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Quick ‘n Easy Web Builder 
 

Introduction 
Quick 'n Easy Web Builder is a WYSIWYG program that can be used to create complete web sites. What-
You-See-Is-What-You-Get (WYSIWYG) means that all elements of the page will be displayed on the exact 
same position (fixed layout) as in the designer unlike fluid (dynamic) layouts (generated by traditional 
HTML editors) where the position of objects depends on the position and size of the objects surrounding 
it. Quick 'n Easy Web Builder generates HTML4, HTML5 or XHTML tags while you point and click on 
desired functions; you can create a web page without learning HTML. Just drag and drop objects to the 
page position them 'anywhere' you want and when you're finished publish it to your web server (using 
the build in Publish tool). Quick ‘n Easy Web Builder gives you full control over the content and layout of 
your web pages. A project file can hold multiple web pages, so you can easily manage all your pages 
from within one file. 
 
Key Features: 

 Drag & drop of HTML objects: Text, Lines, Images, Marquees, Tables and much more! 

 HTML4, HTML5 or XHTML output. 

 Responsive Web Design (based on CSS3 media queries) 

 CSS3 Animations, Transitions and Transformations 

 Site Management. Easily add, edit, clone and structure your web pages. 

 Form wizard; Create forms from scratch or based on a template. 

 Shapes (Rectangle, Rounded Rect, Ellipse, Hexagon, Octagon, Arrows, Signs, Stars, Talk Bubbles 
and more) with many fill effects such as solid, gradients patterns. 

 Flash, YouTube, QuickTime, RealAudio and Flash Movie Player (supports many video formats). 

 Build-in logo creator. 

 Rollover images, Picture gallery object with built-in lightbox effects and amazing Slide Show 
with many transition animations. 

 Ready-to-use JavaScripts. 

 Navigation bars, Menu bars, Text menus, Panel menus, Slide menus and more. 

 Style Manager, a central place to update the styles of multiple objects (H1, H2, H3 etc). 

 Template support. 

 Publish your entire web site, a single page or a group of pages in one action. 

 Built-in FTP Client to manage your online files.  

 Master page object. This allows you to re-use objects from other pages. 

 Meta tags. 

 HTML object to insert your own HTML or JavaScripts. 

 Image tools: Contrast, Brightness, Flip, Rotate, Crop, Reflection, Shadow, Stencils, Resample. 

 Image effects: Grayscale, Negative, Sepia, Blur, Soften, Sharpen, Emboss and much more!  

 Drawing tools: Line, Line + Arrows, Scribble, Polygon, Curve and Closed Curve. 

 Implement events for Images, shapes and form controls. With more than 20 animation effects. 

 jQuery UI Widgets: Accordion, Tab, Dialog, Spinner, Slider, DatePicker etc. 

 Timers 

 PayPal eCommerce Tools.  

 Login tools, protect pages with a password and user management. 

 Page weight tool to determine the estimated size and download time of a page. 

 Popup window support for links (with optional position, size, toolbar, statusbar, scrollbars etc.) 

 Sitemap generator.  

 Built-in RSS Feed creator and RSS viewer. Display RSS feeds (local or from another website), 
Twitter messages, Flickr images or other news sources on your website. 

 WaterMark tool for images. Protect your copyright protected images with a watermark! 

 and much more… 
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Getting started, a quick introduction 

 
Quick 'n Easy Web Builder is a Web site building tool that helps you design and build full-featured Web 
sites without the need to learn HTML. When you preview or publish a page, Quick 'n Easy Web Builder 
automatically generates the HTML code that your browser needs to display pages. 

How is Quick ‘n Easy Web Builder different from a traditional HTML editor? 
The idea behind this application is to hide HTML from the user. Quick ‘n Easy Web Builder is not an 
HTML editor, but an HTML generator. You don't even have to know there is HTML involved. Just drag & 
drop images, text and other objects on your page and your page is ready to be published!  
 
Quick ‘n Easy Web Builder does not edit the HTML directly, but it uses its own file format (.qwb) to store 
the information of the website. You can even store your complete website into one single file! 
By not using HTML internally, the software can do much more than just generate standard HTML 
objects: it supports shapes, drawings, navigation bars, RSS feeds, blogs, photo galleries, ready to use 
Java Scripts and much more advanced objects that would not be possible in a standard HTML editor. 
 

Tip:  
To export your pages to HTML you must use the built-in publish tool! 

 
If you like you can insert existing HTML to your page using the HTML tools (Page HTML and the HTML 
object. You can also insert custom attributes or other code to almost any object. 
 
HTML editors (like FrontPage, Dreamweaver) use a document (word processor) method for layouts, 
where you can not pick up objects and drag it where you want it to go on the web page. In Quick ‘n Easy 
Web Builder you can drag and drop the objects anywhere you want, giving you full control over the 
layout. You can even put objects on top (or below) other objects! 
 
Traditional HTML editors use Dynamic Page Layout, which means that the first object on the page will 
also determine the position of the second object. Resizing or moving the first object will affect the 
complete layout of the page. You can't overlap objects when using Dynamic Page Layout. 
 
Quick ‘n Easy Web Builder generates Fixed Page Layout. All objects have a fixed position which is not 
affected by other objects. This also allows you to overlap objects and give you much more control over 
the layout of the page. 
 
What-You-See-Is-What-You-Get doesn't necessarily mean that the page will look exactly the same in all 
browsers because each browser uses its own rendering engine and has its own interpretation of the 
HTML specification. However Quick ‘n Easy Web Builder will generate the most optimal HTML code, to 
make it look as close as possible. We also constantly monitoring the latest standards to make sure we're 
99.9% compliant with the W3C standards. 
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Start Quick ‘n Easy Web Builder 
Click the Quick ‘n Easy Web Builder icon to launch the application. 
When you startup Quick ‘n Easy Web Builder the main screen will look something like this: 
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Standard Tools 

With the 'Standard Tools' toolbar you can execute basic commands like: Create a new web site, open an 
existing web site, save, cut, copy, paste, undo, redo, publish and preview. 

 

 
 

Toolbox 
The toolbox can be used to add new objects to your web pages. To insert a new object, select one of the 
available items and draw a box to indicate the position of the object. The new object will be inserted to 
the page. Another way to add objects to your page is by simply dragging them out of the toolbox onto 
the workspace. 
 

Workspace 
The center of the screen is the workspace, where you can drag and drop objects from the toolbox. This 
represents your web page. 
 

Formatting Tools 
The formatting tools are only active when you are in text edit mode. 
 

 
 
To insert text simply drag the text icon on the workspace. A new object with the text "Double click to 
edit' will be displayed on the page. To switch to text edit mode double click this text and the formatting 
tools will become active. For some of the tools you need to highlight the text before they can be used 
(just like in a regular text editor). 
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Site Manager 
The Site Manager can be used to manage the structure of your web site. 
 

 
 
The Site Manager has its own toolbar to add, edit, clone or remove pages. In the picture above you see 
an example of a web site structure. The filename of this example web site is called 'mywebsite.qwb', this 
name is always displayed at the root of web site tree. The root can have one of more pages and each 
page can have sub pages. Web sites always have a home page, which is often called index, so for this 
reason Quick ‘n Easy Web builder automatically adds this page to each new project. The names of the 
items (pages) in the site tree are the actual file names of the target HTML files, so if you named a page 
'index' is will publish as index.html. Do not add the file extension in the Site Manager! 
 

Tip: Make sure all pages of a website are part of the same project, this way Quick ‘n Easy Web Builder 
will 'know' that the pages belong together and generate optimal HTML for your website. 

 
 

Tip: Every time you insert a new page to your website it will be added to the Site Manager. To edit 
previously created pages you can click the page name to open it in the editor. 

 
 
You will find more information about the Site Manager later in this document. 
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Property Inspector 
Use the Property Inspector window to view and change the properties of the selected object.  You can 
also use the Property Inspector to modify page properties (when no objects are selected). The changes 
will be visible immediately. It is also possible to manually modify the size and position of the selected 
object. 
 

 
 
The ID property 
The ID property of an object should be unique within the page. Normally Quick ‘n Easy Web Builder will 
automatically assign unique names to all objects. However if you use one of more master pages, then 
IDs may be duplicated, since the software cannot distinguish a master from a normal page. We 
recommend giving objects on a master page names with a prefix like MasterPage_Text1. This will make 
sure that if the master page is used in another page, the ID of the objects is unique.
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Adding text to the page 
One of the first steps in creating a web page is often adding text. 
 

  
 
Select Insert->Text from the menu and draw a box to indicate the position of the text. Then double click 
the box to start editing the text. Type some text and (press Enter to go to the next line). The box 
automatically changes its size to fit the text. 

 

 
 
Next, you can change the text attributes by highlighting the text you want to modify with the mouse and 
then choose the new attributes from the Format Toolbar. From the toolbar you can change font type, 
size, bold, italic, underline, text color and highlight color. There are lots of other formatting options 
available from the Format menu: 
 

 
 
Click anywhere in the page to stop editing. 
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Adding an image to a web page 
Select Insert->Image from the menu and draw a box to indicate the position of the image or select 
Image in the toolbox. The size of the box doesn’t matter; Quick ‘n Easy Web Builder automatically 
adjusts the box to fit the image after you place it. 
 

Tip: Make sure you resize the image before adding it the page. By keeping images as small as possible it 
will keep your project ‘lean and mean’ and it will also reduce the loading times in the browser. 

 
The Image File Open dialog appears so you can locate the image you want to place in the image box. 
Select the image you want to add and click Open to add it to the page. 
 
To resize the image drag the borders (handles) of the image object. 
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Rotate an image  
You can rotate image and shape objects. You will find the ‘angle’ property in the Property Inspector. 
Note that rotation is not a standard feature of HTML, the software will create a new image (with a 
different filename) with the rotated picture. 

 

Apply effects to an image 
In Quick ‘n Easy Web Builder you can apply effects to images without having to open a separate image 
editor! A few of the available effects are: Contrast, Brightness, Blur, Grayscale, Emboss, Negative, Sepia, 
Sharpen, Soften, Stencils and much more! 
 

 

Adding other objects to the page 
There are many other objects you can place on the page. Check out Insert Menu for a description of the 
other objects. 
 

Tip: Another way to add objects to your page is by simply dragging them out of the toolbox onto the 
workspace. 
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Linking your pages together (Creating hyperlinks) 
Hyperlinks are text or images that can be clicked to bring the user to another web file such as a web 
page, images or any other file. They are the essence of the World Wide Web as they link pages within 
sites and web sites to other web sites. To create a hyperlink in Web Builder, follow the instructions 
below. 
 

Linking text 
Highlight the text you want to link and select Insert->Link from the menu bar, click the link button on the 
toolbar or press CTRL+K on your keyboard. This will display the Insert Hyperlink window. 
 

 
 
 

Linking an image, shape or rollover image. 
 

 
 
Please read the chapter ‘Links’ of this document for more details about linking. 
 

Saving your web site 
To save your web site, select Menu->File->Save Web Site from the menu and enter a name for the 
project. Web Builder uses the extension .qwb (Quick ‘n Easy Web Builder) to save the project files, to 
save your page as HTML you’ll have to Publish your pages.  
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Preview a page 
Select File->Preview in Browser->Default Browser (F5) to preview the current page in your default 
browser. It is also possible to change the browser that is used for previewing. Go to File->Preview in 
Browser->Edit Browser List to add/edit the list of browsers that can be used to preview the pages you 
are working on. 
 

 
 
Depending on the preview scope (Tools->Preferences->Publish), you can preview either a single page or 
the entire web site.  
 

Important note: Internal links do not work in Preview, unless you have set the Preview Scope to Entire 
Web Site! If you only preview a single page, your browser will not be able to find all the other (internal) 
pages unless you also generate them! 

 

Another note: You cannot preview pages that use PHP in your local browser. PHP pages can only be 
viewed through a web server with PHP support. 
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Publishing your web pages 
The final phase of creating a web site is publishing your pages. To place your pages on the Web, you 
need a Web server. Commonly called hosts, Web servers allow you to transfer and store files, including 
HTML documents, images and multimedia files. Unless you own your own Web Server, you need to find 
a server to host your pages. Some examples of web hosts are: 
http://www.godaddy.com/ 
http://www.1and1.com 
but of course there are many more! 
Make sure you choose a web host that supports FTP; this makes it much easier to publish your pages 
from Quick ‘n Easy Web Builder.  
 
Publish to a remote FTP server. 
Once you have registered to a web host, you will receive a server address, username and password. 
Enter this information into Web Builder by selecting: File->Publish. Click Add and select Type ‘FTP 
Server’. Sometimes you also need to specify a remote folder. Common remote folders locations are: 
/www, /public_html, /html, but unfortunately this value can be different for each webhost, so consult 
your webhost's documentation for more details! If you have a firewall/router, select 'Use passive mode 
for transfers'. Click OK to save. Now you can publish each page simply by selecting Publish. 
 

 
 
Publish to a local folder 
If your web host doesn't support FTP or you want to use your favorite FTP client to transfer the files to 
the server, you can use the option 'Publish to a local folder'.  Click Add to add a new location to the list. 
Enter a name for the location a select ‘Local Folder’ as type. Enter the folder where you want to publish 
the active document. Click OK to save the data and then click Publish to save the files to the specified 
folder. Now you can take these files from the local folder and publish them using your preferred FTP 
utility. 
 
Pages to Publish 
Select which page or pages you want to publish. 

 Entire Web Site, publishes all pages of the web site (except the pages which have enabled 
'Don't Publish this Page' in Page Properties) 

 Select Page Only, publishes the select page, click Select to specify the page to be published. 

 Select Page and Sub Pages, publishes the select page and all of its subpages (if any). 
 
More about publishing later in this document. 

 
 
 
 
 

http://www.godaddy.com/
http://www.1and1.com/
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The Quick ‘n Easy Web Builder Menu 
All of Quick ‘n Easy Web Builder’s features are available through the menu bar. 
The menu bar has the following items: 
 

 File 

 Edit 

 View 

 Page 

 Insert 

 Format 

 Table 

 Arrange 

 Tools 
 

File Menu 
New Web Site 
Creates a new empty web site project. All pages of a web site are saved in one file. 
 
New Web Site from Template 
Creates a new web site based on a template. A template is a framework for web pages and sites. 
Templates for web pages work much like templates in Microsoft Word, or any other word processing 
application. Think of a template as a starting point for your pages. A template will include all of the 
images and other objects in the template file. So there is no need to copy these files separately. So you 
simply copy one file from one computer to another and you can start or continue working on your web 
pages. Quick ‘n Easy Web Builder Templates have the .qwbt extension and are saved in the sub folder 
/Library/Application Support/Quick ‘n Easy Web Builder/templates. To add a new category to the 
template selection window, so you can organize your templates, simply create a new folder and put the 
template files in this folder. The name of the folder will then be displayed in the Category dropdown list. 
You can also create new categories by using the context menu in the Template selection window. 
 

 
 
Note: The first time you launch the template window the software will generate preview images for the 
templates, so this may take a few seconds to complete. 
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Open Web Site 
Opens an existing web site project.  
 
Close Web Site 
Close the active web site project. 
 
Save Web Site 
Save the active web site project.  
 

Important note:  
Quick ‘n Easy Web Builder does not edit the HTML directly, but it uses its own file format (.qwb) to store 
the information of the website. In order to save your pages as HTML you need to publish your pages. 
QnEWB stores the information of all your pages in one project file. 

 
Save Web Site As 
Save the active web site project with a new name. 
 
Save Web Site as Template 
Save the active web site project to a template. 
See ‘New Web Site from Template’ for more details about templates. 
 
Preview in Browser 
Preview the active web page in your default Browser. 
Depending on the preview scope (Tools->Preferences->Publish), you can preview either a single page or 
the entire web site. It is also possible to change the browser that is used for previewing.  
Go to File->Preview in Browser->Edit Browser List to add/edit the list of browsers that can be used to 
preview the pages you are working on. 
 

Tip: 
You can also use the menu item 'Preview entire web site' to toggle between single page and entire 
website preview. 

 
 

Note: 
You cannot preview PHP pages directly in your browser. PHP can only be viewed via a web server with 
PHP support! 

 
 
Publish 
Publish the active page, a group of pages or the entire web site. You can choose to publish to a local 
folder or a remote FTP server. Check out the chapter ‘Publish’ of this document for more details. 
 
Exit 
Quits the application. 
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Edit Menu 
Undo 
Undo the last action. 
 
Redo 
Redo the previously undone action. 
 
Cut 
Cut the selection and put it on the Clipboard. 
 
Copy 
Copy the selection and put it on the Clipboard. 
 
Paste 
Insert Clipboard contents. 
 
Delete 
Erase the selection. 
 
Select All 
Select the entire document (all objects). 
 
Find and Replace 
The Find and Replace tool can be used to quickly change the color, font, URL or filename for all objects 
(or a selection) on the page or entire website. 
 

Tip: 
To add a prefix to all IDs of a page, set the old value to * (wildcard) and the new value to the prefix.  
This can be useful to quickly add a prefix to the IDs of master pages/master frames. 

 
Lock/Unlock 
This will 'lock' the selected objects, so that they cannot be moved or resized accidentally.  
To unlock the object again, repeat the same command. 
 
Lock All 
This will lock all objects in the active page. 
 
Unlock All 
This will unlock all objects in the active page. 
 
Restore Original Size 
Can be used to restore an image or flash object to its original size. 
 
Animations 
Add CSS3 animations add transitions to the selected object. See also ‘Animations and Translations’.  
 
Events 
Implement dynamic actions based on events. See ‘Events’ for more details. 
 
Lorem Ipsum 
Lorem ipsum is a placeholder text (filler text) commonly used to demonstrate the graphic elements of a 
web site, such as font, typography, and layout, by removing the distraction of meaningful content.  
Quick ‘n Easy Web Builder has a simple built-in Lorem Ipsum Text generator to add place holder text to 
the text object. You can insert complete paragraphs or a specific number of words.  
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HTML 
View the generated HTML of the selected object or insert your own HTML code! 
Please note that this option is for advanced users only. Inserting invalid HTML code may cause 
unexpected results. 
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View Menu 
 
Main toolbar  
Show or hide the standard toolbar.  

 
Breakpoints toolbar 
Show or hide breakpoint toolbar at the bottom of the page.  These tools can be used to insert and 
manage breakpoints for Responsive Web Design. You can also switch between breakpoints. 
See ‘Responsive Web Design’ for more details. 
 
Toolbox 
Show or hide the toolbox. 
 
Object Manager/ Site Manager/ Property Inspector 
Show or hide the Object Manager, Site Manager and Property Inspector window.  
 
Refresh 
'Refresh' reloads all images of the current page. This can be useful if you have edited images in another 
application. 
 
Show Ruler Guides 
Horizontal and vertical ruler guides are used to align objects on the page.  
See ‘Guide Settings’ for more information. 
 
Show Smart Guides 
Smart guides are dynamic guidelines that appear when you move objects into alignment with each 
other. 
 
Snap to grid 
Enable or disable snap to grid. Use the Snap to Grid feature to align objects exactly. Quick ‘n Easy Web 
Builder creates a "magnetic" attraction between the selected object and the grid.  
 
Rulers 
Show or hide rulers. 
 
Object Outlines 
Show or hide object outlines. 
 
Non-responsive objects 
Enable this option to outline objects that are not responsive. This may be helpful for Responsive Web 
Design, so you can either change the object's properties to make it responsive or use 'Clone and Hide' to 
create a new instance of the object. 
 
Render hidden objects 
This option may be useful to trace layout problems caused by hidden objects. Note that hidden objects 
cannot be edited. You will first have to unhide the object (with the Object Manager) to make changes. 
 
Zoom 
You can zoom in to see parts of your web page close-up, or zoom out to see more of the page. 
 

Notes: 
The quality of the zoomed page strongly depends on the zoom level. You will get the best quality for 
100%, 200%, 300%, 400% etc. But a zoom level of 150% will introduce rounding errors of pixels. 
You cannot edit text when a page is zoomed in or zoomed out. 

 



Quick ‘n Easy Web Builder   

23 

Page Menu 
The page menu holds all the commands related to page management. 
 
New Page 
Adds a new page to your web site. The new page is automatically opened so you can start editing it right 
away. The new page (with a unique page name) with be added to the Site Manager tree. 
 
New Page from Template 
Create a new page based on a template. Pick any page from a template and insert it into the current 
project. The new page (with a unique page name) with be added to the Site Manager tree. 
 
Clone Page 
To make an exact copy of the active page, select Clone Page from the menu. A new item (with a unique 
name) will be added to the Site Manager. 
 

Note: 
'Clone Page' will duplicate the page and all objects on that page. To reduce the number of duplicated 
objects within your website you should consider using master pages. 

 
Delete Page 
Remove the active page from your web site. You cannot remove the last page in your web site. 
 
Rename Page 
Rename the active page. Note that the Site Manager must be visible to be able to rename your page. 
The name of the page will be highlighted in the Site manager, where you can change its name. 
 

Note: When you have linked to the page you are renaming (from any page within the web site), Web 
Builder automatically updates all the links for you so you don't have to redo all the internal links. 

 
Notes about page names 
While building your web site, Quick ‘n Easy Web Builder saves the project file with the .qwb extension. 
This is a project file used by Web Builder to simplify the building process. One project file can contain 
multiple web pages. Once your pages are ready you must export or publish them as HTML.  
The name of the output HTML file is taken from the name you have specified in the Site Manager. 
So if you named the page index then the output file will be called index.html. If the page needs another 
extension like .php, you can configure this in the Page Properties. 
 
Here are some guidelines how to name your web pages: 

1. Do not add .html or .htm extension to the page name. Quick ‘n Easy Web Builder will 
automatically add the .html extension (or .php, .asp) when it publishes (or exports) the HTML 
code. 

2. Always name your homepage: "index", this is the most common name for a homepage. 
3. Always use lowercase filenames, most web servers are case sensitive and might fail to find your 

page if you have called it "Index" or "INDEX" 
4. Do not use space or other special characters in the name, keep them simple like: 

"page1" or "my_products" 
It’s strongly recommend using alphanumeric characters only! 

5. Use underscores to connect words. 
6. Do not start the file name with a number. 
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Import HTML 
Although Quick 'n Easy Web Builder is NOT an HTML editor, it has (limited) support to import HTML 
pages. This may help you import images and text from existing pages. You can either select an HTML 
page from your local drive or specify a URL of an online website. The software will automatically copy 
images from remote pages to your local drive. 
 
Notes about importing HTML: 

 This feature is still in beta.  Importing HTML is a very complex process and it will take a lot of 
testing and optimizing before we get the optimal results. However, in many cases the current 
implementation may be sufficient enough. 
 

 QnE Web Builder is not an HTML editor, but an HTML generator! Internally the software does 
not use HTML. This give you much more control over the layout then you normally would have 
in a traditional HTML editor. So this means that the HTML has to be converted to QnE WB's 
internal format. A very complicated task… 
 

 The import feature currently only imports text, images, form elements and body attributes 
(background images, meta tags). Tables, scripts, stylesheets and multimedia components are 
not imported. But in most cases this is good enough to get you started. 
 

 QnE Web Builder does not parse style sheets, currently all objects will have the default styling.  
 

 It is very difficult to support all different types of HTML. Even the different types of browsers 
will interpret HTML differently, so don't expect miracles. If a page fails to import, then it 
probably contains code that Qne Web Builder doesn't understand and you still have to start 
from scratch. 
 

 Importing web pages with fixed page layout (absolute positions), for example those created 
with WYSIWYG Web Builder or QnE Web Builder will give the best results. 
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Page HTML 
View the generated HTML of the active page. You can also add your own HTML code!  
Note however that you cannot edit the HTML generated by Quick 'n Easy Web Builder, all changes to the 
code are done through visual design (drag & drop, editing properties). 
 

 
 
 

Warning: When you insert code in the Page HTML window, make sure you do not include the <HTML>, 
<HEAD> or <BODY> tags! Quick ‘n Easy Web Builder already generates these tags. 
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 Start of Page 
The HTML will be inserted before all other code on the page. 
 
<-- your html --> 
<!DOCTYPE HTML PUBLIC "-//W3C//DTD HTML 4.01 Transitional//EN" 
"http://www.w3.org/TR/html4/loose.dtd"> 
<html> 
<head> 
… 
 

 Between <head></head> tags 
The HTML will be inserted between the <head></head> tags. 
 
<head> 
... 
<-- your html --> 
</head> 
 

 Inside <body> tag 
The HTML will be inserted inside the <body> tags. 
 
<body attribute=value> 
 

 After <body> tag 
The HTML will be inserted after the <body> tags. 
 
<body> 
<-- your html --> 
 
... 
</body> 
 

 Before </body> 
 
<body> 
... 
 
<-- your html --> 
</body> 
 

 End of page 
 
<body> 
... 
</body> 
<-- your html --> 
 

 Inside <html> tag 
 
<html your html> 
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Animations Timeline 
The Animation Timeline displays all animations on the page; you can also add, edit and remove 
animations. It's also possible to drag & drop/move animations on the timeline, so you can easily control 
the timing of the animations.  
 
 
Error Reports 
The Error Report tools will analyze the current page and check for errors like duplicated IDs, invalid 
filenames or other common problems.  
  
Invalid filename 
Names must contain only ASCII letters (a-z,A-Z), digits (0-9), underscore, dot and dash. 
  
Empty ID 
Make sure all objects have a valid ID. You can set the ID property in the Property Inspector. 
  
Duplicate ID 
All objects must have a unique ID property within the context of the page. This includes the objects on 
master pages! You can set the ID property in the Property Inspector. 
  
Invalid HTML 
Custom HTML may not contain <html> <<head> or <body> tags. 
  
Invalid page extension 
The page contains a form which requires PHP. Set the page file extension to 'php' (in Page properties) 
  
Success page not specified 
The success page property of the form cannot be empty if the form processor if used.  
  
Error page not specified 
The error page property of the form cannot be empty if the form processor if used.  
  
Invalid page title 
The page does not have a meaningful title. The page title is either empty or has the default 'untitled 
page' value. You can change the page title in Page Properties. 
 
 
Google Analytics 
Insert Google Analytics code in <head> section of the current page.  
This option is a shortcut to Page HTML. 
 
 
Responsive Web Design 
In this section you can add, manage and switch breakpoints. 
See ‘Responsive Web Design’ for more details. 
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Page Weight 
The Page weight tool helps you determine the estimated size and download time of a page. 
The tool will list all files which are part of page and their sizes. By selecting the connection speed you 
can get an idea how long it will take to download the complete page. 
 

Note: Please keep in mind that some files (like scripts, images) are used by multiple pages. They will be 
downloaded by the browser from the server only once! 
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Site variables 
This option can be useful to get global variables for the project, for example to quickly update the 
copyright or other value that regularly changes. 
The variables will be replaced during publishing by the specified value. You can use this variable 
anywhere in the page, text or property values. 
 
Example: 
Name: $COPYRIGHT$ 
Value: Pablo Software Solutions 
This will replace any instance of '$COPYRIGHT$' in the project by 'Pablo Software Solutions'. 
 
 
The following built-in variables are available (for advanced users): 
 
$PARALLAX_SPEED$ 
Specifies the speed at which the parallax effect runs. 0.0 means the image will appear fixed in place, and 
1.0 the image will flow at the same speed as the page content. The default is 0.3.  
 
$GOOGLEFONTS_PREFIX$  
This makes it possible to overwrite the 'http:' prefix used for Google web fonts. You can replace it with 
'https:' or leave the value empty. Default is 'http:' 
 
$VIMEO_PREFIX$  
This makes it possible to overwrite the 'http:' prefix used for the Vimeo URL. You can replace it with 
'https:' or leave the value empty. Default is 'http:' 
 
$LAZYLOAD_THRESHOLD$ 
Specifies the default threshold of the Lazy Load script. By default, images are loaded when they appear 
on the screen. If you want images to load earlier use threshold parameter. Setting threshold to 200 
causes image to load 200 pixels before it appears on viewport. 
 
$LAZYLOAD_FADE$ 
Specifies whether to use a fading effect when Lazy Load is enabled. Use 'true' to enable fading. Default 
is 'false'. 
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Page Properties 

To edit the page properties click on an empty area of the page. This will display the properties of the 
page in the Property Inspector. 
 

Page Properties – General 
 
Center page in browser window 
Enabling this option will center the published page in the browser window. 
Most professional web sites are designed so they will look good on different screen sizes. 
Because Web Builder uses absolute positioning for all elements, they cannot be stretched over the full 
width and height of a page, because that would 'scramble' the contents of the page and this wouldn’t 
look good;) 
 
Character Set 
The character set tells the browser how to interpret and display the characters on your webpage. 
Depending on the language of the text on the page it might be necessary to force the browser to 
another character set. The most common used character sets are: ISO-8859-1 (ANSI) and UTF-8 
(UNICODE). 
 
Direction 
Specifies the text direction for the content in the page. This can be either property set to 'left-to-right' or 
'right-to-left'. 
 
Document Type 
The doctype declaration is an instruction for the web browser about what version of the markup 
language the page is written in. 
Currently Quick ‘n Easy Web Builder supports 2 document types: 
 

HTML 4.01 Transitional (default) 
The generated output will be HTML and compliant to the HTML 4.01 specification of W3C (just 
like in previous versions of Quick ‘n Easy Web Builder). 
XHTML 1.0 Transitional 
The generated output will be XML and compliant to the XHTML 1.0 specification of W3C. 
HTML5 
The generated output will be HTML and compliant to the HTML 5 specification of W3C. This 
mode is experimental because the HTML5 specifications are not officially finished yet. 
 

Select document type 'None' if you don't want to include the doctype declaration in the page output. 
The generated output will be HTML 4.01 Transitional in that case. 
 
Favorites Icon 
You can use favorites icons (also known as shortcut icons) to display your logo or some other small 
graphic on the Favorites menu, address or page tabs of your browser. They are a great way to add brand 
recognition to your Web site. A shortcut icon must be square in size, and at least 16 x 16 pixels. Consider 
creating both a 16 x 16-pixel icon as well as a 32 x 32-pixel icon (and larger, bandwidth permitting), since 
on high-DPI displays, the browser may stretch the icon to fit the available space. 
 
To create the icon, use an icon editor, such as Axialis IconWorkshop, IcoFX or Microangelo Toolset and 
save the icon in the .ico file format.  
 
Apple Touch Icon 
When someone bookmarks your web page or adds your web page to their phone's home screen this 
icon is used. Preferred size: 180x180 (png image). 
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File extension 
Normally your web page will be published using the .html extension. In some cases it may be necessary 
to specify another extension like .php of .asp in case your page uses PHP or ASP. 
 

Notes:  
If you set the file extension to something other than .html, then your browser may not be able to 
preview the page. In order to preview PHP or ASP page, you must publish the page to a web server 
which can handle these page types! 
 
After changing the file extension, you will need to re-publish all pages link to it, otherwise the links will 
still refer to the old page name. 

 
IE Compatibility 
This option enables Internet Explorer to emulate previously versions of this browser. This can be useful 
in case you experience display problems in IE that did not exist in previous versions of the browser. 
More information: http://msdn.microsoft.com/en-us/library/cc288325(VS.85).aspx#SetMode 
 
Overflow 
These properties specify whether content is clipped when it overflows the browser window.  
‘Overflow-x’ determines clipping at the left and right edges, ‘Overflow-y’ at the top and bottom edges.  
 

 none 
The overflow attribute will not be added to the page HTML. In this case scroll behavior may be 
different for each browser type.  

 visible 
This value indicates that content is not clipped, i.e., it may be rendered outside the browser 
window.   

 hidden 
This value indicates that the content is clipped and that no scrolling mechanism should be 
provided to view the content outside the browser window.   

 scroll 
This value indicates that the content is clipped and that if the browser displays scrolbars.  
This avoids any problem with scrollbars appearing and disappearing in a dynamic environment 
where pages have different sizes.   

 auto 
The behavior of the ‘auto’ value is browser-dependent, but should cause a scrolling mechanism 
to be provided for overflowing boxes.  

 
jQuery UI Theme 
Specifies the jQuery UI theme for the page. This theme will be applied to all theme enabled objects like 
jQuery UI widgets. Besides jQuery UI widgets you can also enable theming for the menubar, navigation 
bar, tab menu, slidemenu, horizontal line. This way you can give you page a uniform look and feel. 
Themes can be created and edited with the jQuery UI Theme Manager. 
 
Page Language 
Specifies the language (Content-Language) of the page. Search engines may use this tag to categorize 
pages by language. 
 
Title 
This title will be displayed in the title bar of the browser's window and search engine results. 
 
PHP Version 
Specifies the PHP version for the current page. 
Currently this option only affects database functionality. If set to PHP4 then all scripts will use MySQL 
database functions. If set to PHP5 then MySQLi database functions will be used. 

http://msdn.microsoft.com/en-us/library/cc288325(VS.85).aspx%23SetMode
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Properties - Background 
 
Background Mode 
Specifies the background mode: Solid, Image, Gradient or Transparent. 
 
Background Color 
Specifies the color of the background.  
 
Gradient Color 
Specifies the color of the gradient effect (in combination with the background color). 
 
Gradient Style 
Specifies the style of the gradient effect. 
The gradient can either be horizontal or vertical. 
 
Background Image 
Specifies the optional background image. If the image is smaller than the page size it will be tiled. 
 
Background Size 
Specifies the size of the background image.  

 empty (default) 
The background-image has the default size and scrolls with the content. 
 

 fixed 
A fixed background is a background image that will stay in one place while the rest of your text 
and images scroll over the top of it. 
 

 cover 
Scale the background image to be as large as possible so that the background area is 
completely covered by the background image. Some parts of the background image may not be 
in view within the background positioning area. 
 

 contain  
Scale the image to the largest size such that both its width and its height can fit inside the 
content area. 
 

 parallax 
The image scrolls slower than the content in the foreground, creating the illusion of 3D depth.  
 
For advanced users: 
The default speed is 0.3. You can change this by adding a Site Variable with the name 
$PARALLAX_SPEED$. The speed at which the parallax effect runs. 0.0 means the image will 
appear fixed in place, and 1.0 the image will flow at the same speed as the page content. 
 

 percentages 
For example: '100% 100%' will stretch the images to 100% of the object's width/height. Other 
values like '50% 50%' are also possible. 
 

 pixels 
For example: '320px 250px' will display the image in the specified size. 
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Horizontal Alignment 
Sets the horizontal position for the background image.  
 
Repeat 
Sets the tiling attributes for the background image. Possible options are: 

 Repeat in both directions 

 Repeat in horizontal direction 

 Repeat in vertical direction 

 Do not repeat 
 
Vertical Alignment 
Sets the vertical position for the background image.  
 
 

Properties - Links 
 
Link Color 
This specifies the default, unvisited hyperlinks color. 
 
Visited Link Color 
This specifies the color of a followed link. 
 
Active Link Color 
This specifies the color of an active link. 
 
Hover Link Color 
This specifies the color of all hover links of the active page. 
 
Underline mode 
This specifies the underline behavior of links. 
 

Note: You can also control the colors of hyperlinks by using Hyperlink Style Sheets. For more 
information, see the description in the chapter ‘Links’. 
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Page Properties - Meta Tags 
 
Author 
The author meta tag is used to indicate who the author of the web page is.  
 
Description 
The description meta tag can be important when it comes to some search engines.  
There are many search engines that will index your site automatically.  
Some of these search engines allow for a short description to be placed in their web page.  
If the search engines are looking in your web page for a description meta tag, it will use this description 
in the search index.  
 
Generator 
Typically, the name of the application used to create the page. 
 
Keywords 
The keyword meta tag can be important when it comes to some search engines.  
When these auto robot search engines index your site, some will look for a keyword meta tag to use as 
index words.  
When someone uses their search engine and searches on a word that is in your keyword meta tame list, 
your site will be included in the output search results. 
 

Tip:  
The keywords are typically separated by a comma (,) 

 
User defined 
Here you can insert your own custom meta tags. These will be inserted before all other meta tags right 
after the <head> tag. 
 
Example: 
<meta http-equiv="Cache-control" content="no-cache"> 
<meta name="expires" content="tue, 01 Jun 2015 19:45:00 GMT"> 
 

 
Page Properties - Size  
 
Automatic Page size 
Specifies whether the page size should be automatically managed based on the page content.  
It is recommended to set this to ‘false’ when designing responsive web layouts. 
 
Height 
Specifies the height of the workspace. 
Note that this does not set the HTML page height. In HTML the height of the page is determined by the 
content. 
 
Width 
Specifies the width of the workspace. 
Note that this does not set the HTML page width. In HTML the width of the page is determined by the 
content. 
 
Use 100%-page width/height 
Enable this option if you are using ‘Full Screen’ floating layers. 
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Properties - Redirect 
 
The Redirect property redirects the user to another page after a specific delay (by using the 'refresh ' 
meta tag). 
 
Redirect URL 
Specifies the URL where the user will be redirected to. 
 
Redirect Delay 
Specifies the redirect delay. 0 (zero) means no delay. 
 

 
Properties – Search Engine Optimization 

Search engine optimization (SEO) is the process of improving the volume or quality of traffic to a web 
site or a web page from search engines. The theory is that the earlier (or higher) a site appears in the 
search results list, the more visitors it will receive from the search engine.  These values may help 
improve your SEO, however modern search engines use more advanced techniques to index your 
website. More details: http://en.wikipedia.org/wiki/Search_engine_optimization 
 
Robots 
The Robots Meta Tag is used to tell search engines whether to index and/or crawl a page or not.  
 
Revisit after 
The Revisit Meta Tag is used to tell search engines when to come back next. 
 
Expires after 
The Expires Meta Tag is used to tell search engines when the page and content is no longer valid. 
 

 
Properties – Master Frame 

 
Master Frame 
Specifies the page used for the Master Frame. The content of this page will be put inside the Content 
Place Holder of that Master Frame when the page is being previewed or published. 
To remove a previous selected name, click the 'Remove' button. More details: Master Frames 
 
 

Properties - Events 
For more information about events please go read the chapter Events. 

 
Properties - Defaults 
Font Family 
Specifies the default font that will be used for (new) text. This option does not affect existing text! 
 
Font Size 
Specifies the default font size that will be used for (new) text. This option does not affect existing text! 
 
Text Color 
Specifies the default text color that will be used for (new) text. This option does not affect existing text! 
 
Note: 
The default settings only apply to new objects. If you want to change the style of existing objects, then 
either change the (global) style in the Style Manager or use Find and Replace. 

 

http://en.wikipedia.org/wiki/Search_engine_optimization
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Insert Menu 

 
The Insert menu provides an alternative way to insert objects. Most of the menu items are also available 
through the Toolbox. A few additional choices are available: 
 
Select 
The Select object is used to select objects. To select multiple objects, drag a selection box around them, 
or hold down the Shift key while you click them one at a time. 
 
Symbol 
Insert a symbol (special character) into a text object. This option is only enabled when you are in text 
edit mode. 
 
Link 
Opens the link dialog for the selected object or text. 
Check out chapter ‘Links’ for more details. 
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Format Menu 

 
Most formatting tools apply to text only. Quick ‘n Easy Web Builder allows you to make all the same 
attribute changes you can make in (for example) MS Word.  
To edit the formatting of text you must first double click the text object to go into edit mode, then 
highlight the text you want to modify with the mouse and select formatting option. 
 
Font Name 
Font name is the font family of text, such as Comic Sans, Times New Roman, and Courier New.  
To change the font type, select the font you want from the Font Type List Box on the toolbar.  
 
Font Style 
The style of the text can either be bold, italics, or underline.  
To change the font style, select one or more of the Style Icons on the toolbar. 
 
Font Color 
The color of the text can also be changed.  
To change the font color, select the Text Color Icon on the toolbar.  
The Color Dialog Box appears. Choose the color you want and click OK. 
 
Font Size 
To change the font size, select one of available HTML font sizes. 
 
Background Color 
To change the background color of the selected text, click the Background Color Icon on the toolbar.  
The Color Dialog Box appears. Choose the color you want and click OK. 
 
Text Alignment 
You can change the alignment of the selected text object by using one of the alignment buttons: Left, 
Center, Right or Justify. 
 
Remove formatting 
Sometime it can be useful to remove all formatting from a piece of text at once. Highlight the text and 
select Remove Formatting to reset all styles to its default values. Formatting removed from the text 
include bold, italic, underline, subscript, superscript, strikeout, text color and background color. 
 
Remove link 
Removes the link that was assigned to the selected text. 
 
Remove list style 
Removes the bullet list style from the text. 
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Styles 
In the Style Manager you can manage the styles of a project. By using styles you can modify the style of 
the entire website all in one place. 
 

 General Styles 
In the General Style page HTML/CSS styles can be defined, such as text header styles (H1, H2, 
H3 ...) or form element styles. See also: Style Manager. 
 

 Link Styles 
By default all hyperlinks in your webpage use the default link colors as defined in page 
properties. But you can also specify different colors for each link by using Hyperlink Styles. 

 
 
Websafe fonts 
Websafe (or "web safe", "safe for the web") fonts are fonts that are common among all versions of 
Windows, Mac, and Linux. By using these fonts you can make sure your web site looks (almost) the same 
on all devices. 
 
List of web safe fonts: 
Arial 
Bookman Old Style 
Comic Sans MS 
Courier 
Courier New 
Georgia 
Impact 
Lucida Console 
Lucida Sans Unicode 
MS Sans Serif 
MS Serif 
Palatino Linotype 
Symbol 
Tahoma 
Times New Roman 
Trebuchet MS 
Verdana 
Webdings 
Wingdings 
 
You can enable the option 'Tools->Preferences->Miscellaneous->Display web safe fonts only', so Quick 
‘n Easy Web Builder will only display web safe fonts. This may also increase the speed of the user 
interface, because not all fonts need to be loaded into memory every time you want to select a different 
font. 
 
Using @font-face 
If you want to use non-webfonts then you can use Quick ‘n Easy Web Builder's @font-face options 
(Preferences ->HTML). If you enable this option you will be able to use any type of true type font even if 
it's not web safe by using a new CSS3 feature called @font-face. Quick ‘n Easy Web will automatically 
generate the necessary code and upload the font to the server. There is also support for Google Fonts. 
For more information see the description of the @font-face configuration later in this document. 
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Table Menu 
The Table Menu contains all the operations related to creating and modifying tables. 
Tables have columns and rows of cells that can contain text (images, forms, or other page elements are 
not supported at the moment). Tables are useful for the layout of data; they can be used to simulate 
columns of text. When you type text in a table cell it expands horizontally and vertically to 
accommodate the text that are typed or inserted. You can edit, format, and specify properties 
(background color or image) for the text, as well as for the table cell, row, column, or table itself. You 
can easily resize cells, columns, rows, or the entire table by the dragging borders.  
 
Insert Table 
Draw a box where you want to position the table. The table will now be created on the page. 
   
Insert Rows or Columns 
Select this option if you need to insert additional rows and columns after a table has been created. 
Specify if you want to insert Rows of Columns and enter the number of rows/columns to be added. 
To insert a column to the left of a selected column, choose Left of selection. 
To insert a column to the right of a selected column, choose Right of selection. 
To insert a row above a selected row, choose Above Selection. 
To insert a row below a selected row, choose Below Selection. 
 
Merge Cells 
Merge two or more adjacent cells 
This command is only available when two or more adjacent cells are selected on the same row. 
 
Split Cell 
Split the selected cell into columns. 
 
Delete Column 
Select this option to delete the selected column. 
 
Delete Row 
Select this option to delete the selected row. 
 
Table Column Width 
Set the column width for the selected column. 
 
Table Row Height 
Set the row height for the selected row. 
 
Border Size 
Enter how wide you want the border to be, in pixels. 
 
Cell Padding 
Enter how much space you want between the contents and inside edges of cells, in pixels.  
 
Cell Spacing 
Enter how much space you want between the cells in the table, in pixels. 
 
Background color 
Specifies the color of the form background. If set to 'Automatic' the webpage background will be used. 
 
Background image 
Specifies the optional background image. 
 
Border color 
Specifies the color of the table's borders. If set to 'Automatic' the table will have a 3d border. 
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Table HTML 
View generated HTML of the table. You can also insert your own HTML code! 
 
Cell Properties 
This option will display the properties of the selected cell. 
Background Color 
Specifies the color of the text background. If set to 'Automatic' the webpage background will be used. 
Background Image 
Specifies the optional background image. 
Repeat 
Sets the tiling attributes for the background image. 
Possible options are: 

 Repeat in both directions 

 Repeat in horizontal direction 

 Repeat in vertical direction 

 Do not repeat 
 
Horizontal Align 
Sets the horizontal position for the background image.  
Vertical Align 
Sets the vertical position for the background image.  
 
Cell HTML 
View generated HTML of the selected cell. You can also insert your own HTML code! 
 
 
Table Tips:  

1. While resizing the table, hold down the Ctrl-key to resize last column/row of a table with 
affecting the size of the other columns/rows. 

2. To select multiple cells hold down the Ctrl-key while selecting the cells. 
3. To select the whole row, move the mouse cursor to the left border of the first cell. 
4. To select the whole column, move the mouse cursor to the top border of the first cell. 
5. To change the properties of multiple cells in one action, first select the cells and then click Cell 

Properties. 
6. To center an image in the middle of a cell, open Cell Properties, specify the background image, 

set Repeat to 'Do not repeat' and set Horizontal/Vertical Align to 'Center'. 
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Arrange Menu 
The arrange menu contains all operations related to the layout of the current page. 
 
Align 
Lefts 
Aligns the left edges of the selected objects with the dominant object. 
  
Centers 
Aligns the centers of the selected objects with the dominant object  
 
Rights 
Aligns the right edges of the selected objects with the dominant object  
 
Tops 
Aligns the top edges of the selected objects with the dominant object  
 
Middles 
Aligns the middles of the selected objects with the dominant object  
 
Bottoms 
Aligns the bottom edges of the selected objects with the dominant object  
 
Space Evenly 
Across  
Evenly spaces the selected controls horizontally 
 
Down 
Evenly spaces the selected controls vertically 
  
Center in Page 
Vertical / Horizontal 
Centers the controls vertically or horizontally within the web page  
 
Make same size 
Width 
Resizes the selected objects to have the same width as the dominant object 
 
Height 
Resizes the selected objects to have the same height as the dominant object 
 
Both 
Resizes the selected objects to have the same size as the dominant object 
 
Arrange 
Move To Front         
Move object to front of the page 
 
Move To Back 
Move object to back of the page 
 
Move Forward 
Move object to next position in z-order 
 
Move Back         
Move object to previous position in z-order 
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Grouping 
Group 
You can group multiple objects, so that they stick together when you move them. When you select one 
object of a group, the other objects will automatically be selected too. Grouped objects can not be 
edited until you ungroup them. 
 
Ungroup 
Ungroup objects. 
 
Merging Objects 
By using this option you can merge multiple objects into a single image! This can be useful for merging 
multiple (layered) shapes into a single image to reduce the number of published images and speed up 
loading times. This option will basically convert any object (or group of objects) into an image. So if this 
is used for objects like forms, buttons, menus then they will lose their original functionality, because 
they will be published as a static image. 
 

Tip:  
You can also use this option on a single object. This can be useful to convert an image or shape to 
another image format. 
 
For example: 
Let's say you have applied a shadow effect to an image. The output format of the image will then be 
PNG. Now select 'Merge' from the menu. The image will be converted to an 'merged object', you can 
now select another output format like jpg which will result in a smaller output image). 

 
Split Objects 
This option will split previous merged objects. 
 
Set Tab Order in Forms 
The option 'Set Tab Order' can be used to quickly set the Tab order in forms. 
Here's how it works: 
1) First select the form. 
2) Next select the 'Set Tab Order' option in the menu (also available in the context menu of the form). 
3) Quick ‘n Easy Web Builder will now display the current index of each form element that supports the 
tab index attribute. If the tab index is not set yet, it shows 'Not Set'. 
4) Now click each object in the desired order. The new index will automatically be displayed. 
 



Quick ‘n Easy Web Builder   

43 

Guide settings 
 
Show Table Cell Outlines (if border = 0) 
When this option is enabled Web Builder will draw table cell outlines even if the border is zero. 
 
Show Ruler Guides 
Horizontal and vertical ruler guides are used to align objects on the page.  
Typically ruler guides are placed on the page by dragging them from the horizontal and vertical rulers or 
by specifying precise positions using the 'Format Ruler Guides' dialog box.  
Alternatively you can use the menu option 'Add Horizontal Ruler Guide' or 'Add Vertical Ruler Guide' to 
insert a new guide. 
  
To move the ruler guide, position the mouse pointer over the guide, until you see the vertical or 
horizontal Adjust pointer and then drag the guide to its new position.  
 
You can remove a single ruler guide or all ruler guides from a page 
Position the mouse pointer over the ruler guide you want to delete until you see the adjust pointer and 
then drag it back to the ruler. 
Or you can use the 'Format ruler guide' dialog box to delete the ruler.. 
 
To remove all ruler guides in a page, select the Arrange menu, point to Ruler Guides, and then click Clear 
All Ruler Guides.  
 
Objects which are placed close to a guide "snap to" the guide for easy alignment. 
 
Show smart guides when objects are aligned 
Smart guides are dynamic guidelines that appear when you move objects into alignment with each 
other. 
 
Snap to ruler guides 
Enable or disable snap to ruler guides  
 
Show Grid 
Show or hide grid. 
 
Snap to grid 
Enable or disable snap to grid. Use the Snap to Grid feature to align objects exactly. Web Builder creates 
a "magnetic" attraction between the selected object and the grid.  
 
Grid Spacing 
Specifies the spacing between the grid dots. 
 
 
Edit Points 
This option can be used for Polygons and Curves to add, edit and remove nodes. 
To start editing nodes, first select the Polygon or Curve and then select 'Edit Points' from the menu. 
To edit existing nodes simply hold the left mouse button and drag it to its new position. 
To add a new node, click anywhere on the line and drag the point to the desired position. 
To remove a node, hold down the CTRL key and click the node with the left mouse button. 
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Tools Menu 

 
Asset Manager 
The Asset Manager can be useful to modify the location of one or more assets (images, movies, sounds 
etc) without the need to open the properties of each item. You can select which group of items will be 
displayed in the Asset Manager (Filter). 
 
To change the location of only 1 asset, simply select the item, click the 'Update' button and select the 
new location. To change the location of multiple assets, select the items, click the 'Update' button and 
select the new location. This means that you can update the location of all assets with just a few clicks! 
 
It is also possible to move assets to another location. In that case a copy of the assets will be made to 
the specified location and update the path in the editor. Note that the original file will not be deleted! 
 
Another handy feature of the Asset Manager is the ability to show all orphan files in the project folder.  
Select Filter->Orphan files to display a list of all the assets no longer used by the current project. Now 
you can select and remove those files from the project folder. 
 
Sandbox folder (Mac App Store version only) 
The Mac App Store version of Quick ‘n Easy Web Builder is ‘sandboxed’. This means that the software 
has limited access the file system. See ‘App Store Sandboxing’ later in this document. 
The option Sandbox folder allows you to select a folder to give the application access to the files in the 
specified folder. Usually this is the Documents folder. 
 
Animation Manager 
The Animation Manager can be used to define animations (with key frames). We have included a few 
example animations to help you get started. 
 

Important:  
Not all animations are useful for all objects. For instance animating the background color of an image or 
shape will not do anything because there is no background in that case.  Also animating 
left/top/width/height/margin/etc will not work for most objects because these values are usually fixed. 
If you want to animate the size or position of an object it's better to use transforms. See the examples 
for more details. 

 
The first step in creating animations is to define 'key frames'. A key frame is a point that defines the start 
and end of a transition. The simplest animation will have two key frames - one at the start (0%) and one 
at the end (100%) - whereas more complex animations will have more key frames in between. 
In the key frame you set the position (in percentages) along the duration of the animation. You must 
specify at least two key frames (0% and 100%), but you can have many as you like. 
Each key frame defines a property (and value) that is applied to the element at the specified stage of the 
animation. 
 
Example: 
First key frame: 0% -> background color #000000 
Last key frame: 100% -> background color #FFFFFF 
This will smoothly animate the background color of an object from black to white. The timing is defined 
in the animation properties of the object, not in the animation itself. This way you can reuse an 
animation in different objects with different timing settings. 
 
You can animate multiple CSS properties at the same time by using multiple key frames with same 
position.  See the include examples to get a better idea how to create your own animations. 
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Extension Manager 
Extensions (also called add-ons or plugins) are components which enhance the functionality of Quick ‘n 
Easy Web Builder. Extensions can be accessed through the Toolbox or via the Insert menu just like the 
standard objects.  
 
The Extension Manager helps you organize extensions. In the Extension Manager you can install/remove 
and update extensions. The Installed Extensions page displays all extensions which are currently 
installed. If you do no longer need a specific extension you can remove it by clicking the 'Uninstall' 
button. 
 

Note:  
Please make sure that none of your projects uses the extension if you decide to remove a specific 
extension, otherwise you will no longer be able to load that project until you re-install the extension. 

 
The Online Gallery page displays all extensions available for download and installation. If a new version 
of an extension that you already have is available online, then you have the choice to update it. Each 
time you open this window, Quick ‘n Easy Web Builder will ask if you wish to download the most recent 
list from the website. Normally you will have to do this only once a week.  
  

Notes:  
The built-in Extension Manager only works properly if the software can access our web server! If for 
some reason your firewall or virus scanner blocks access the Internet connection then you will not be 
able to use this feature. To fix this problem make sure Quick ‘n Easy Web Builder is on the exception list 
of your firewall/virus scanner!  

 
The Manual Install page allows you to manually install extensions. Click the 'Install' button to select an 
extension file (*.xmz) or zip file.  
You can also manually install extensions by copying the .xmz file to the extensions folder: 
/Library/Application Support/Quick ‘n Easy Web Builder/extensions/ 
 
 

Disclaimer: 
Extensions are made available as an extra service for registered users. They are not an official part of the 
software. Pablo Software Solutions will not offer support for third party extensions and is in no way 
responsible for proper functioning of these extensions. All extensions are provided "AS IS" for those who 
find them useful. Of course we will do our best to make sure they work properly. 
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Site Map 
The sitemap tool creates an XML sitemap that can be submitted to Google and other search engines to 
help them crawl your website better.  A Sitemap is an XML file that lists the URLs for a site. It allows 
webmasters to include additional information about each URL: when it was last updated, how often it 
changes, and how important it is in relation to other URLs in the site. This allows search engines to crawl 
the site more intelligently.  
  
It's important that you specify the full URL to your website, for example 
http://www.quickandeasywebbuilder.com/  
This URL must begin with the protocol (such as http) and end with a trailing slash, if your web server 
requires it. You can specify the change frequency and priority for each page in your website. 
 
Change frequency 
How frequently the page is likely to change. This value provides general information to search engines 
and may not correlate exactly to how often they crawl the page.  Valid values are: always, hourly, daily, 
weekly, monthly, yearly, never. The value "always" should be used to describe documents that change 
each time they are accessed. The value "never" should be used to describe archived URLs. 
 
Please note that the value of this tag is considered a hint and not a command. Even though search 
engine crawlers consider this information when making decisions, they may crawl pages marked 
"hourly" less frequently than that, and they may crawl pages marked "yearly" more frequently than 
that. It is also likely that crawlers will periodically crawl pages marked "never" so that they can handle 
unexpected changes to those pages. 
 
Priority 
The priority of this page relative to other pages on your site. Valid values range from 0.0 to 1.0. This 
value has no effect on your pages compared to pages on other sites, and only lets the search engines 
know which of your pages you deem most important so they can order the crawl of your pages in the 
way you would most like. The default priority of a page is 0.5. 
 
Please note that the priority you assign to a page has no influence on the position of your pages in a 
search engine's result pages. Search engines may use this information when selecting between pages on 
the same site, so you can use this tag to increase the likelihood that more important pages are present 
in a search index. Also, note that assigning a high priority to all of the pages on your site will not help 
you. Since the priority is relative, it is only used to select between pages on your site; the priority of your 
pages will not be compared to the priority of pages on other sites. 
 

  
 
The final step is to tell Google where it can find your sitemap.  
https://www.google.com/webmasters/tools/docs/en/sitemap-generator.html#submitting  
 
The location of the sitemap will be something like:  
http://www.yourwebsiteurl.com/sitemap.xml 
 

http://www.yourwebsiteurl.com/sitemap.xml
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Preferences. 
 
HTML 
Include page name in automatically generated ID attributes. 
This option will add the page name to automatically generated ID when a new object is added to the 
page. So for example 'Image1' it will become 'indexImage1'. Where 'index' is the name of the page. 
This can be useful when you use lots of master pages in which case it will prevent duplicated ID 
attributes within a page. 
 
Note:  This option does not change your existing ID's only for newly created objects! 
 
HTML Formatting 

 Default 
The HTML will be published "AS IS". No formatting will be applied. 

 Beautify 
Formats the HTML code so it looks better and is easier to read. If you select this option, then 
the size of the page will slightly increase because of the extra white spaces added to the page. 
But in general this does not affect the performance in the browser 

 Minify 
This option reduces the size of the generated HTML and may improve the performance of the 
page. However, the HTML becomes more difficult to read. 

 

Notes:  
-  Formatting will affect all HTML on the page. Including custom code and code generated by extensions!  
-  PHP and JavaScript will not be formatted.  

 
 
CSS 
Generate external CSS style sheets for page specific styles. 
Enable this option to generate a separate CSS file with the styles used by a page. The name of the file 
will be the same as the page name. So 'index.html' will generate a 'index.css' file. Inline styles will not be 
part of the style sheet! So for the best results your objects should make use of styles created in the Style 
Manager. 
 
Generate single CSS style sheet for global styles. 
Enable this option to generate a single CSS file with all styles created in the Site Manager. All pages will 
refer to this file. The global style sheet will not contain page specific styles (like menubar styles). 
 
Optimize inline styles (experimental) 
This is an option which attempts to clean up the HTML code by moving inline styles to the page's style 
sheet.  
 

Note:  
This option will process all HTML elements on the page, however not all (third party) extensions may 
support this behavior.  So please test all functionality of your website before using this! 

 
Use CSS3 gradients instead of images (when possible). 
Enable this option to generate CSS styles for background gradients instead of images. This reduces the 
number of images generates for the page. Keep in mind however than not all browsers (especially 
Internet Explorer!) do support CSS3 gradient yet. 
Also note that not all gradients styles are yet supported, for in some case images still will be used. 
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CSS Formatting 

 Default 
The CSS will be published "AS IS". No formatting will be applied. 

 Beautify 
Formats the CSS code so it looks better and is easier to read. 
If you select this option then the size of the page will slightly increase because of the extra 
white spaces added to the page. But in general this does not affect the performance in the 
browser. 

 Compact 
This option compacts all styles from one section into one line.  

 Minify 
This option reduces the size of the generated CSS and may improve performance. Note 
however that the CSS becomes more difficult to read. 

   
 
JavaScript 
Generate external JS file for page specific scripts. 
Enable this option to generate a separate JS file with the script used by a page. The name of the file will 
be the same as the page name. So 'index.html' will generate a 'index.js' file. 
 
Move JavaScript to the end of the page 
This will place all scripts at the end of the page and may result in better performance because the 
JavaScript will be executed after the rest of the page has been loaded. This is also known as 
"Unobtrusive JavaScript". 
 
JavaScript Formatting 

 Default 
JavaScripts will be published "AS IS". No formatting will be applied. 
 

 Minify 
This option removes all white spaces and line feeds from the code. This reduces the size of the 
page or script file and may improve performance. Note that the JavaScript will become more 
difficult to read and debug. 

   
 
Responsive Web Design 
Keep inline styles with Responsive Web Design (use !important). 
This option applies to Responsive Web Design only. This is an advanced option. Do not change this 
option if everything works correctly!  
 
When using Responsive Design Design/breakpoints, the software will move all inline styles of objects to 
the <style> section in the header of the page. This makes it possible to use CSS3 media queries to 
control the position, size and visibility of objects for different breakpoints. 
However, in some cases this may affect the behavior of an object or extension. If you enable this option 
then the software will not touch inline styles, but add !important to overwrite the position, size and 
visibility of objects with media queries. 
 
Use 'Include visibility' as default for new objects in Responsive Web Design. 
This option sets the default value for 'Include visibility' in Responsive Web Design. 
A description of the 'Include visibility' option is available here. 
 
Hide new objects on other breakpoints (Responsive Web Design) 
When this option is enabled then new objects will be set invisible in other breakpoints. This is usually 
the best option because new objects generally do not have the same position in different breakpoints. 
You can use the Object Manager to make the object visible in other breakpoints. 
 



Quick ‘n Easy Web Builder   

49 

Web Fonts (@font-face) 

 Do not use @font-face (default) 
No code will be generated to support non-web safe fonts. 
 

 Manually specify @font-face fonts. 
Enable this option to manually configure @font-face fonts. Note that different browsers 
support different types of fonts. So you may need to configure multiple formats for the same 
font.  

 

Notes about @font-face:  
- Be aware that font files can be pretty large, so they can add a considerable weight to the page.  
- Make sure you check the license of the font you wish to use, as most fonts are not licensed to allow 
this kind of use. Making the font available on your server violates most end user licensing agreements.  

 

 Use Google Fonts for non-web-safe fonts 
Enable this option if you plan to use Google Fonts in your project. If this option is enabled then 
the software will assume that all non-web safe fonts you are using are Google Web Fonts and it 
will automatically generate a link to the font in the HTML code, so you do not have to do that 
manually. Note however that to use Google Fonts during design time you must have it installed 
on your computer! 

  
Here's how you can install a Google Font on your computer: 
1) Visit the Google Fonts website: http://www.google.com/fonts/ 
  
2) Find the font you want to use and add it to a collection (Click 'Add to collection'). Take note of the 
font name, you will need it in step 6. 
  
3) To be able to use the font on your computer you will have to download and install it so it will be 
available in Quick ‘n Easy Web Builder (and other software). 
Click the “Download your Collection” link at the top of the Google Fonts website and you’ll get a zip file 
containing all the requested font(s) in TTF format. 
  
4) Unzip the collection and drag the TTF files to your fonts folder. The font(s) will now be available to all 
your applications. 
  
5) To see the font in Quick ‘n Easy Web Builder, make sure the option 'Display web safe fonts only' is 
disabled: Preferences ->Miscellaneous
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Publish 
Connection Timeout, increase this value if you experience timeouts while connecting to the FTP server. 
Default is 30 seconds. 
 
Enable Logging, enable logging when you have problems while publishing your web site. The log might 
contain useful information about the problem. 
 
Images name prefix. Some objects such as shapes, navigation bar buttons will be published as 
(dynamically generated) images. These images do have an unique name within the website (eg 
img0001.gif, img0002.gif). With this option you can control how the images will be named. For example 
if you specify qwbimage as prefix, the images will be named 'qwbimage0001.gif' or 'qwbimage0002.png' 
It is also possible to make the name of the page part of the filename by enabling the option Use page 
name for image prefix, this makes it easier to keep track of which images belong to a specific page 

 
Preview Scope, this option specifies the preview scope of Web Builder. Select Current Page to only 
preview one page or Entire Web Site if you want to test your complete web site. 
 
If the option Remove old preview files before previewing is enabled, QnE WB will remove all previously 
generated files the next time you select the preview option. This prevents that old files will be left 
behind and only new files exists in the preview folder. 
 
Target folder for File Types 
It’s possible to publish images, scripts, swf, pdf, css and other files to separate folders on the server. This 
will keep your web site organized. If the server does not support sub folders, then remove all file types 
from the list. In that case all files will be published to the same folder as the HTML files. 
Note: The folders are relative to the folder of the HTML page. So if you have created folders in the Site 
Manager then each folder will have its own sub folders for the files! 
 

Miscellaneous preferences 
Language: Use this option to specify the language used for the user interface. Default is English.  
If you language is not available the please check out the web site for more details: 
http://www.quickandeasywebbuilder.com/forum/viewtopic.php?f=10&t=40229 
 
Display web safe fonts only: You can enable this option so the software will only display web safe fonts.  
 
Enable docking/floating panes: Enable this option if you would like to re-arrange the Toolbox, Site 
Manager and Property Inspector windows using drag & drop. For advanced users only! 
 
Enable standard context menu in text controls (Mac only). This option enables the standard context 
menu is text controls. This option is disabled by default because it may cause problem in OSX 10.8 
 
Backup folder: You can automatically make backups of your projects, before overwriting a previous 
version of the project. Backup folder specifies the folder where the backup will be stored.  
 
Total number of site backups. Specifies the number of backup to keep before overwriting them with 
newer versions. Enter 0 is you do not want Web Builder to create backups. The backups will be named 
like this: myproject_01.qwb,  myproject_02.qwb. The highest numbered file will always be the latest 
backup. If the maximum number of backups is reached, the oldest backup will be deleted and all other 
backups will be renamed. 
 
Auto backup 
Enable this option to automatically make backup copy of your project every 5, 15, or 30 minutes. This 
may help you restore your work if your computer crashes unexpectedly. The name of the backup will be 
myproject_autobackup.wbs and it will be stored in the backup folder. 
 

http://www.quickandeasywebbuilder.com/forum/viewtopic.php?f=10&t=40229
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Asset Management 
If you enable Automatically manage images and other files used by a project, then Quick ‘n Easy Web 
Builder will make a backup copy of all assets (images, movies, sounds) which are part of your website to 
a folder relative to the project file, so all files will be stored in one place. The name of the folder will be 
the same as the project name. This means that if your project is called 'mywebsite', then all assets will 
be stored in the sub folder 'mywebsite'. Copying or moving your project to another computer is now as 
easy as copying the project file and its sub folder the other PC! 
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Search Index 
Quick ‘n Easy Web Builder has basic built-in 'search engine' functionality, so visitors can search for 
specific words within your website. To make this feature available non-advanced users we decided to 
use Javascript as it does not require you to setup database and indexing service on the server. The 
downside is that it can be slower for larger websites (> 100 pages). 
 
Generate Search Index for this project 
Enable this option to create the search index during publishing. 
 

Note:  
The search index is required if you want to use the 'Site Search' object on your website! 

 
Name of Index File 
Specifies the name of the search index file. Since this is a javascript file, it must have the .js extensions. 
 
Create Index from 
This option specifies how the search index will be created. 
 

 Page Content 
The search index will be created from the content of the page. In this case Quick ‘n Easy Web 
Builder will extract all text from the pages.  

 Meta tags 
The search index will be created from the meta tags you've specified content in Page 
Properties.   

 Text Only 
This will only index the text which result in a smaller/faster search index. In most cases this 
mode will be sufficient enough. Note that will also decrease the time required to create the 
search index during publishing. 

 
Use absolute links 
Enable this option if you want to use the search engine in sub folders. In that case absolute links must be 
used otherwise the links in the search results will not be using the correct path (because there is only 
one search index in the root of the website). 
 
Example: 
http://www.yourwebsite.com 
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jQuery UI Theme Manager 
The Theme Manager provides an alternative way to create jQuery UI themes which are used by objects 
like jQuery Accordion, jQuery Tabs and many other jQuery based widgets. Normally you would create 
these themes via http://jqueryui.com/themeroller/, but you can create awesome themes directly from 
within the software!  
 
To create a new theme click the 'Add' button. Now you can specify styles for each state of the jQuery 
widgets. There is the default state, the hover and activate states, and the content area. The content 
area may be the panel of a set of tabs or an accordion. You can also set the global font-family, font-style 
and the font-size. The corner radius specifies the roundness of the borders. In the right panel you can 
preview the result of the specified styles. 
 
When you are done designing your theme click 'Save'. The Theme Manager will now generate the CSS 
files and associated images. The files will be copied to the  
/Documents/Quick ‘n Easy Web Builder/themeroller/ folder.  If the theme already exists then you will be 
asked to overwrite the current theme. Note that when you save a theme with the same name as a 
standard theme then (like 'cupertino' or 'smoothness') then the custom theme will be overwritten!  
 
You can also create a new theme based on an existing theme by using the 'Copy' button. It's even 
possible to import CSS themes generated by the theme roller website. Although this will only import the 
color scheme of course, because it not possible extract style data from images! 
 
In the Page Properties you can select the theme for a page (which then will be applied to all objects on 
that page). And although the Theme Manager was designed to create themes for jQuery UI widgets, 
other objects also support the themes! For example you can select 'Use page theme' in the menubar, 
navigation bar, tab menu and many other objects.  
 
Of course you can also use themes create on the ThemeRoller website: 
http://jqueryui.com/themeroller/. New themes must be copied in the ‘themeroller’ folder of  
Quick ‘n Easy Web Builder: /Documents/Quick ‘n Easy Web builder/themeroller/  

http://jqueryui.com/themeroller/
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Site Manager 
The Site Manager can be used to manage the structure of your web site. When your web site has more 
than one page they must all be part of the same Web Builder project file. The Site Manager can be used 
to add, edit, remove pages and organize your web site. There is also a button to open the properties of 
the selected page. The New Folder command gives you the possibility to organize your pages in folders. 
 

 
 
In the picture above, you see an example of a web site structure. The filename of this example web site 
is called 'mywebsite.qwb', this name is always displayed at the root of web site tree. The root can have 
one of more pages and each page can also have sub pages. 
Web sites always have a home page, which is often called index, so for this reason Web builder 
automatically adds this page to each new project. The names of the items (pages) in the site tree are the 
actual file names of the target HTML files, so if you named a page 'index' is will publish as index.html. 
 

Adding a new page 
1. Select the position where you want to insert the page, for example select the root (the top level 

item) to insert the page to the first level. 
2. Click the first button on the toolbar (New Page) 
3. Web Builder adds the new page to your project and will automatically open it, so you can start 

building the page. 
 
To insert a new page as child of an existing page or folder, first select the parent and click 'New Page' 
 

Tip:  
You can also use the context menu (right mouse click) to add new pages to the web site or you can 
select Page->New Page from the Quick ‘n Easy Web Builder menu. 
 

 
 

Adding a new folder 
1. Select the position where you want to insert the folder, for example select the root (the top 

level item) to insert the page to the first level. 
2. Click the second button on the toolbar (New Folder) 
3. Web Builder adds the new folder to your project.  

 

Open an existing page 
1. Select the item (page name) your want to edit 
2. Click the third button (from the left) on the toolbar (Edit Page). 

 

Inserting an external file 
This option can be useful if you want to make an external file part of the project, so you can easily link it 
or make it part of the sitemap. 
And although this option was designed to include HTML files, it can basically used for any type of file. 
Note however that it will only be a link to the file. You will not be able to edit the file directly in Quick ‘n 
Easy Web Builder. 
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Cloning an existing page 
To make an exact copy of an existing page, select the item (page name) you want to clone and click the 
fourth button (from the left) on the toolbar to insert a copy of that page. 
 

Remove a page/folder 
Select the item (page or folder name) you want to remove and click the remove button on the toolbar or 
press the Delete key on the keyboard. You cannot remove the last page in your web site. 
 

Rename a page/folder 
Select the item (page or folder name) and press F2 to enter the new name.  
You can also use the context menu (right mouse click) to select and rename a page/folder. 
When you have linked to the page, you are renaming (from any page within the web site), Web Builder 
automatically updates all the links for you, and so you don't have to redo all the internal links. 

 
Notes about page names 
While building your web site, Web Builder saves the project file with the .qwb extension. This is a 
project file used by Web Builder to simplify the building process. One project file can contain multiple 
web pages. Once your pages are ready you must export or publish them as HTML.  
The name of the output HTML file is taken from the name you have specified in the Site Manager. 
So if you named the page index then the output file will be called index.html. If the page needs another 
extension like .php, you can configure this in the Page Properties. 
 
Here are some guidelines how to name your web pages: 

7. Do not add .html or .htm extension to the page name. Web Builder will automatically add the 
.html extension (or .php, .asp) when it publishes (or exports) the HTML code. 

8. Always name your homepage: "index", this is the most common name for a homepage. 
9. Always use lowercase filenames, most web servers are case sensitive and might fail to find your 

page if you have called it "Index" or "INDEX" 
10. Do not use space or other special characters in the name, keep them simple like: 

"page1" 
or 
"my_products" 

11. Use underscores to connect words. 
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Arrange Items 
You can arrange items by using drag and drop select the item and drag it to the position where you want 
to move it to. Dropping an item on another item will automatically make it a child of this item. To 
prevent this you can hold down the CTRL key, this will move the item below the drop item. 
Another way to arrange items is using the context menu: 

1. Select an item 
2. Right click to display the menu. 
3. Select Arrange and one of the available items: Move Up, Move Down, Move Left or Move Right. 

 
 
 
Don't Publish this page (available in the context menu of the Site manager) 
Enable this option if you don't want this page to be published if you select Publish Entire Web Site. 
Possible reason for this can be: 

1. This page is currently not part of the website or still under construction 
2. The page is only used as part of your other pages e.g. Master Page. 
3. The page is not changed so there's no need to publish it again. 

 
Don't Include this Page in the Site Map (available in the context menu of the Site manager) 
When this option is enabled the page will not be included in the site map. 
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Object Manager 
The Object Manager gives an overview of all objects in the current page; you can make objects invisible, 
lock/unlock objects, change the z-order or remove a specific object. Double click an object to select it in 
the workspace.  
 

 
 
More about the z-order of objects 
Quick ‘n Easy Web Builder uses CSS positioning to create pixel perfect layouts in HTML. CSS operates in 
three dimensions - height, width and depth. In Web Builder each object (element) of your web page is 
placed on a separate layer, which makes it possible to overlap these objects something which can not be 
done using standard HTML/dynamic page layout). For that purpose, you can assign each element a 
number (z-index).  Elements with a higher z-index overlap an element with a lower z-index. The z-order 
is the order in which objects will be displayed by the browser. 
 
WB automatically generates the z-index for each object you add to your page. So the first element will 
have z-index '0', the next object '1' etc. To change the z-index of objects you can use the arrange tools 
(Layout->Arrange) or the Object Manager. The following arrange tools are available: 
 
Move To Front   
Move object to front of the page 
 
Move To Back   
Move object to back of the page 
 
Move Forward   
Move object to next position in z-order 
 
Move Back   
Move object to previous position in z-order 
 
For example, you want to display the objects in a particular order. 

1. Select all objects one by one in the order you want them to be displayed. 
2. After you have selected an object, click Layout->Arrange->Move to Front 
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Property Inspector 
Use the Property Inspector window to view and change the properties of selected objects.  
You can also use the Property Inspector window to modify page properties. The changes will be visible 
immediately in the workspace. 
  

 
 
To display the Property Inspector window click Property Inspector on the View menu. The Properties 
window typically displays in the bottom right corner of Quick ‘n Easy Web Builder.  
 
Categorized (Toolbar Button) 
Lists all properties and property values for the selected object, by category. You can collapse a category 
to reduce the number of visible properties. When you expand or collapse a category, you see a plus (+) 
or minus (-) to the left of the category name. Categories are listed alphabetically. 
 
Alphabetic (Toolbar Button) 
Alphabetically sorts all properties for selected objects.  
 
Properties/Values 
Displays the properties and their values of the select object.  
 
Description pane  
Shows the property type and a short description of the property.  
 
The ID property 
The ID property of an object should be unique within the page. Normally Quick ‘n Easy Web Builder will 
give your object unique names automatically. However if you use one of more master pages, then IDs 
may be duplicated, since the software cannot distinguish a master from a normal page. We recommend 
giving objects on a master page names with a prefix like MasterPage_Text1. This will make sure that if 
the master page is used in another page, the ID of the objects is unique. 
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Style Manager 
The Style Manager (Menu->Format->Style Manager) is a central place to add, edit or remove style 
definitions for the entire website. Updating a specific style will affect all objects using that style. For 
example you can update all fonts of your website in one operation.  
  

 
 
There are six standard heading styles (H1, H2, H3, H4, H5, H6), which normally are used for text headers 
only. Other styles can be used for all other objects that support them, like form elements and tables. 
  
When you add a new style all attributes of the style are empty (= default). You do not have to specify 
values for all attributes. It's also possible to define custom style attributes. You may have noticed that 
we did this for the header styles (CustomStyle is display: inline;), to make sure it is displayed correct in 
all browsers. 
 

Notes:  
Not all style attributes are useful for all objects! For example margins and padding are current ignored 
by most objects. These attributes were only added to fix browser incompatibility issues for header 
styles.  
 
Header styles (H1, H2 ...) can only be applied to text. 
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Quick ‘n Easy Web Builder Objects 

 
In Quick ‘n Easy Web Builder your web pages are created by dragging and dropping objects on the page. 
Most of these objects represent a standard HTML element. There are 2 ways to insert object to your 
page: 
 

1. By using the Insert menu. 
2. By using the Toolbox 

 
To insert a new object, select one of the available items and draw a box to indicate the position of the 
object. The new object will now be inserted to the page. To change the properties, click the object and 
the properties will be displayed in the Property Inspector. 
 

Tip:  
Another way to add objects to your page is by simply dragging them out of the toolbox onto the 
workspace. 

 

 
 
The Quick ‘n Easy Web Builder toolbox contains all objects you can add to your page. 
A detailed description of all available objects follows later in this document. 
 
Quick ‘n Easy Web Builder Extensions 
Extensions (also called add-ons or plug-ins) are components which enhance the functionality of Quick ‘n 
Easy Web Builder. Extensions can be accessed through the Toolbox or via the Insert menu just like the 
standard objects. In the future we plan to release a wide range of extensions to make Quick ‘n Easy Web 
Builder even more powerful than it already is.  
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Anchor 
Anchors (also called bookmarks) mark a specific location on a page. With an anchor a visitor of the page 
can go directly to a particular part of the page without having to scroll to it. You can place the anchor 
icon anywhere in the page. Make sure you give the anchor a unique ID. You link to an anchor from the 
link dialog. 
 
You can create an anchor by using the Anchor tool from the Insert menu and place it anywhere in the 
page. Make sure you give the anchor a unique name. Once you have placed the anchor icon on your 
page, it can be selected from the Anchor dropdown list in Link properties.  
 
 
Enable Smooth Scrolling 
Enable this option to animate the page scrolling. This effect is often used in modern websites. The 
Duration specifies the timing of the animation. Easing can be used  to create ‘bounce effects’. 
 
Events 
The following events are unique to Quick ‘n Easy Web Builder. They make it possible to trigger actions 
based on the scroll position of the page. For example you can start animations or show/hide objects 
when the bookmark scrolls into (or out of) the viewport. 
 
onscrollreveal 
Fires when the bookmark is completely visible in the view port of the browser. 
 
onscrollrevealpartial 
Fires when the bookmark is partially visible in the view port of the browser. 
 
onscrollhide 
Fires when the bookmark is scrolled out of the browser's view port. 
 
You can read more about bookmarks in the ‘Links’ chapter. 
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Horizontal Line 
The Line object is used to insert a horizontal line <hr> across the page. 
 

 
 
Color 
Specifies the color of the line. 
 
Use jQuery UI theme 
Use the jQuery UI theme to style the object. More details about themes: Theme Manager. 
 
Box Shadow 
Configure box shadow (also called drop shadow) for the object. This feature requires a CSS3 enabled 
browser. 
 
 

Note: HTML does not have a vertical line object, but in Quick ‘n Easy Web Builder you can use the shape 
object or draw tools instead. 
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Heading 
This object provides a quick and easy way to add headings (<h1>, <h2>) without using styles. Each 
heading object can have its own fonts/size/color independently from the styles defined in the Style 
Manager. 
 
Note that you can also use Styles to insert headings into the standard text objects, but in that case the 
all headings will have the same style. 
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HTML 
This object can be used to insert custom HTML, PHP code or JavaScript. 
When you add HTML using this object it will be place at the location where you positioned the object.  
 
Description 
This is used for display in Quick ‘n Easy Web Builder only. It can help you identify the code block you've 
added. 
 
Type 
The type property specifies how and where the HTML code will be inserted in the page. 
 

 Do not use <div> 
Select this option to insert the HTML code “AS IS”, without size and position information. 
 

 Use <div> to set position and size of the HTML 
Select this option to insert the HTML code inside a DIV container with size and position 
information added by Quick ‘n Easy Web Builder.  
 
<div style:left:100px;top:100px;width:200px;height:200px;position:absolute"> 
<-- your html --> 
</div> 
 

 Start of Page 
The HTML will be inserted before all other code on the page. 
 
<-- your html --> 
<!DOCTYPE HTML PUBLIC "-//W3C//DTD HTML 4.01 Transitional//EN" "http://www.w3.org/TR/html4/loose.dtd"> 
<html> 
<head> 
 

 Between <head></head> tags 
The HTML will be inserted between the <head></head> tags. 
<head> 
... 
<-- your html --> 
</head> 

 

 Inside <body> tag 
The HTML will be inserted inside the <body> tags. 
 
<body attribute=value> 

 

 After <body> tag 
The HTML will be inserted after the <body> tags. 
<body> 
<-- your html --> 
... 
</body> 
 

 Before </body> 
<body> 
... 
<-- your html --> 
</body> 
 

 End of page 
<body> 
... 
</body> 
<-- your html --> 

 



Quick ‘n Easy Web Builder   

65 

Overflow 
This overflow can be used to control the overflow behavior of the layer. 
 

 None 
The content of the HTML object is fully visible. No clipping will occur. 

 Hidden 
The content is clipped, but the browser does not display a scroll-bar to see the rest of the 
content. 

 Scroll 
The content is clipped, but the browser displays a scroll-bar to see the rest of the content. 

 Auto 
If the content is clipped, the browser will display a scroll-bar to see the rest of the content. 

 
HTML 
Enter your custom HTML code here. 
 
Notes:  

1. For most objects you can also add extra HTML before, inside of after the automatically 
generated HTML.  Select an object and select Edit->HTML from the Web Builder menu. 

2. To add extra HTML before, inside of after the HEAD and BODY tags, select View->Page HTML 
from the Web Builder menu. 

3. If you need to add 'global' HTML to your page, it is better to add it using the Page HTML option. 
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Inline Frame 
Inline Frame or an iframe is allows you to open new pages inside main pages. Inline frames are also 
referred to as Floating frames.  
 
Border Color 
Specifies the color of the border around the inline frame. Set the color to 'Automatic' to display the 
standard 3D border. 
 
Border Style 
Specifies the style of the border: Dotted, Dashed, Solid, Double, Groove, Ridge, Inset or Outset. 
 
Border Width 
Specifies the width of the border around the inline frame. Set this to 0 (zero) for no border. 
 
Alternate text 
This text will be displayed by browsers which do not support inline frames. 
 
Name 
Used to set a name for the inline frame. 
 
Scrollbars 
Used to specify whether the inline frame should have scrolling capability or not. Possible values are: 

 If Needed 

 Never 

 Always 
 
URL  
Specifies the URL or page which will be displayed inside the inline frame. 
 
Lightbox 
The Lightbox option makes it possible to display another page in a lightbox (using FancyBox) after 
clicking on a preview image. You can specify the preview image, lightbox title and width/height of the 
lightbox. 
 
In 'Lightbox Settings' you can specify additional options for the Fancy Lightbox. Each option must be on a 
new line and separated by a comma: 
'transitionIn' : 'elastic', 
'transitionOut' : 'elastic', 
'speedIn' : 600,  
'speedOut' : 200,  
'overlayShow' : true, 
'overlayColor' : '#FF0000' 
 
More information about options is available here: http://fancybox.net/api 
 
 

http://fancybox.net/api
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Marquee 
The Marquee object can be used to display scrolling text. 
 
Behavior 
This attribute controls the behavior of the displayed text. 
 
Direction 
This attribute controls the direction of scrolling. 
 
Loop 
Number of times to repeat the scrolling (0=Continuously). 
 
Pause scrolling on mouseover 
Specifies whether to pause scrolling on mouse over. 
 
Scroll Amount 
This controls the amount of movement (in pixels) between the successive displays that give the 
impression of animation. 
 
Scroll Delay 
This controls the delay (in milliseconds) between the successive displays that give the impression of 
animation. 
 
Responsive Properties 

 visibility  

 object position  

 object size  

 background border color 
 
 

Note:  
Although the Marquee is not an official W3C complaint HTML element, most modern browsers do 
support it! Note however that W3C validators will complain about using this object. 
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Text 
This object allows you to add text to the web page drag the object to the page and double click it to 
start typing your text.  Use the Format Toolbar to change the font, size, color and other properties of the 
text. To insert a link in the text use the Link option. For more information about hyperlinks please read 
the ‘Links’ chapter of this document. 
 
Most text properties can be changed using the format toolbar or using the menu bar’s format item. 
You must first highlight text before you can change the formatting. 
 

Note:  
Although Quick ‘n Easy Web Builder will display all fonts installed on your computer by default, we 
recommend that you only use web safe fonts so your web pages will look the same on all computers. 
You can read more about web safe fonts in the ‘Format menu’ section of this document. 
 
Some browsers have problems with large text blocks and absolute positioning. We recommend splitting 
up large text blocks into multiple smaller text objects. This will result in better layouts. 

 
Overflow 
The overflow property can be used to control the overflow behavior of the object. 

 None 
The content of the HTML object is fully visible. No clipping will occur. 

 Hidden 
The content is clipped, but the browser does not display a scroll-bar to see the rest of the 
content.  

 Scroll 
The content is clipped, but the browser displays a scroll-bar to see the rest of the content.  

 Auto 
If the content is clipped, the browser will display a scroll-bar to see the rest of the content.  

 
 
Publish text as an image 
This option converts the text to image when your page is published. 
This option can be useful if you want the text to be displayed exactly as in Quick 'n Easy Web Builder, 
even when you selected fonts which are not web safe.  
 
The text can be converted to JPG or PNG.  
JPG will use a solid background color because it does not support transparency. 
PNG will result in the best (anti-aliased) quality for larger fonts, but the output image will be larger. 
Note that PNG transparency is currently only supported on the Mac! 
 
Include text in ALT attribute 
If text has been converted to an image, then search engines will not be able to 'see' this text. Select this 
option if you want the original text to be included in the alt attribute. 
 
Defragment 
Enable this option to defragment character formatting and optimize the generated HTML. 
This option can reduce the amount of generated HTML code, but is only useful when the object has the 
same style for all text! 
 
Compatibility 
Unfortunately, there is no way to make text look exactly the same in all browsers. Each browser uses its 
own text rendering engine and they are all slightly different. And although Quick 'n Easy Web Builder 
uses pixels to specify the font size, this still causes different results in different browsers.  To help you 
optimize your text so that it looks as good as possible is all browsers, we have added this compatibility 
option to control the way the text is outputted in HTML. 
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There are 3 output formats. 

 Default 
This option works best for smaller text blocks or if overflow is set to 'scroll'. For larger text 
blocks the text will be rendered larger/smaller depending on the selected browser and may 
cause overlaps with other objects. 

 Optimize text positioning 
Each line will be embedded inside its own div and includes position/size information. A 
common problem with Mozilla based browsers is that they do not handle large text blocks in 
combination with CSS absolute positioning very well. This option attempts to overcome this 
problem by breaking up the text into multiple <div> elements. This will result in better layouts, 
but also increases the amount of generated code. 

 Include line-height in text styles  
Quick ‘n Easy Web Builder will calculate the line-height for each font (based on the rendering in 
the workspace) and add it to the CSS style. In many cases this will give very accurate results in 
various browsers with minimum of code. 
 

 There is not really a preferred output format because it all depends on your layout, so you should try 
what works best for you. And test it in all popular browsers to find the optimal solution. 
 
 
Responsive Fonts 
When this option is enabled the text object can have different font sizes in breakpoints. This can be 
useful if you need a larger font for smaller screens. Each breakpoint can have a different text size. 
Note however that when this option is enabled, you can only use one font-family and font-size for the 
entire text object! Also the use of styles in combination with this option is not supported (because the 
responsive fonts will be applied to the text and that will overwrite global styles).  
However, the Style Manager also supports breakpoints, so if you wish to use styles then do not enable 
responsive fonts, but use responsive styles instead. 
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Image 
Use the Image object to insert image to your page. Drag the object to the page and a file dialog will pop 
up to select the image. Quick ‘n Easy Web Builder supports jpg, gif, and png files. 

 
Border Color 
Specifies the color of the border around the image.  
 
Border Style 
Specifies the style of the border: Dotted, Dashed, Solid, Double, Groove, Ridge, Inset or Outset. 
 
Border Width 
Specifies the thickness of the border around the image. Set this to 0 (zero) for no border. 
 
Alternate text 
This text, usually a short description, appears in place of the object in browser when images are 
unsupported or have been disabled.  
 
Angle 
This option allows you to rotate the image! Specify an angle between 0 and 360. 
Note that rotation is not a standard feature of HTML, the software will create a new image (with a 
different filename) with the rotated picture. 

 
Filename 
Enter the path and filename of the image/picture or select the Browse button to find an image on your 
local drive. 
 

Tip:  
Do not use spaces or other special characters in the filename of an image! Use underscores to connect 
words; this will prevent display problems in some browsers. In general, it's best to use alphanumeric 
character in the filenames only. 

 
Retina image 
Specify an (optional) high-resolution version of the image. This image will be displayed on on retina 
displays. 
 
Title 
In modern browsers this title appears as a ToolTip when you move the mouse over the image. 
 
Reflection 
Specifies the amount of reflection.  
 
Enable Shadow 
Specifies whether to enable the shadow effect. A shadow with an x and y offset of 0 (zero) will produce 
a glow-like effect. Decreasing the blur factor of the shadow will make the edges more sharp. 
 
Lazy loading 
Enable this option to delay the loading of images until they are visible in the view port. This will speed 
up the page loading. It also prevents loading large images in mobile devices because only the visible 
images will be downloaded. 
 
Events 
For more information about events please read the ‘Events’ chapter. 
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Full Width 
Specifies whether the image is full width (responsive) inside a Layout Grid cell. If set to false, the image 
uses a fixed size. 
Note: This option is only available if the image is part of a Layout Grid! 
An alternative way to create full width images is using a layer with a background image and the 
background size set to 'cover'. 
 
Maximum width 
Specifies the maximum size of the image when it is set to full width. This prevents the image from 
getting too large in responsive layouts.  
Note: This option is only available if the image is part of a Layout Grid! 
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Image Tools & Effects 

In Quick ‘n Easy Web Builder, you can apply effects to images without an external image editor! 
 

 Rotate 
Rotate the image 90 degrees left or right.  

 Flip 
Flip the image horizontally or vertically. 

 Contrast 
Adjust the contrast of the image.  

 Brightness 
Adjust the brightness of the image.  

 Resample 
Resampling an image will change the number of pixels and therefore the physical file size of an 
image. Re sampling will be done based on the current size of the image on the page. If the size 
is smaller than the original size, the physical file size is decrease. It it's larger the physical file 
size will increase! 

 Crop 
By cropping an image, you can remove areas of the image that you don't want to use. While in 
crop mode drag the handles of the cropping box to resize and include the part of the image 
that you want to keep. Click Crop again to remove the area outside of the cropping box. 

 Slice 
The slice tool is used for "Slicing" up your images into many smaller pieces you will not notice 
anything on your page because when it is previewed all the piece show as one. The logic behind 
slicing is that your images will load faster and it can also help to stop users from trying to steal 
your images if the try to they won’t get one large image but just one small piece of it. 

 Hue/Saturation 
Adjust the hue or saturation of the image.  

 Add/Replace stencil 
Stencils are a cool way to change the appearance of your images. Stencils can convert your 
images into any shape! Basically stencils replace the alpha channel information (transparency) 
of the image with the one from the stencil. You can create your own stencils and place the 
stencils in the sub folder \stencils of the program.  
 
 

Things that you should know about effects: 
1. You can apply multiple effects to an image. 
2. Effects are non-destructive, which means they are not apply to the original image. A copy of the 

original image will be published to your website using an unique name (.png format). 
3. Effects are applied to the image 'on-the-fly' when the images are loading into workspace and in 

the order you've added them. So for example if you apply Brightness 3 times, the images will be 
processed 3 times the next time you load your page.  

4. Plan your effects! Do not add to many effects to images. This will slow down loading times of 
the image in Web Builder. Before applying effects test which impact the effect has on the 
image, if you do not like it use undo the restore the original image. 

5. Do not apply effects to very large images! The bigger the image, the longer it will take before 
the effect has been processed (just like in any other image editor!). 

6. Resample can be used to decrease the size of the published image and therefore can increase 
the loading speed of your website. Of course resampling will also reduce the quality of the 
image. 
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Some of the available effects are: 

 Aquarelle 

 Blur / Gaussian Blur / Motion Blur 

 Buttonize 

 Colorize 

 Comic 

 Cylinder 

 Diffuse 

 Edge Linear 

 Emboss / Engrave 

 Erode 

 Fish Eye / Pinch / Punch 

 Flame 

 Impressionism 

 Inner bevel frame 

 Invert Luminance 

 Jitter 

 Glow 

 Gold/Ice/Metallic effect 

 Grayscale 

 Laplace 

 Mosaic Tiles 

 Negative 

 Neon Glow 

 Noise 

 Oil Painting 

 Old Photo 

 Pencil 

 Pixellate 

 Psychedelic 

 Replace Color 

 Ripple 

 Sepia 

 Sharpen 

 Sketch 

 Solarize 

 Soften 

 Soft Edges/Feather 

 Splash 

 Swap Color Channels 

 Texture 

 Thermique 

 Threshold 

 Twirl 

 Water Reflection 
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Watermark  

Watermark Tool is the powerful feature that allows you to quickly and easily protect your images with a 
visible watermark.  With the many watermarking options available, you're able to personalize your 
images in a variety of ways including text size, color, and position. 
 
Type 
Specifies the type of watermark. 
 

 None 
The watermark tool will be disabled. 

 Standard 
The text will be rendered in top of the image. 

 Inverted 
The watermark effect will be inverted. 

 Embossed 
This option will use an emboss effect for the text. 

 
Text 
Specifies the watermark text. 
 
Font Type 
Font type is the font family of text, such as Comic Sans, Times New Roman, and Courier New.  
 
Style 
Style of the font such as Bold, Italic or Regular. 
 
Font Size 
Size of the text. 
 
Color 
Specifies the color of the text. 
 
Opacity 
Specifies the opacity/transparency of the text. 
 
Horizontal Alignment 
Specifies the horizontal alignment of the text. 
 
Vertical Alignment 
Specifies the vertical alignment of the text. 
 
Repeat Text 
Enable this option to repeat the text over the full image. 
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Image Map 
You can create an (client-side) image map that divides an image into different areas that each link to a 
different web page. Creating an image map is useful for images such as a floor, campus map or world 
map that you want to contain links to different pages. You can define each clickable area (hotspot) on 
the map using three shape values: rectangle, circle or polygon. 
 

 
 
  
The Image Map has the same properties as the standard Image object (with the exception of ‘Angle’). 

 
Adding Hotspots 
There are two ways to add hotspots to an image map: 

1. Manually entering the coordinates in the hotspot tab of the image map properties 
2. Visually modifying the coordinates using the mouse 

 

Manually entering the coordinates 
Open the image map properties and click the Hotspots tab to insert the coordinates of an hotspot. 
You can insert three types of hotspots: 

1. Circle, here you enter the x and y coordinates of the center and the radius of the circle. 
2. Rectangle, here you enter the x (left) and y (top) coordinates and the width and height of the 

rectangle. 
3. Polygon (Irregular Shape), here you enter each point (x, y coordinates) on the polygon. 

 

Visually modifying the coordinates using the mouse 
A more efficient way to modify the coordinates of the hotspots is by visually dragging them. 

1. Right click the image map to display the context menu 
2. Select the hotspot type you want to insert (Add Circle Hotspot, Add Rectangle Hotspot or Add 

Polygon Hotspot) 
3. A window will popup where you can set the initial coordinates, the URL and alternate text of 

the area. By default, Web Builder will insert the shape in the center of the image map. 
4. After you have clicked OK, the shape will be inserted to the image map, you can now select it 

and drag it around or change its size using the size handles. 
5. To edit or remove the hotspot, right click the area to display the context menu and select Edit 

Hotspot or Delete Hotspot. 
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Photo Album 
The Photo Album object introduces yet another way to display pictures on your web site. 
Basically this object works the same way as the standard Photo gallery object, but the output is 
completely different. Rather than displaying all pictures on 1 page, you can display images over multiple 
pages. The thumbnail navigation option provides a filmstrip-style menu to navigate through the images. 
 
Features 

 Create great looking photo albums with only a few mouse clicks. 

 Add a title and description for each photo. 

 Choose the number of rows and columns and the thumbnail width and height for the index 
page(s). 

 Choose whether navigation controls appear above or below the large photo on photo pages. 

 Filmstrip-style navigation. 
 

Background  

Background Mode 
Specifies the background mode: Solid, Image or Transparent. 
 
Background Color 
Specifies the color of the form background. If set to 'Automatic' the standard (system) button color will 
be used. 
 
Background Image 
Specifies the optional background image. 
 
Horizontal Alignment 
Sets the horizontal position for the background image.  
 
Repeat 
Sets the tiling attributes for the background image. Possible options are: 

 Repeat in both directions 

 Repeat in horizontal direction 

 Repeat in vertical direction 

 Do not repeat 
 
Vertical Alignment 
Sets the vertical position for the background image.  
 

Border 

Border Color 
Specifies the color of the border around the object.  
 
Show Frame Bolder 
Specifies whether to display a border around the photo album. 
 

Miscellanious 

Cell Padding 
Enter how much space you want between the contents and inside edges of thumbnails, in pixels.  
 
Cell Spacing 
Enter how much space you want between the cells of the thumbnails, in pixels. 
 
Columns 
Specifies the number of columns in the photo album. 
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Images 
Use this property to add, edit or remove images. 
 
Image format 
Specifies the output format of the images PNG or JPG. Note that photo album will not publish the 
original images, but a resized copy to make sure all images have the same dimensions. 
 
Large image size 
Specifies the size of the full images.  
 
Prefix large image 
Prefix used for naming the large version of the images. 
All large images generated by the photo album will start with this prefix. For example: 
large_image1.png, large_photo1.png 
 
Prefix thumbnails 
Prefix used for naming the thumbnail images. 
All thumbnail images generated by the photo album will start with this prefix. For example: 
small_image1.png, small_photo1.png 
 
Columns 
Specifies the number of rows in the photo album. 
 
Thumbnail size 
Specifies the size of the thumbnail images.  
 

Navigation 

Labels 
These items allow you to overwrite (eg. translate) the standard text strings.  
 
Link color 
Specifies the color of links within the photo album. 
 
Link hover color 
Specifies the color of hover links within the photo album. 
 
Type 
You can also specify whether you want to display the filmstrip navigation above or below the images. 
 

Text 

Album title 
Specifies the album title, which is be displayed on top of the index page(s). 
 
Album description 
Specifies the album description, which is be displayed on top of the index page(s), under the album title. 
 
Description Style 
Specifies the style of the album and image descriptions (bold, italic, size, color etc). 
 
Title Style 
Specifies the style of the album and image titles (bold, italic, size, color etc). 
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Photo Gallery 
The Photo Gallery object is gives you a tool to create a Photo gallery with only a few mouse clicks. 
 

Options 

Images 
Use this property to add, edit or remove images. 
 
Cell Padding 
Enter how much space you want between the contents and inside edges of cells, in pixels.  
 
Cell Spacing 
Enter how much space you want between the cells in the table, in pixels. 
 
Columns 
The number of images per row. If the thumbnail size is set to 'Responsive' then the number of columns 
can be different in breakpoints. 
 
Generate thumbnail images 
By default, Web Builder will generate a preview window which displays the original images. 
If the size of these images is large it can take a long time before the page is loaded in the browser. 
Instead you can enable Generate thumbnail images which will generate a smaller version of the images 
so the page will load faster.  
 
Horizontal and Vertical Alignment 
Alignment of the thumb images. This option has no effect when the Maintain aspect ratio option is off. 
 
Maintain aspect ratio 
Select this option if you want to maintain the aspect ratio of the image in the thumbnail. 
If this option is not selected the thumbnail will be resized to fit whole rectangle. 
 
Thumbnail title 
Enter the text that will be displayed under the thumbnail image. To enable titles make sure you selected 
the 'Include  title' option in the Text Page. 
 
Target 
Specifies what happens if the user click on an image.  

 Open in the same browser window 
The larger version of the image will be displayed in the same browser window. 

 Open in a new browser window 
The larger version of the image will be displayed in a new browser window. 

 Open in a popup window 
The larger version of the image will be displayed in a popup browser window. The popup 
window will have the size of the full image. 

 Open in another window 
The larger version of the image will be displayed in another window. For example in an inline 
frame. You can specify the name of the target window in the Target Name property. 

 Open in a Light Box 
If you select this option then clicking on one of the images will start a lightbox slideshow. You 
can select one of built-in slideshows: slimbox, prettyphoto, fancybox. 
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Thumbnail size 
Specifies the size of the thumbnail images.  
Select 'Variable' to dynamically determine the thumbnail size. 
Besides the standard sizes you can also enter your own custom sizes. For example: 200x300, 50x150 etc. 
 
Select 'Responsive' to make the photo gallery responsive. When this option is selected the gallery can 
have a different number of columns in breakpoints!  
 
The images in the gallery will be responsively resized based on the available space. This means for 
example that when the gallery is inside a layout grid that it can be full width.  
  
Compatible 
Since version 4 the Photo Gallery uses CSS to implement the gallery functionality (instead of HTML 
tables used by previous versions). However, in some cases the layout of CSS may be different than when 
using table. The main difference is that in CSS the image sizes are calculated based on the width instead 
of the height in tables. 
For this reason, we have added a 'compatible' mode which simulates the gallery from previous versions 
(not responsive and HTML table layout). When you load projects create with a previous version then all 
Photo Galleries will automatically be set to 'compatible'.  
 
Important Note:  
If you select 'Compatible' then new gallery features like responsive columns, descriptions, bootstrap 
frames are not available because they did not exist in older versions! 
 
 
Lazy Loading 
Enable this option to delay the loading of images until they are visible in the view port. This will speed 
up the page loading. It also prevents loading large images in mobile devices because only the visible 
images will be downloaded. 
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Text 

In this section you can select the font family of text (such as Comic Sans, Times New Roman, and Courier 
New), font size, style (Bold, Italic, Underline) and the color of the text. 
 
Include title 
Include the title of the image under the thumbnail. You can also change the font type, size, style and 
color of the title. 
 

Frame 

Border Color 
Specifies the color of the border around the object.  
 
Border Style 
Specifies the style of the border: Dotted, Dashed, Solid, Double, Groove, Ridge, Inset or Outset. 
 
Border Width 
Specifies the width of the border around the object. Set this to 0 (zero) for no border. 
 
Style 
Specifies which style of frame to use. The 'Default' type adds a simply border where you can specify the 
width and color. Quick 'n Easy Web Builder includes several predefined frame styles, but you can  add 
your own styles too (for advanced users only). Copy your own styles (gif, jpg or png) to gallery folder, 
where each style has its own folder. 
 
Polaroid mode 
The Photo Gallery also has Polaroid mode. This uses CSS3 and has a few cool effects like rotated or 
variable sized polaroids. To enable Polaroid mode select (Polaroid) as the frame style. For the best effect 
set the frame width to 20 or more and use 'white' as the color. Also adding a little shadow will give it a 
more realistic effect. 
 
Rotate polaroids will randomly rotate the images to simulate a photo stack. You can also give each 
photo a different size. 
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Rollover image 
Rollover images change swap images on rolling over it (onMouseOver event) and reverts back to the 
original image on rolling out of the object (onMouseOut event). 
 
Alternate text 
This text, usually a short description, appears in place of the object in browser when images are 
unsupported or have been disabled. In some browsers it appears as a ToolTip when you move the 
mouse over the image. 
 
Animation 
Specifies the animation effect for the rollover image: 

 None 

 Fade 

 Slide Left 

 Slide Right 

 Slide Up 

 Slide Down 

 Zoom 

 Scale, uses CSS3 to display a larger version of the image. Uses transformation, CSS3 box 
shadow, a nice image caption when possible (experimental).  

 Sliding Door. This makes it looks like the image is splitted into half and one goes left and the 
other one goes right.   

 
Animation Duration 
Specifies the duration of the animation in milli seconds. 
 
Initial image 
Select the image that will be displayed initially. 
 
Mouse Over image 
Select the image that will be displayed when the mouse is over the object. 
 
Easing 
The slide animations also support easing. You can select from more than 30 easing functions to control 
the animation process. This option can be used to create bounce or elastic effects. 
 
Title 
In modern browsers this title appears as a ToolTip when you move the mouse over the image. 
 
Lazy Loading 
Enable this option to delay the loading of images until they are visible in the view port. This will speed 
up the page loading. It also prevents loading large images in mobile devices because only the visible 
images will be downloaded. 
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Rollover Text 
 
The RollOver Text object displays a text (title and description) banner over an image on mouse over. 
 
Filename 
Select the image that will be displayed initially. 
 
Title 
Title of image. 
 
Description 
Description of the image. 
 
Link text 
The banner can also contain a link. Here you can specify the text for this link. The URL for the link can be 
configured in the 'Link' tab. 
 
Position 
Specifies the position of the text banner. 

 Top 
The banner will be displayed at the top of the image. 

 Bottom 
The banner will be displayed at the bottom of the image. 

 Full 
The banner will be displayed over the full size of the image. 

 
Animation 
Specifies the animation effect for the rollover text banner: 

 None 

 Fade 

 Slide Left 

 Slide Right 

 Slide Up 

 Slide Down 
 
New in version 4: 

 Fall In. Rotate and translate text on hover  

 Revolving Door. 3D transform on hover  

 Translate Left/Right. Translate and scale image to reveal text on hover  

 Tunnel. Scale and fade image on hover  

 Reveal. Pushes the image up or down to reveal the text. Supports easing. 
 
Duration 
Duration of the animation in milliseconds. 
 
Lazy Loading 
Enable this option to delay the loading of images until they are visible in the view port. This will speed 
up the page loading. It also prevents loading large images in mobile devices because only the visible 
images will be downloaded. 
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Slide Show 
You can use the Slide Show object to display different images in succession in the same place on the 
web page. For example, you could rotate among several images that advertise new products or display 
advertisements for other web sites.  
 

Border 

Border Color 
Specifies the color of the border around the object.  
 
Border Style 
Specifies the style of the border: Dotted, Dashed, Solid, Double, Groove, Ridge, Inset or Outset. 
 
Border Width 
Specifies the width of the border around the object. Set this to 0 (zero) for no border. 
 

Options 

Images 
To add an image, click the Add-button. You can also assign a link to each the image. 
Click Edit to change the properties of an image or Remove to remove it from the list. 
 
Delay 
You specify the number of seconds to pause before displaying the next image in the sequence.  
If you set this value to 0 (zero), the images will not rotate automatically, but instead you can use Events 
to display the next or previous image. This means you can use shapes, images,text or any other object 
which supports events to walk through the images! There are two special Event actions defined for this 
purpose: SlideShow Next and SlideShow Previous. See Events for more details. 
 
Type 
Specifies the type of slideshow 
Sequence, the images will be rotated in sequence. 
Random, the images will be displayed in random order. 
Light Box, If you select this option then clicking the image will start a lightbox slideshow. You can select 
one of built-in slideshows: slimbox, prettyphoto, fancybox. 
Conveyer Belt 
This option creates an image slideshow which scrolls the images from right to left in a "conveyor belt" 
fashion. Note that titles will not be displayed in Conveyer Belt mode! 
 
Effect 
Specifies the effect that will be used for image transitions. You can choose from 18 animation effects! 
  
Full Screen Mode 
When this option is enabled the slideshow will be stretched to full width or height of the browser 
window. The images will retain their original aspect ratio! 
Note: When using Full screen mode, only one slideshow can be added to the page! 
 
Full width 
Specifies whether the slideshow is full width (responsive) when its inside a Layout Grid. If set to false, 
the slideshow uses the fixed size. 
Note: This option is only available when the slideshow is part of a layout grid! 
 

Title 

In the Title section you can configure whether a title/caption will be display on top of the images. 
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Form Wizard 

 
Creating forms has never been so easy! Create complete forms in just a few steps. 
 
One of the many ways in which you can interact with people who visit your website is to get feedback 
from them through forms. Creating a form from scratch can be a rather difficult, so we've implemented 
the Form Wizard to make this task a little easier. 
  

Step 1: How do you want to create the new form? 
The Quick ‘n Easy Web Builder Form Wizard has 3 methods to create a form: 
 

1. Create a new form based on a template 
This option allows you to select a template form, which you can use as the basis for own form. 

2. Create a new form from scratch using the wizard 
Manually insert controls and labels to the form. 

3. Create a blank form so you can add controls later 
This inserts a blank form to your page with no controls on it. Basically this is the same as 
manually inserting an empty form area.   
 

 
 

Step 2: Select a template form 
We've included several ready-to-use forms to get you started. Please take your time to study the 
properties of each of these form to get an idea how we've implemented them, so you can use this 
knowledge to create your own forms. For some forms you will need to modify the pre-defined values 
such as the specified email address or website URL. 
There are 2 form processor templates where external websites are used to process the form data. 
Before you can make use of the services of these websites you will need to register first! 
http://www.formbuddy.com/ 
http://www.mailmyform.com/ 
These examples can be useful if your website does not support PHP or any other type of form 
processing. 
 

 

http://www.formbuddy.com/
http://www.mailmyform.com/
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Step 3: Add Control to the form 
In this step you can insert controls to the form. Each control can have a label which will be displayed in 
front of the control. Click Add and select one of the items from the drop down menu to insert a new 
control. In most cases the wizard will ask you to enter a label name. 
You can re-arrange the items using the Move Up and Move Down buttons.  
  

Tip:  
Make sure your form contains a Submit button. Without this button user will not be able to submit the 
entered data! 

 

 
 
Note that you can also add and remove controls to the form after you have created it in the Form 
Wizard. 
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Step 4: Where should the data be sent to? 
When the user presses Submit, the browser sends the form data to a web server, so we need to specify 
where the data should be sent to. 
One of the possibilities is 'Submit the data to an email address', although this is a very common 
method, it doesn't work reliably for all visitors to your site. Whether or not a visitor can use this method 
depends on the mail client installed on their computer. And unfortunately, there's no way to test if 
that's the case for each of your visitors. We do not recommend using this method! 
  
Instead of using the Submit the data to an email address ("mailto") method, try using a remotely hosted 
CGI script like PHP, ASP or remote hosted solutions like www.formabuddy.com or 
www.mailmyform.com. These services let you access a CGI script run off of their servers. You build your 
form as you normally would, but now you select Submit data to a script on an external server and fill in 
the URL of the remote CGI script. The CGI script translates your form into an email message and sends it 
on to the address you provide. 
 
Alternatively you can create your own form processor and make the form processor script part of your 
Quick ‘n Easy Web Builder website. In that case select Submit data to a page within your website. 
Note that you will have to write a script to process the submitted data, the 'submit data to a page within 
your website' does not do anything by itself! 
 
 

Note:  
Some form templates use their own form processor script (usually as a separate HTML object). In that 
case please do not change the predefined values. 
 
Templates that use a custom form processor include: 
Dictionary lookup 
Form processor: ASP 
Form processor: Godaddy 
Form processor: Tell a friend 
Form processor: www.formbuddy.com 
Form processor: www.mailmyform.com 
All PayPal templates 
All search templates! 

 
 
Use Built-in PHP form processor to send data to an email address. 
Enable this option if you want to use the built-in form processor.  
For more details about this feature in the Form chapter. 
 
Encoding type 
The required encoding type depends on the form processor script, so please consult the documentation 
of the CGI script for more info. In case you have selected a pre-defined form, the correct encoding type 
will be selected. 
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Form 
A form provides a way you to collect information from the people who view your web pages. A viewer 
enters data or makes choices among several options and then submits the form. The results can be sent 
to you by email. If your web server has the right software, you can save the form results in a database. 
 

 
 
The Form Area object is a container for FORM objects like buttons, edit boxes and checkboxes.  
You can add any standard form object to a form, including single- and multiple-line text fields, check 
boxes, radio buttons, scrolling lists, and drop-down lists.  
You add objects to a form using the Form toolbar (Form Tools).  
You must place form objects inside a form to make them work as part of the form. 
Browsers display form objects differently, so test your form on all the browsers and platforms you plan 
to support.  
 

How do I create a form in Quick ‘n Easy Web Builder? 
1. Drag the Form object to the page and a draw a box to indicate the position of the form. 
2. Design your form by adding some Form controls to the form, for example: 

Button, Checkbox, Radio button, Editbox, Text Area or Combobox. You can also make text and 
images part of the form. You'll notice that all objects become a part of the form, so when you 
change the position of the form all those objects move along. 

3. Make sure your form contains a Submit button (push button). Without this button the user will 
not be able to submit the entered data. 

4. Once you have designed your form, you must configure it to tell the browser where the data 
should be sent to.  



Quick ‘n Easy Web Builder   

88 

Accept Charset 
Specifies which character will be accepted by the form. This can be useful for Unicode languages. This 
value also used by the built-in form processor. Common values supported by most browsers are ISO-
8859-1 or UTF-8. 
 
Action 
Required attribute, specifying the URL of a CGI script which processes the form and sends back 
feedback. There are two methods to send form data to a server. GET will send the form input in an URL, 
whereas POST sends it in the body of the submission. The latter method means you can send larger 
amounts of data, and that the URL of the form results doesn't show the encoded form.  
 
Example: 
mailto:yourname@yourdomain.com 
This will email the results to your email address using the visitors default email client. 
 

Note: We do not recommend using the HTML’s ‘mailto’ feature. It is very unreliable and its behavior 
strongly depends on the type of browser and user preferences. When possible use the built-in PHP form 
processor or create your own processing script. 

 
If your web server supports PHP then you can use the built-in PHP form processor which is probably the 
easiest way to implement form processing. Read more details about this later in this document. 
 
If your server is not PHP-enabled, then you should contact your web host and ask them for the details 
on processing forms. Some servers offer server-side scripts that you can use, and if this is the case you'll 
need instructions setting this facility up. Alternately you can use a remotely hosted solution like 
www.formabuddy.com or www.mailmyform.com.  
These services let you access a CGI script run off of their servers. You build your form as you normally 
would, but now you fill in the URL of the remote CGI script. The CGI script translates your form into an 
email message and sends it on to the address you provide. 
 
Encoding type 
Here you can specify an encoding type the default of "application/x-www-form-urlencoded" is most 
widely supported. An alternative is "text/plain", which is typically used in combination when the Action 
attribute points to a mailto: URL. If a browser supports both, the content of the form is sent in plain text 
to the indicated recipient. 
 
Hidden Fields 
You can also add hidden fields that are not rendered but whose values are submitted with a form. 
Generally hidden fields are used to store information between client/server exchanges that would 
otherwise be lost due to the stateless nature of HTTP.  
 
Form name 
Enter a name for the FORM. This name is primarily used for advanced scripting. 
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Form Processor 
Enable this option if you want to use the built-in form processor.  This feature automatically generates a 
PHP script that will process the fields of your form and send it to an email address you specify. 
The form processing script will be inserted into the same page and you will be able to select a 'thank 
you' or successful page that will be displayed after the user has submitted the data. 
 
Email address 
Specifies the email address where the results of the form will be send to. You can only specific one email 
address in this field! If you leave this property empty then no email will be sent. 
 
Subject 
The subject of the email message. 
 
Message 
A short message that will be added to submitted data. 
 
Success page 
The page that the user will be redirected to after the data has been submitted (after the 'submit' button 
has been pressed). 
 
Error page 
The page that the user will be redirected to if an error occurred while processing the data. 
 
Upload files to a folder on the server. 
If this option is enabled the built-in form processor will upload files to a folder on the server instead of 
sending them as attachment via email. The files will be saved with a unique filename. The location of the 
uploaded file(s) will be included in the email message. 
 
Maximum upload file size 
Specifies the maximum file size which will be accepted by the script..The default maximum is: 1000 KB  
(1 MB). Example: enter '2000' to set the maximum value to 2 MB. 
Note: While you can specify the upload limit it will nevertheless comply with the limits imposed by the 
hosting providers. 
 
Auto responder 
We have added some basic auto responder functionality to the form processor. This allows you to send 
a (thank you or confirmation) message to the user. Your form must have an input field (editbox) with the 
name 'email'! This is the email address where the auto response message will be send to. 
 
From 
Specifies the 'from' email address for the email message. 
 
Subject 
Specifies the subject for the email message. 
 
Message 
Specifies the body text for the email message. 
 
 
Write form data to a .csv file. 
This option will save the submitted form data to a comma separated data file on the web server. You 
can open this file in Microsoft Excel, a text editor or import it into a database. 
 
Note that the data file must exist on the server and it must be writable! So before you can use this 
option you will have to create the CSV file on the server and give it the appropriate permission. 
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Database (for advanced users only!) 
You can use this option in combination with the built-in form processor to store form data in a MySQL 
database on the server. The generated PHP script will attempt to automatically create the table and 
fields based on the settings you configured, so you do not have to worry about creating it yourself. 
The database fields will be in the same order and use the same name as in your form design. To view or 
process the submitted form data you will need a separate tool, like the standard MySQL admin tool. 
Please consult the documentation of your web host for more details. 
 
MySQL 
Specifies whether to write form data in a MySQL database.  
 
Database 
Specifies the MySQL database name. 
 
UserName / Password 
Specifies the MySQL username  and password. 
 
Server 
Specifies the MySQL database server. 
 
Table 
Specifies the MySQL table name. 
 

Important notes about the built-in PHP form processor:  
If the form contains an editbox named 'email', then this email address will be used as the 'from' address 
for the message. This field name is case sensitive! So do not call it 'Email' or 'eMail'. 
 
If the form contains one or more 'file upload' objects then the script will automatically attached these 
files to the email message or upload them to the server. 
 
You MUST change the file extension on the page to php (in the page properties), because PHP code will 
be added to the page. 
 
Your hosting account must support PHP and the mail() function must be enable, otherwise it will not 
work. 
 
You can have only one form per page. 
 
The z-order of the objects on the form determines the order of the items in the email message.  
You can change this order by using the Arrange tools or select 'Arrange Objects' in the form's context 
menu. 

 
Mail Engine 
By default the form processor will use standard PHP mail. However this may not work on all web servers 
(depending on how it is configured). On some servers you may need to configure SMTP authentication. 
In that case you can enable PHP Mailer which gives you more control over the mail settings. 
 
Web Storage 
Web storage is a new feature of HTML5. It allows you to store field values between sessions or/and 
pages.  This can be useful if you want to transfer values from one form to another. Enable this option 
and Quick ‘n Easy Web Builder will automatically store and retrieve all values for you! Note that the ID 
of the objects will be used as the key for the value, so if you want to retrieve the values in another form 
(on another page) then it must have the same ID. 
 
Local storage stores data with no time limit. Session storage stores data for one session. 
Note:  Web storage only works if your website is online. It works in all modern browsers. 
 



Quick ‘n Easy Web Builder   

91 

Button 
The push button will usually be used as submit or reset button on a form.  
If the push button isn't part of a form it doesn't do anything by default.  

 
Background 
Background Mode 
Specifies the background mode: Solid, Image or Transparent. Note that if you set the border style to 
‘Default’ then the button will be rendered using the standard browser theme! 
 
Background Color 
Specifies the color of the form background. If set to 'Automatic' the standard (system) button color will 
be used. 
 
Background Image 
Specifies the optional background image. 
 
Horizontal Alignment 
Sets the horizontal position for the background image.  
 
Repeat 
Sets the tiling attributes for the background image. Possible options are: 

 Repeat in both directions 

 Repeat in horizontal direction 

 Repeat in vertical direction 

 Do not repeat 
 
Vertical Alignment 
Sets the vertical position for the background image. 
 

Border 
Border Color 
Specifies the color of the border around the object.  
 
Border Style 
Specifies the style of the border: Dotted, Dashed, Solid, Double, Groove, Ridge, Inset or Outset. 
Note that if you set the border style to ‘Default’ then the button will be rendered using the standard 
browser theme! 
 
Border Width 
Specifies the width of the border around the object. Set this to 0 (zero) for no border. 
 
Radius 
Defines the degree to which border corners will be rounded. Requires a browser with CSS3 support! 
 

Events  

For more information about events please read the ‘Events’ chapter of this document. 
 

Font  

In this section you can select the font font family of text (such as Comic Sans, Times New Roman, and 
Courier New), font size, style (Bold, Italic, Underline) and the color of the text. 

 
Box Shadow 
Configure box shadow (also called drop shadow) for the object. This feature requires a CSS3 enabled 
browser! 
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Miscellaneous 

Access Key 
This attribute assigns an access key to the object. An access key is a single character. 
Pressing the access key gives focus to the element. 
 
Disabled 
The disabled option disables the control for user input.  
Disabled controls do not receive focus.  
Disabled controls are skipped in tabbing navigation.  
The value of disabled controls will not be submitted with the form. 
 
Name 
Name of the button. 
 
Tab Index 
All elements (except hidden elements) in a form are part of the form's tab order.  
When the user presses the Tab key, the browser shifts the input focus from element to element in order 
the elements appear in the HTML code. However, sometimes you want the tab order to flow a little 
differently. In that case, you can number the fields using tabindex attribute. Usually the first tabindex 
start on with value '1'. To exclude an element from the tab order, set the value of tabindex to 0. In that 
case the element is skipped when the user tabs around the form. 
 
Title 
Specifies the tooltip displayed by the browser 
 
Type 

 Submit 
When activated, a submit button submits a form. A form may contain more than one submit 
button.  

 Reset 
When activated, a reset button resets all controls to their initial values.  

 Normal 
Normal (Push) buttons have no default behavior.  

 
Value 
Caption of the button. 
 

Style 
Predefined Style 
Here you can select one of the global site styles. This option will overwrite all custom style settings for 
this object. You can add or edit styles in the Style Manager. 
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Checkbox 

 
Checkboxes are on/off switches that may be toggled by the user.  
Use check boxes if want to allow more than one item to be selected. 
 

Miscellaneous 
Access Key 
This attribute assigns an access key to the object. An access key is a single character. 
Pressing the access key gives focus to the element. 

 
Disabled 
The disabled option disables the control for user input.  
Disabled controls do not receive focus.  
Disabled controls are skipped in tabbing navigation.  
The value of disabled controls will not be submitted with the form. 

 
Initial state 
Initial state of the checkbox. 

 
Name 
Name of the checkbox. 
 
Tab Index 
All elements (except hidden elements) in a form are part of the form's tab order.  
When the user presses the Tab key, the browser shifts the input focus from element to element in order 
the elements appear in the HTML code. However, sometimes you want the tab order to flow a little 
differently. In that case, you can number the fields using tabindex attribute. 
Usually the first tabindex start on with value '1'. To exclude an element from the tab order, set the value 
of tabindex to 0. In that case the element is skipped when the user tabs around the form. 
 
Title 
Specifies the tooltip displayed by the browser 
 
Value 
Value of the checkbox when it's switched on. 
 

Events 
For more information about events please read the ‘Events’ chapter of this document. 
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Combobox 

  
Used to allow users to make a selection from a number of different options. 
 

Background 
Background Mode 
Specifies the background mode: Solid, Image or Transparent. 
 
Background Color 
Specifies the color of the form background. If set to 'Automatic' the standard (system) button color will 
be used. 
 
Background Image 
Specifies the optional background image. 
 
Horizontal Alignment 
Sets the horizontal position for the background image.  
 
Repeat 
Sets the tiling attributes for the background image. Possible options are: 

 Repeat in both directions 

 Repeat in horizontal direction 

 Repeat in vertical direction 

 Do not repeat 
 
Vertical Alignment 
Sets the vertical position for the background image. 
 

Border 
Border Color 
Specifies the color of the border around the object.  
 
Border Style 
Specifies the style of the border: Dotted,Dashed, Solid, Double, Groove, Ridge, Inset or Outset. 
 
Border Width 
Specifies the width of the border around the object. Set this to 0 (zero) for no border. 
 
Radius 
Defines the degree to which border corners will be rounded. Requires a browser with CSS3 support! 
 

Events  

For more information about events please read the ‘Events’ chapter of this document. 
 

Font  

In this section you can select the font font family of text (such as Comic Sans, Times New Roman, and 
Courier New), font size, style (Bold, Italic, Underline) and the color of the text. 
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Miscellaneous 
Disabled 
The disabled option disables the control for user input.  
Disabled controls do not receive focus.  
Disabled controls are skipped in tabbing navigation.  
The value of disabled controls will not be submitted with the form. 
 
Items 
You can Add, Edit and Delete items that will appear in the list. 
Use Add to add a new item to the list, Edit to edit an existing item in the list and Remove to remove the 
select item. Move Up moves the selected item up one position in the list. Move Down moves the 
selected item down one position in the list. 
 
MultiSelect 
Allows the user to select multiple items at the same time. 
 
Name 
Enter an identifier for the field. 
 

Note:  
It's important to note that the element name must be in the form name[] for multiple selects! This way 
you'll receive the selected values in an array (this is a PHP feature). 

 
Tab Index 
All elements (except hidden elements) in a form are part of the form's tab order.  
When the user presses the Tab key, the browser shifts the input focus from element to element in order 
the elements appear in the HTML code. However, sometimes you want the tab order to flow a little 
differently. In that case, you can number the fields using tabindex attribute. 
Usually the first tabindex start on with value '1'. To exclude an element from the tab order, set the value 
of tabindex to 0. In that case the element is skipped when the user tabs around the form. 
 
Title 
Specifies the tooltip displayed by the browser 
 
Type 
Combobox: this will make the object a drop-down list. Only a single line is displayed at once. 
Listbox: this will make the object a standard list box. Multiple lines are displayed at once. 
 
Focus state 
Removes the default outline styles and applies a box-shadow (with customizable color) in its place. 
 

Style 
Predefined Style 
Here you can select one of the global site styles. This option will overwrite all custom style settings for 
this object. You can add or edit styles in the Style Manager. 
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Editbox 

 
Single-line field that can be used to add name/e-mail address fields. 
 

Background 
Background Mode 
Specifies the background mode: Solid, Image or Transparent. 
 
Background Color 
Specifies the color of the form background. If set to 'Automatic' the standard (system) button color will 
be used. 
 
Background Image 
Specifies the optional background image. 
 
Horizontal Alignment 
Sets the horizontal position for the background image.  
 
Repeat 
Sets the tiling attributes for the background image. Possible options are: 

 Repeat in both directions 

 Repeat in horizontal direction 

 Repeat in vertical direction 

 Do not repeat 
 
Vertical Alignment 
Sets the vertical position for the background image. 
 

Border 
Border Color 
Specifies the color of the border around the object.  
 
Border Style 
Specifies the style of the border: Dotted, Dashed, Solid, Double, Groove, Ridge, Inset or Outset. 
 
Border Width 
Specifies the width of the border around the object. Set this to 0 (zero) for no border. 
 
Radius 
Defines the degree to which border corners will be rounded. Requires a browser with CSS3 support! 
 

Events  

For more information about events please read the ‘Events’ chapter of this document. 
 

Font  

In this section you can select the font font family of text (such as Comic Sans, Times New Roman, and 
Courier New), font size, style (Bold, Italic, Underline) and the color of the text. 

 
Box Shadow 
Configure box shadow (also called drop shadow) for the object. This feature requires a CSS3 enabled 
browser! 
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Miscellaneous 
Access Key 
This attribute assigns an access key to the object. An access key is a single character. 
Pressing the access key gives focus to the element. 
 
Disabled 
The disabled option disables the control for user input. Disabled controls do not receive focus. Disabled 
controls are skipped in tabbing navigation. The value of disabled controls will not be submitted with the 
form. 
 
Max. Length 
Specifies the maximum number of characters a user can enter into the editbox. 
 
Name 
Enter an identifier for the field. 
 
Place holder (HTML5 only) 
Specifies a short hint to help the user to fill out the input field. The text will disappear as soon as the 
user enters some text. 
 
Type 

 text 
A plain text field. 

 password 
Makes the editbox a password field so any text entry is displayed as asterisks. 

 color (HTML5) 
The browser displays a visual color picker. 

 date (HTML5) 
The browser displays a date picker. 

 datetime  (HTML5) 
Input field is for precise, absolute date and time stamps. 

 datetime-local  (HTML5) 
Input field is for local dates and times. 

 email  (HTML5) 
Input field is for email addresses. 

 month  (HTML5) 
The browser displays a month picker. 

 number  (HTML5) 
The browser displays a visual spin box. 

 range  (HTML5) 
The browser displays a range selector. 

 search (HTML5) 
The browser displays a search input field. 

 tel (HTML5) 
The browser displays a telephone input field. 

 time  (HTML5) 
Input field is a time input field. 

 url (HTML5) 
Input field is for web addresses. 

 week  (HTML5) 
The browser displays a week picker. 

 
Note: Currently only text and password fields are supported by all browsers. In other cases some 
browsers will simply display the default edit box. 
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Alignment 
Specifies the horizontal alignment of the input field. 
Note: This setting will be ignored if you select a predefined style. In that case the alignment of that style 
will be used.  
 
Auto complete (HTML5) 
Specifies whether the input field should have autocomplete enabled  (if available in the browser) . 
 
Auto Focus (HTML5) 
Specifies whether the element should automatically get focus when the page loads. 
 
Readonly 
The readonly option prevents the user from changing the value of the field, but not from interacting 
with the field. The user can still highlight the text for copying for example. Readonly elements receive 
focus but cannot be modified by the user. Readonly elements are included in tabbing navigation. 
Readonly elements will be submitted with the form. 
 
Tab Index 
All elements (except hidden elements) in a form are part of the form's tab order.  
When the user presses the Tab key, the browser shifts the input focus from element to element in order 
the elements appear in the HTML code.  However, sometimes you want the tab order to flow a little 
differently. In that case, you can number the fields using tabindex attribute. 
Usually the first tabindex start on with value '1'. To exclude an element from the tab order, set the value 
of tabindex to 0. In that case the element is skipped when the user tabs around the form. 
 
Title 
Specifies the tooltip displayed by the browser 
 
Value 
Value that is initially display in the field. 
 
Focus state 
Removes the default outline styles and applies a box-shadow (with customizable color) in its place. 
 

Style 
Predefined Style 
Here you can select one of the global site styles. This option will overwrite all custom style settings for 
this object. You can add or edit styles in the Style Manager. 
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File Upload 

 
This object provides a means for users to attach a file to the contents of the form. The element is 
rendered as a text field and an associated button, though in some browsers it may appear differently. 
For example: the text of the 'browse' button will be 'Choose' in Opera and 'Browse' in IE/FireFox. Also 
there is no way to control the size of the button or edit field through HTML. 
 

Notes: 
When using the built-in PHP form processor, the generated script will automatically take care of 
attaching the selected file(s) to the email message after the form has been submitted.  
 
Most hosting services limit upload size to between 2 and 4 Mb. While you can control the upload limit 
by adding a hidden field called 'filesize' with the size in kB, it will nevertheless comply with the limits 
imposed by the hosting providers. 
 
If you choose not to use the built-in form processor, then you must implement a script to handle file 
uploads yourself! 

 

Background 
Background Mode 
Specifies the background mode: Solid, Image or Transparent. 
 
Background Color 
Specifies the color of the form background. If set to 'Automatic' the standard (system) button color will 
be used. 
 
Background Image 
Specifies the optional background image. 
 
Horizontal Alignment 
Sets the horizontal position for the background image.  
 
Repeat 
Sets the tiling attributes for the background image.  
 
Vertical Alignment 
Sets the vertical position for the background image. 
 

Border 
Border Color 
Specifies the color of the border around the object.  
 
Border Style 
Specifies the style of the border: Dotted, Dashed, Solid, Double, Groove, Ridge, Inset or Outset. 
 
Border Width 
Specifies the width of the border around the object. Set this to 0 (zero) for no border. 
 

Font  

In this section you can select the font family of text (such as Comic Sans, Times New Roman, and Courier 
New), font size, style (Bold, Italic, Underline) and the color of the text. 
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Miscellaneous 
Access Key 
This attribute assigns an access key to the object. An access key is a single character. 
Pressing the access key gives focus to the element. 
 
Disabled 
The disabled option disables the control for user input.  
Disabled controls do not receive focus.  
Disabled controls are skipped in tabbing navigation.  
The value of disabled controls will not be submitted with the form. 
 
Name 
Enter an identifier for the field. 
 
Tab Index 
All elements (except hidden elements) in a form are part of the form's tab order.  
When the user presses the Tab key, the browser shifts the input focus from element to element in order 
the elements appear in the HTML code. However, sometimes you want the tab order to flow a little 
differently. In that case, you can number the fields using tabindex attribute. 
Usually the first tabindex start on with value '1'. To exclude an element from the tab order, set the value 
of tabindex to 0. In that case the element is skipped when the user tabs around the form. 
 
Title 
Specifies the tooltip displayed by the browser 
 

Style 
Predefined Style 
Here you can select one of the global site styles. This option will overwrite all custom style settings for 
this object. You can add or edit styles in the Style Manager. 
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Radio button 

 
Radio buttons are like checkboxes except that when several share the same name, they are mutually 
exclusive: when one is switched "on", all others with the same name are switched "off".  
 

Miscellaneous 
Access Key 
This attribute assigns an access key to the object. An access key is a single character. 
Pressing the access key gives focus to the element. 
 
Disabled 
The disabled option disables the control for user input.  
Disabled controls do not receive focus.  
Disabled controls are skipped in tabbing navigation.  
The value of disabled controls will not be submitted with the form. 
 
Initial state 
Initial state of the radio button. 
 
Name 
The radio button will be part of this group. 
Radio buttons with the same group name will force the user to select one choice. 
 
Tab Index 
All elements (except hidden elements) in a form are part of the form's tab order.  
When the user presses the Tab key, the browser shifts the input focus from element to element in order 
the elements appear in the HTML code.  
However, sometimes you want the tab order to flow a little differently. In that case, you can number the 
fields using tabindex attribute. 
Usually the first tabindex start on with value '1'. To exclude an element from the tab order, set the value 
of tabindex to 0. In that case the element is skipped when the user tabs around the form. 
 
Title 
Specifies the tooltip displayed by the browser 
 
Value 
Value of the radio button when it is selected. 
 

Events  

For more information about events please read the ‘Events’ chapter of this document. 
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reCAPTCHA 

 
This object provides an easy way to add reCAPTCHA to your forms. It was designed to work in 
combination with Quick 'n Easy Web Builder’s built-in form processor, but it may also work with other 
form processors which process the form on the same page. If the form is processed on another page 
then this CAPTCHA will not work. 
 
reCAPTCHA is a free CAPTCHA service that helps protect your site against spam, malicious registrations 
and other forms of attacks where computers try to disguise themselves as a human. reCAPTCHA is 
currently one of the best ways to protect online forms from spammers. 
 
Before you can use this extension, you’ll need to sign up at reCAPTCHA.net: 
http://www.google.com/recaptcha and create reCAPTCHA keys for your site. The keys are unique to 
your domain and sub-domains and will not work for other domains. After you have signed up you will 
receive a Private Key and a Public Key.  
  
Version 
Specifies which version to use: reCAPTCHA v1 or reCAPTCHA v2. 
Note: Version 1.0 of the reCAPTCHA API is no longer supported, please upgrade to Version 2.0. 
 
Error Page 
Specifies the page the user will be redirect to if the user’s response is invalid. 
 
Private Key (Secret Key) 
Enter your Private or  Secret reCAPTCHA key here. 
 
Public Key (Site Key) 
Enter you Public or Site reCAPTCHA key here. 
 
Theme 
Specifies the theme of the reCAPTCHA image.  
4 themes are available for version 1: red (default), clean, white and black glass. 
2 theme are available for version 2: dark and light. 
 
Language (version 2 only) 
Forces the widget to render in a specific language. Auto-detects the user's language if unspecified. 
 
Tab Index (version 2 only) 
The tabindex of the widget and challenge. If other elements in your page use tabindex, it should be set 
to make user navigation easier. 
 
 
 
 

  

 

http://www.google.com/recaptcha
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TextArea 
A Text Area is a multi-line form field where the user can enter large amounts of text. 
 

Background 
Background Mode 
Specifies the background mode: Solid, Image or Transparent. 
 
Background Color 
Specifies the color of the form background. If set to 'Automatic' the standard (system) button color will 
be used. 
 
Background Image 
Specifies the optional background image. 
 
Horizontal Alignment 
Sets the horizontal position for the background image.  
 
Repeat 
Sets the tiling attributes for the background image. Possible options are: 

 Repeat in both directions 

 Repeat in horizontal direction 

 Repeat in vertical direction 

 Do not repeat 
 
Vertical Alignment 
Sets the vertical position for the background image. 
 

Border 
Border Color 
Specifies the color of the border around the object.  
 
Border Style 
Specifies the style of the border: Dotted,Dashed, Solid, Double, Groove, Ridge, Inset or Outset. 
 
Border Width 
Specifies the width of the border around the object. Set this to 0 (zero) for no border. 
 
Radius 
Defines the degree to which border corners will be rounded. Requires a browser with CSS3 support! 
 

Events  

For more information about events please read the ‘Events’ chapter of this document. 
 

Font  

In this section you can select the font font family of text (such as Comic Sans, Times New Roman, and 
Courier New), font size, style (Bold, Italic, Underline) and the color of the text. 

 
Box Shadow 
Configure box shadow (also called drop shadow) for the object. This feature requires a CSS3 enabled 
browser! 
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Miscellaneous 
Access Key 
This attribute assigns an access key to the object. An access key is a single character. 
Pressing the access key gives focus to the element. 
 
Auto Focus (HTML5) 
Specifies whether the element should automatically get focus when the page loads. 
 
Disabled 
The disabled option disables the control for user input.  
Disabled controls do not receive focus.  
Disabled controls are skipped in tabbing navigation.  
The value of disabled controls will not be submitted with the form. 
 
Name 
Enter an identifier for the field. 
 
Place holder (HTML5 only) 
Specifies a short hint to help the user to fill out the input field. The text will disappear as soon as the 
user enters some text. 
 
Readonly 
The readonly option prevents the user from changing the value of the field, but not from interacting 
with the field. 
The user can still highlight the text for copying for example. 
Readonly elements receive focus but cannot be modified by the user.  
Readonly elements are included in tabbing navigation.  
Readonly elements will be submitted with the form. 
 
Tab Index 
All elements (except hidden elements) in a form are part of the form's tab order.  
When the user presses the Tab key, the browser shifts the input focus from element to element in order 
the elements appear in the HTML code.  
However, sometimes you want the tab order to flow a little differently. In that case, you can number the 
fields using tabindex attribute. 
Usually the first tabindex start on with value '1'. To exclude an element from the tab order, set the value 
of tabindex to 0. In that case the element is skipped when the user tabs around the form. 
 
Title 
Specifies the tooltip displayed by the browser 
 
Value 
Value that is initially display in the field. When the form is submitted the new or edited text is entered. 
 
Focus state 
Removes the default outline styles and applies a box-shadow (with customizable color) in its place. 
 

Style 
Predefined Style 
Here you can select one of the global site styles. This option will overwrite all custom style settings for 
this object. You can add or edit styles in the Style Manager. 
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Flash 
With Adobe Flash files (.swf), you can create multimedia, graphics, and audio that downloads quickly. To 
view these files, site visitors must install the Flash plugin appropriate for their browser and platform. 
These plugins are available from the Macromedia Web site at www.macromedia.com. Web Builder 
creates all of the code you need to add a Flash files to your site. 
 

Note: 
Many modern browsers do no longer support Flash. For example Flash will not work on mobile phones 
and iPads. If your website is still using Flash based components, then you should consider looking for 
alternatives. 

 
Allow Fullscreen 
Enable this option to allow full-screen display of the Flash application. This option is supported by Flash 
9.0 or higher. 
 
Autostart 
To play the movie automatically when the site visitor opens the page, select Auto Start. 
 
Display Menu 
When checked it will display the full menu, allowing the user a variety of options to enhance or control 
playback. When not checked it will only display a menu that contains only the Settings option and the 
About Flash option. 
 
Flash Variables 
Flash variables (FlashVars) it a way to pass data or variables from html to a Flash application. 
FlashVars is supported by Flash Player 6 and newer. Please check the documentation of the Flash 
application for more details. 
 
Filename 
Enter a filename of the movie (.swf). 
 
Loop 
To replay the movie when it ends, select Loop. 
 
Quality 
To control the display quality, select a Quality option. 
Low favors playback speed over appearance and never uses anti-aliasing.  
Autolow emphasizes speed at first but improves appearance whenever possible. Playback begins with 
anti-aliasing turned off. If the Flash Player detects that the processor can handle it, anti-aliasing is 
turned on.  
Autohigh emphasizes playback speed and appearance equally at first but sacrifices appearance for 
playback speed if necessary. Playback begins with anti-aliasing turned on. If the actual frame rate drops 
below the specified frame rate, anti-aliasing is turned off to improve playback speed. Use this setting to 
emulate the View > Anti-alias setting in Flash.   
Medium applies some anti-aliasing and does not smooth bitmaps. It produces a better quality than the 
Low setting, but lower quality than the High setting.  
High favors appearance over playback speed and always applies anti-aliasing. If the movie does not 
contain animation, bitmaps are smoothed; if the movie has animation, bitmaps are not smoothed.   
Best provides the best display quality and does not consider playback speed. All output is anti-aliased 
and all bitmaps are smoothed.  
 
Scale 
To determine how the movie fits in the frame, select a Scale option.  
Default (Show all) makes the entire movie visible in the specified area without distortion, while 
maintaining the original aspect ratio of the movie. Borders may appear on two sides of the movie.  
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No Border scales the movie to fill the specified area, without distortion but possibly with some cropping, 
while maintaining the original aspect ratio of the movie.   
Exact Fit makes the entire movie visible in the specified area without trying to preserve the original 
aspect ratio. Distortion may occur.  
 
UseSWFObject 
SWFObject is a W3C standards-friendly method to embed Flash content, which utilizes one small 
JavaScript file. If you enable this option, then Web Builder will use the SWFObject script instead of the 
W3C incompliant <object> and <embed> tags. 
 
Version 
This specifies the minimum Flash version number that the movie needs to play correctly. 
 
Window Mode 
Specifies the window mode of the flash. Select Transparent if you want to display the flash movie with 
transparency. Otherwise select Window or Opaque. 
 
Alternative image 
This image will be displayed if the browser does not support flash. 
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Media Player 
 The Media player object supports several media player types:  

 Flash Player 

 Quick Time 

 Real Player 

 Default Media Player 

 HTML5 Audio 

 HTML5 Video 
 

Flash Player 

If you want to add movies to your page then Flash Video is probably the most reliable way to do this 
since most users will have the Adobe's Flash Player plug-in installed in their browser. 
 
The Flash Movie Player is a player that can be used to play Flash Movies (FLV), but it also support many 
other formats like MP4 (also AVC), MOV, AVI, MP4V, M4V, and M4A, M4R (Audio/Ringtones for iPhone), 
F4A (Audio). It has many options to customize the appearance of the player. 
 
Auto start 
To play the movie automatically when the site visitor opens the page, select Auto Start. 
 
Filename 
Specifies the video to be played. 
 
Image 
Specifies the 'teaser' image. This will be displayed if the video is not playing. 
 
Loop 
To replay the movie when it ends, select Loop. 
 
Title 
Specifies the title of the video. This will be displayed in the player if the user click the 'Info' button. 
 
Description 
Specifies the description of the video. This will be displayed in the player if the user click the 'Info' 
button. 
 
Show  Info Button 
Specifies whether the 'Info' button should be displayed in the control bar. 
 
Show Fullscreen Button 
Specifies whether the 'Fullscreen' button should be displayed in the control bar. 
 
Show  Scale Button 
Specifies whether the 'Scale' button should be displayed in the control bar. 
 
Show  Volume Controls 
Specifies whether the volume controls should be displayed in the control bar. 
 
Show  Time 
Specifies whether the time should be displayed in the control bar. 
 
Show  Large Play Button 
Specifies whether the large play button should be displayed in the center of the player. 
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HTML5 
To make sure your video also plays on devices that do not support Flash (like many mobile devices), you 
can enable the option Support both Flash and HTML5. The look and feel of the Flash Player will then be 
simulated by using HTML5 video, JavaScript and CSS. Note that not all browsers do support the same 
video formats.  if you want to support as many devices as possible you should also include .mp4 and 
.webm versions of the video. 
 
If you set 'Show controls' to false then no controls will be displayed in HTML5 mode. 
 
Background Color 
Specifies the color of the background. 
 
Button Color 
Specifies the color of buttons. 
 
Control Spacing 
Specifies the spacing between controls. 
 
ControlBar Color 
Specifies the color of the control bar. 
 
ControlBar Height 
Specifies the height of the control bar. 
 
Description Color 
Specifies the color of the description. 
  
Gradient Color 
Specifies the gradient color. 
 
Slider Color 
Specifies the color of the sliders. 
 
Slider Height 
Specifies the height of the sliders. 
 
Slider Tracker Color 
Specifies the color of the slider tracker. 
 
Time Color 
Specifies the color of the time. 
 
Title Color 
Specifies the color of the title. 
 
Total Time Color 
Specifies the color of the total time. 
 
Volume Length 
Specifies the width of the volume bar. 

 
Window Mode 
Specifies the window mode of the flash movie. Select Transparent if you want to display the flash movie 
with transparency. Otherwise select Window or Opaque. 
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Quick Time Player 

Use this object to add QuickTime media files to your page. 
 

Note:  
In order to view a QuickTime movie the visitor of your website must have installed the appropriate 
browser plug in! In many cases the Flash Movie Player is probably a safer choice, because it's a more 
common video format for the web. 

 
Autostart 
To play the movie automatically when the site visitor opens the page, select Auto Start. 
 
Controller 
Select this option to display a control bar that site visitors can use to start or stop the movie.  
 
Filename 
Enter the filename of the movie. 
QuickTime media has a .mov or .qt extension.  
 
Hide 
Select this option if you don’t want to show the movie, but want to use it only as background sound. 
 
Loop 
To replay the movie when it ends, select Loop. 

 



Quick ‘n Easy Web Builder   

110 

Real Player 

Use this object to add RealPlayer media files to your page. 
 

Note:  
In order to play a RealPlayer media file the visitor of your website must have installed the appropriate 
browser plug in! In many cases the Flash Movie Player is probably a safer choice, because it's a more 
common video format for the web. 

 
Autostart 
Sets whether or not the RealPlayer Plug-in will automatically start playing once the source data is 
available. 
 
Console 
Sets a console name used to link multiple RealPlayer Plug-in instances. All RealPlayer Plug-ins with the 
same console name work together. For example, if you have multiple Play and Stop buttons on the same 
page, the console name would enable them to control the same RealAudio clip. Set this property for 
each instance of the Play or Stop button you want to link. The console name master links to all 
instances. The console name unique links to no other instances. 
 
Controls 
Sets the visible components of the RealPlayer Plug-in. 
 
ImageWindow  Displays the image window.  
All   Displays the basic RealPlayer control panel. 
ControlPanel  Displays a compact RealPlayer control panel.  
PlayButton   Displays a play/pause button.  
PlayOnlyButton   Displays a play button.  
PauseButton   Displays a pause button.  
StopButton   Displays a stop button.  
FFCtrl    Displays a fast-forward button.  
RWCtrl    Displays a rewind button.  
MuteCtrl   Displays a mute button.  
MuteVolume   Displays a mute button and volume slider.  
VolumeSlider   Displays a volume slider.  
PositionSlider  Displays a clip position slider.  
TACCtrl  Displays a clip information field. 
HomeCtrl   Displays the Real™ logo.  
InfoVolumePanel Displays presentation information along with the volume slider and mute button. 
InfoPanel  Displays the presentation information panel. 
StatusBar  Displays the status panel, which shows informational messages. 
StatusField  Displays the message text area of the status bar.  
PositionField  Displays the position field, which shows the clip's current place in the 
presentation timeline and the total clip length.  
 
Filename 
Enter the filename of the audio or video file. 
A RealPlayer media file can have one of these extensions: .ra, .rm, .rv, .rmvb, .rmj, .rms, .ram, .rmm, 
.rax, .rvx, .rp, .rtx, .rt, .rmx. 
 
Loop 
To replay the movie when it ends, select Loop. 
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Linking multiple Real player controls 
The console property defines a name that unifies RealPlayer objects so that multiple controls work 
together.  
For example, you could create three separate RealPlayer objects to define an image window, a play 
button, and a stop button.  
By using three different object, you can set the size of each control separately.  
To tie controls together, define the same CONSOLE name within RealPlayer, or use one of these 
predefined names: 
_master links the control to all other embedded controls on the page. 
_unique links the control to no other embedded controls on the page. 
 
You can have multiple console names for separate presentations.  
For a page showing two video clips, for example, you can define the console names video1 and video2.  
All controls linked by video1 interoperate, as do all controls linked by video2. However, a video1 volume 
slider, for example, will not affect the volume of a video2 clip. 
 
Example 1: 
You want to add a video file without any controls to your page 

1. Add one instance of the object to your page 
2. Specify the filename 
3. Set the controls property to ImageWindow 
4. Set the console property to video1 

 
Example 2: 
You want to add a video file with all controls visible 

1. Add two instances of the object to your page 
2. Specify the filename for both objects 
3. Set the controls property of object 1 to ImageWindow 
4. Set the controls property of object 2 to All 
5. Set the console properties of both objects to video1 

 
Example 3: 
You want to add a video file with only a playbutton 

1. Add two instances of the object to your page 
2. Specify the filename for both objects 
3. Set the controls property of object 1 to ImageWindow 
4. Set the controls property of object 2 to PlayButton 
5. Set the console properties of both objects to video1 

 
For more information about the RealPlayer object visit the official website: 
http://service.real.com/help/library/guides/production8/htmfiles/control.htm 

 

http://service.real.com/help/library/guides/production8/htmfiles/control.htm
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Default Media Player 

Use this object to add media files to your page. This is the most common way to add media files to your 
web page. This option will actually use the default media player (for the selected media type) to play the 
file in the visitors browser. 
 

Note:  
In order to play a media file the visitor of your website must have installed the appropriate browser plug 
in! In many cases the Flash Movie Player is probably a safer choice, because it's a more common video 
format for the web. 

 
Supported types are: 
Audio Files (*.wav,*.snd,*.mp3,*.wma,*.au,*.aifc,*.aiff) 
Midi Files (*.mid,*.midi) 
Movie Files (*.mpg,*.mpeg,*.m1v,*.mp2,*.mpa,*.mpe,*.mpv2) 
Video Files (*.avi,*.wmv) 
Windows Media Files (*.wm,*.wmv,*.asf,*.asx,*.wax,*.wma) 
 
 
Autostart 
To play the movie automatically when the site visitor opens the page, select Auto Start. 
 
Hide 
Select this option if you don’t want to show the movie, but want to use it only as background sound. 
 
Loop 
To replay the movie when it ends, select Loop. 
 

 
HTML5 Audio/Video 

Use this option if you want to play HTML5 audio or video. Note that this option is only supported by 
modern browsers! 
 
Show controls 
If present, controls will be displayed, such as a play button. The actual appearance of the player depends 
on the type of browser! Each browser will render the player differently!!! 
  
Preload media 
If present, the video will be loaded at page load, and ready to run. Ignored if "autostart" is enabled. 
 
Mute audio  
Specifies whether the audio should be muted. (applies to HTML5 video only). 
  
Alternative formats 
Unfortunately not all browsers do support the same audio/video formats. There is currently no format 
that works on all browsers. So to ensure the player will work in all browsers you can specify alternative 
formats. 
  
Poster 
Specifies the filename or URL of an image representing the video. 
 
Aspect ratio 
Keep the aspect ratio of the video fixed at 16:9 or 4:3. This is especially useful when the video is party of 
a Layout Grid, so the video resizes dynamically while keeping the original aspect ratio. 
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Vimeo 
The Vimeo object provides an easy way to add Vimeo (https://vimeo.com/) videos to your pages.  
 
Video ID 
Specifies the Vimeo Video ID of the video. 
 
Fill entire browser window 
Use the Vimeo video as page background. 
 
Aspect ratio 
Keep the aspect ratio of the video fixed at 16:9 or 4:3. This is especially useful when the video is party of 
a Layout Grid, so the video resizes dynamically while keeping the original aspect ratio. 
 
Lightbox 
The Lightbox option makes it possible to display another page in a lightbox (using FancyBox) after 
clicking on a preview image. You can specify the preview image, lightbox title and width/height of the 
lightbox. 
 
In 'Lightbox Settings' you can specify additional options for the Fancy Lightbox. Each option must be on a 
new line and separated by a comma: 
'overlayShow' : true, 
'overlayColor' : '#FF0000' 
 
More information about options is available here: http://fancybox.net/api 
 

http://fancybox.net/api
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You Tube 
The YouTube object provides an easy way to add YouTube videos to your pages. 
 
Auto Start 
To play the movie automatically when the site visitor opens the page, select Auto Start. 
 
Loop 
To replay the movie when it ends, select Loop. 
 
Show related videos 
Specifies whether display a list of related videos. 
 
URL 
Specifies the URL of the youtube video.  
The URL should be in the following format: http://www.youtube.com/v/x-40jgwazk0 
 
Allow Full Screen 
Enables the 'full screen' button in the player's control bar. 
 
Auto Hide Controls 
The video progress bar and the player controls will slide out of view a couple of seconds after the video 
starts playing. They will only reappear if the user moves her mouse over the video player or presses a 
key on her keyboard. 
 
Use Modest Branding (no logo) 
This option lets you use a YouTube player that does not show a YouTube logo. Enable this option to 
prevent the YouTube logo from displaying in the control bar. 
 
Fill entire browser window 
Use the YouTube video as page background. 
 
Aspect ratio 
Keep the aspect ratio of the video fixed at 16:9 or 4:3. This is especially useful when the video is party of 
a Layout Grid, so the video resizes dynamically while keeping the original aspect ratio. 
 
Custom parameters 
Use custom parameters to add extra features which are not implemented in WWB (yet). For a complete 
list of available options please check the YouTube API documentation: 
https://developers.google.com/youtube/player_parameters 
 
Lightbox 
The Lightbox option makes it possible to display another page in a lightbox (using FancyBox) after 
clicking on a preview image. You can specify the preview image, lightbox title and width/height of the 
lightbox. In 'Lightbox Settings' you can specify additional options for the Fancy Lightbox. Each option 
must be on a new line and separated by a comma: 
'overlayShow' : true 
 
More information about options is available here: http://fancybox.net/api 
 

 

http://www.youtube.com/v/x-40jgwazk0
https://developers.google.com/youtube/player_parameters
http://fancybox.net/api
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Blog 
The word 'blog' is short for web log. A blog is a journal that's posted on the web for other to read.  
The Blog object provides an easy way to implement a blog on your website without special 
requirements on the web server. Unlike its name suggests, the Blog can be used for more than just a 
blog. It is also a quick way to display all kinds of data is a list or grid. 
  
Comment Text, each blog entry will have a link on the bottom to allow readers to send comments. The 
default text is 'Send Comments', but you can change this to anything you like. If you leave this field 
blank, no link will be displayed. Comment Email, specifies the email address where the comments will be 
send to. To add a new entry to your Blog, click the Add button. Give you blog entry a title and then type 
your blog's message in the text area. Optionally you can insert an image and a link to a related web 
page. 
 
Sort Order 
Specifies the order of the items on the page ('Ascending' or 'Descending'). 
 
Columns 
Specifies whether to display the blog items in columns. This option is responsive, so each breakpoint can 
have different number of columns. 
 
Layout 
This controls the appearance of the blog items. More than 10 different layouts are currently available. 
You can also create your own layouts (with HTML/CSS templates). The templates are stored in the folder 
Documents\Quick ‘n Easy Web Builder\system\blog\ 
 
Note: Quick ‘n Easy Web Builder currently does not render the different layout, because this would 
require a built-in browser. And building a cross platform browser is out of the scope of this project (this 
would take years of extra work!). So you will need to preview the page to see the results! 
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Carousel 
The Carousel object (also known as horizontal sliding panels) displays images or any other objects by 
scrolling the content from right to left using a smooth sliding animation (with several optional easing 
effects).  Users can step to any specific panel on demand using the pagination icons or browse the 
carousel sequentially by using the back/next buttons. You can also think of the Carousel as a multiple 
layer slide show. It’s a very effective method to increase the web site usability and engage the user. You 
probably have seen this effect on many popular websites, such as Apple or Blackberry. 
 
When you first insert the Carousel to your page, you will see a blank area with two buttons and a 
pagination control. The buttons can be used to go to the next or previous panel. The pagination control 
displays a 'dot' for each page in the carousel. You can directly jump to a specific page by clicking the dot. 
The colors and size of the pagination control is configurable and of course you can select your won 
images for the next/back buttons as well. 
Advanced users can even use events to create custom buttons outside of the Carousel!  
 
To add new content to the current page, simply drag and drop objects within the Carousel area. To add 
objects to another page, first go to the page (either by using the pagination controls or next/back). 
Another cool feature of the Carousel is support for mobile devices. On the iPhone/iPad/Android you can 
use slide gestures to switch between pages! 
 
Note that the objects that you drag onto the Carousel should be smaller than the size of the Carousel 
itself otherwise they will not fit into the ‘drop container’ and will not become part of the Carousel. 
 

General 
Slide Count 
This will set the number of pages for the Carousel.  
 
Slide Backgrounds 
This option makes it possible to set a different background for each slide.  
 
Pause time 
Specify the number of milliseconds to pause before displaying the next panel in the sequence.  
 
Animation duration 
Specifies the duration of the slide animation in milliseconds. 
 
Easing 
You can select from more than 30 easing functions to control the animation process. This option can be 
used to (for example) create bounce or elastic effects. 
 
Enable navigation buttons 
Specifies whether to display the navigation buttons. 
 
Previous button 
Specifies the image to be used for the 'Previous' button. If you leave this field empty a default image will 
be used. 
 
Next button 
Specifies the image to be used for the 'Next' button. If you leave this field empty a default image will be 
used. 
 
Margin 
Specifies the margin between the border of the Carousel and the buttons. 
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Enable pagination 
Specifies whether to display the pagination controls. The pagination controls will be displayed on the 
bottom of the Carousel. The user can click the icons to quickly go to the specific panel. 
 
Color / Border Color 
Specifies the colors of the pagination icons. 
  
Size 
Specifies size of the pagination icons. 
  
Padding 
Specifies the padding around the pagination icons. 
 
Full Width Mode 
When this option is enabled the Carousel will be stretched to full width of the browser window. The 
content of the Carousel pages will not be stretched but aligned in the center of the Carousel.  
Many modern websites use this tech 
  
Full width and floating 
This makes it possible to use the Carousel as part of a floating layout. For example, in combination with 
layout grids or floating layers 
  

Style 
In this section you can modify the appearance of the object. For more details about object styling please 
read Style. 
 
How to control the slides through events? 
You can use the Slideshow Next and Slideshow Previous actions in events to create external navigation. 
 
It's also possible to directly jump to a specific page: 
1. Add the Carousel object to your page.  
2. Take note of the ID. The default value is ‘Carousel1'’.  
3. Add an image, shape or other object with event support to the page.  
4. Open the properties and select the ‘Events’ tab.  
5. Click ‘Add’ to insert a new event.  
6. Select ‘Event’: OnClick and set the ‘Action’ to JavaScript function.  
  
To show the dialog enter this JavaScript:  
$('#Carousel').carousel('goto,1'); 

 
where Carousel1 is the ID of the Carousel. 
goto,1 jumps to the first slide 
goto,2 jumps to the second slide. 
etc... 
 
To show the next slide you can also use this JavaScript:  
$('#Carousel').carousel('next'); 

 
To show the previous slide use:  
$('#Carousel').carousel('next'); 

 
Note: If the Carousel Mode is set to one of the effects, then ‘carousel’ should be replaced with 
‘carouseleffects’! 
 
$('#Carousel1').carouseleffects('goto,1'); 
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Content Place Holder 
The Content Place Holder object should be inserted on a Master Frame page. It defines where the 
content of the page will be inserted. 
 
Alignment 
Specifies how the content of the page will be aligned inside the place holder if it's smaller than the size 
of the content place holder. 
 
Overflow 
Specifies what will happen if the content of the page is larger than the size of the content placer holder. 

 Expand 
The place holder will automatically expand so that the content will fit without the need for 
scrollbars. All objects below and on the right side of the place holder will be repositioned. 

 Hidden 
Content that does fit inside the place holder will be hidden. 

 Scroll 
Scrollbars will be added if the content does not fit inside the place holder. 

 

Master Frames 
A Master Frame is a design concept where your website has a constant frame and only the inner part of 
the pages changes. In Quick ‘n Easy Web Builder you only have to design the frame once and then reuse 
it in all other pages. You can even automatically expand the layout if the content is larger than the 
content place holder! If the content is smaller than the place helper there is also an option to center it in 
the area. 
 
A master frame page can be any page in your website. To indicate the position where the content of the 
master frame must go, you must insert a Content Place Holder object to the master frame page. 
During preview/publish this content place holder will be replace with the actual content of the page. 
 
To indicate that a page must use the master frame, you must configure it in the Master Frame settings 
of the Page Properties. 
 

 
 
The master frame and content page will be merged into one page when it is preview/published. 
Note that the footer has been automatically repositioned because the page content was larger than the 
content place holder! All objects below and at the right side of the content place holder object can be 
repositioned automatically. You can also select to display scrollbars instead. 
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Master Frame with Content Place Holder Page Content 
 
 
 
 

 
 
Result in browser window, the master frame merged with the content of the page. 
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File Publisher 
This component automatically uploads the specified files to your web site and creates the folders once 
you publish this page. The files will be published to the same location as the page. 
 
This object can be helpful if you want to include extra files which are part of the page (like scripts or 
multimedia files). 
 
Add Files  
Add one or more files to the tree.  
 
Add Folder 
Insert a complete folder and all files it contains from your local disk. 
 
New Folder 
Adds a new folder name to the tree.  
 
Properties 
Modify the properties (folder name or file location) of the selected item. 
 
Remove 
Remove the selected item from the folder tree. 
 
Remove All 
Remove all items from the folder tree. 
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Layer 
Layers can be used to create advanced layouts. A layer is a container for other objects. Objects can be 
dragged and dropped on a layer just like on a form.  
 
In Default mode the layer will be positioned on the location where you've placed it during design time. 
 
Sticky Layer mode keeps a layer visible (top/bottom/left/right) at all times. This can be useful if you 
want to keep a menu or image visible even if the page scrolls. Animation is also an option! With 'Keep 
original position until layer is about to be hidden', the layer will only move to the specified if it is about 
to be scrolled outside of the view. ‘Orientation’ specifies to which side of the browser window the layer 
will 'stick'. You can use the offset values to set the horizontal and vertical offset from the borders. The 
‘Delay’ value specifies the animation delay. 
 
The Header/Footer mode can be useful if you are using the layer as a header or footer for your page 
usually in combination with the 'relative horizontal resizing' option. Normally the 'relative horizontal 
resizing' (and the other relative options) will add the code after the <body> container resulting in a 
higher z-index. Selecting 'Header/Footer' mode will insert the code before the <body> container, so the 
layer will be behind all other content. 
 
Docking layer mode allows you to dock a layer to a specific side of the screen or in the center of the 
screen. The main difference between this mode and the sticky layer mode is that Docking layer mode 
does not use JavaScript, instead is uses standard CSS techniques. It's just another way for you to use 
layers and this mode can also be useful for full page headers and footers. 
 
An Anchored Layer can anchor one or more sides of the layer to the sides of the page. For example, if 
you enable 'Anchor Left' and 'Anchor Right' then then the layer will stretch if you resize the browser 
window (the offset to the left and right page border will remain the same). But you can also anchor just 
one side (or all!). 
Related online tutorial: http://www.quickandeasywebbuilder.com/anchored_layers.html 
 
Floating Layer mode is for advanced usage. It will make the layer 'float' instead of having a fixed 
position. If multiple floating layers are placed on the page then they will be placed next to each other 
(from left to right) depending on the available screen space. If the layer does not fit on the current row, 
then it will be wrapped to the next row. This feature may be useful (for advanced users) to create 
responsive websites.  The option Floating mode can be used to control the 'float behavior': 

 Default 
The layer will be positioned to the right side of the previous floating object. If the object does 
not fit on the current row, then it will move to the next row. 

 Clear Left 
The layer will be forced to the next row. The layer can have other objects on the right side of 
the row (unless the next floating object is also set to clear left). 

 Full Width 
The layer will use the full width (100%) of the page. No other objects can be on the same row. 
This mode can be useful for headers or footers. Floating layers can be part of another (floating) 
layer. However currently only one nesting level is supported.  

 Full Screen 
This will set the width/height of the layer to 100% of the current view port. This can be useful 
for creating full screen/single page web sites. 

 
Related online tutorial: http://www.quickandeasywebbuilder.com/floating_layers.html 
 

http://www.quickandeasywebbuilder.com/anchored_layers.html
http://www.quickandeasywebbuilder.com/floating_layers.html
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Modal Layer mode will position the layer on top of everything. Other items on the page will be disabled 
until you close the layer. Enable backdrop, specifies whether the background overlay is enabled. Close 
on escape, specifies whether pressing the 'esc' key will close the modal layer. Modal Type, jQuery UI (as 
in previous version of WWB) or Bootstrap. Unlike the jQuery UI option Bootstrap is responsive, so the 
layer can have a different size in breakpoints! Also Bootstrap uses the title of the layer in the header. 
 
A Panel Layer is initially invisible, but can slide from the right or left side of the page by using events 
(show/hide). Display, specifies the relationship of the panel to the page contents. "Push" pushes the 
page over and "overlay" display the layer over the content. Dismissible, specifies whether the panel can 
be closed by clicking outside onto the page. 
 
Other options 
Overflow 
This overflow can be used to control the overflow behavior of the layer. 

 None 
The content of the layer is fully visible. In this case the size of the layer cannot be smaller the 
content. 

 Hidden 
The content is clipped, but the browser does not display a scroll-bar to see the rest of the 
content. 

 Scroll 
The content is clipped, but the browser displays a scroll-bar to see the rest of the content. This 
can be useful to create scrollable content without the need for an inline frame! 

 Auto 
If the content is clipped, the browser will display a scroll-bar to see the rest of the content. 
 

Note:  
To create/update the content of the layer, you must resize it in the designer so all objects will be visible. 
After you've created/updated the layout you can resize the layer to the desired size.  

 
 
Box Sizing 
The box-sizing property is used to tell the browser what the sizing properties (width and height) should 
include. Should they include the border-box or just the content-box (which is the default value)?  
The 'border-box' option is especially useful for full width layers, where you usually want the border 
inside the view port. With content-box the border size will be added to the total width (> 100%). 
 
Right  
Sets the position of the object relative to the right edge of the page. This will replace the 'left' attribute. 
 
Bottom  
Sets the bottom position of the layer from bottom of the page. This will replace the 'top' attribute. 
 
Relative horizontal/vertical position 
Instead of using absolute coordinates, the position of the layer will now be relative to the page 
width/height. This property only has effect when the page is displayed in the browser! 
 
Relative horizontal/vertical sizing 
Instead of using absolute dimensions, the width/height of the layer will now be relative to the page 
width/height. This property only has effect when the page is displayed in the browser! 
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Alignment  
Specifies the alignment of the content of the layer if Relative horizontal sizing is enabled. 

 Left 
The content will be left aligned (default). 

 Center 
The content will be centered. 

 Right 
The content will be right aligned. 

 Stretch content 
Position and size child object relative to the layer. This option can be used to created 
stretchable content. 
 

Notes about stretching content:  
This feature was primarily designed to be used for header and footers that will cover the complete 
width of the page. This option will only work for simple HTML objects like images, shapes, text. It will 
not work for advanced objects like menus, extensions, blog, galleries etc.  
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Layout Grid 
The Layout Grid can be used to create flexible multi column layouts that automatically adapt to the 
screen size. A grid can have up to 12 columns, with sizes in percentages. Objects that are dragged onto a 
grid will automatically become floating, which means that they are placed next to each other (from left 
to right) depending on the available space. If the object does not fit on the current row then it will be 
wrapped to the next row. Some objects (like images, text, blog, photo gallery) can be full width, so they 
always take up the entire row and stretch or shrink when the page size changes. For smaller (mobile) 
screens all columns are stacked based on the defined breakpoint. This is a great new way to create 
flexible and responsive (Bootstrap-like) layouts! 
 
Layout 
The grid can be configured as fixed or fluid layout. A fixed grid will have fixed columns based on the 
design time width of the grid. The layout will be centered in the viewport. A fluid grid uses the full width 
of the browser window and all columns will be resized accordingly. 
 
Padding 
Padding specifies the gutter width on each side of a column. 
 
Breakpoint 
The breakpoint specifies at which viewport width when the layout will be switched to mobile/stacked 
layout. 
 
Adding objects 
To add objects to the layout grid, simply drag & drop the object inside a column. The column will 
highlight to indicate where the object will be added. Note that the mouse cursor needs to be inside the 
column. 
 
Related online tutorials: 
http://www.quickandeasywebbuilder.com/layoutgrid_part1.html 
http://www.quickandeasywebbuilder.com/layoutgrid_part2.html 
 
 

Notes:  
Some objects cannot be part of a layout grid because they cannot be stretched automatically. For 
example: Layers, Forms, Tabs, Accordion. This behavior may change in future updates. 
 
Although you cannot drag a form to a layout grid, the grid itself can be a form! Also a Layer and Carousel 
can be set to ‘floating’, so they can be used together with layout grid on the same page. 

 

http://www.quickandeasywebbuilder.com/layoutgrid_part1.html
http://www.quickandeasywebbuilder.com/layoutgrid_part2.html
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Master Page 
The Master Page object is a very cool feature, which allows you to re-use objects from another page 
(from your web site) in the current web page. Let's say you have a certain layout which is the same for 
all your pages and you don't want this copy/paste it between all your pages; then simply create the 
layout once in page and insert the layout of that page in all your other pages using the master page 
object. When you want to update the layout you will only have to do this once in the original page. 
 
Here is an example: 

1. Create a new website, QnE Web Builder automatically adds the first page called 'index'. 
2. Insert a new page using the Site Manager and rename it to 'master_page’. 

 

 
 

3. Now let's add a navigation bar to the master page. Insert->Navigation->Navigationbar. 
 

 
 

4. Switch back to the index page (click on the index tab) and insert a Master Page object. 
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5. Double click the object you have just inserted to select a page. Next click the Select-button to 
display the Select Page window and choose master_page from the list. Click OK to return to the 
page. 
 

 
 
You will notice that the navigation bar of your master_page now has become a part of the 
index page. If you go back to the master page and you modified something in that page, it 
automatically is updated in the index page as well. Of course, this feature is not limited to 
navigation bars only; you can add any element to the master page. 

 
Notes: 

1. Place all objects on the master page aligned to the left and top border, so you do not have any 
margins. 

2. If you use the master_page only for master page purposes and not as standalone page, you can 
enable 'Don't Publish this page' in the Site Manager, so the page won't be published when the 
entire website is published. 

3. In contrast to inline frames, when using the Master Page object, all objects from that page are 
merged in the current page as if they are really a part of the page. You must however edit them 
in the master page. 

4. Master page objects do not clone the properties of a page! Only objects on the master page 
will be cloned.  

5. Since the objects are cloned "AS IS", make sure the IDs of objects on the master page are 
unique. You can change the ID in the Property Inspector. It's good practice to give them a 
prefix, like ‘master_’. This will prevent duplicated IDs on a page.  

6. Layer can be used on a master page. However you cannot use internal links on that layer. 
7. The option 'Use hover state style to indicate the current page' in navigation tools will not work 

in combination with master objects, because there will be only one set of images for that 
object. The same images will be used on all pages.  

8. The master page should be in the same folder as the pages than are using it. This is especially 
important if you are using internal links, because the links will be relative to the master page so 
if the page is in another folder then they are not valid. 

 
Master page is a layer 
When enabled, all of the elements that make up the master page are on a layer. This layer will block 
access to any page elements "beneath" it (in the z-order).  If the master page layer is on top of a button 
or link, visitors to your site will not be able to click on the button or link even if it is visible.  
When disabled, the master page elements are inserted as individual objects on the page. You can then 
access any objects "beneath" the masterpage objects (as long as they are visible). 
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Page Header 
The Page Header can be used to add a full width header to your website. 
Basically this object is a simplified layer, so most settings are identical and other objects can be dragged 
on top of this object to make then part of the header. 
The header will always be displayed at the top of the page. 
 
Mode 
Specifies the header mode. 

 Default 
The header will be positioned at the top of page. Note that this is not necessarily the top of the 
browser window.  

 Fixed 
The header will be fixed at the top of the browser window.  

 Fullscreen 
The header will be hidden by default and become visible when the user moves the mouse over 
the header. So the header is only visible when needed. This mode also supports animations to 
slide or fade the header into view.   

 Floating 
The position of the header will depend on other floating objects (like layers), but it will always 
be at the top.  

 
Stack Level 
Specifies the stack level of the header relatively to the page content. The header can either be 'In front 
of the content' or 'Behind the content'. 
 
Styling, alignment and other options are the same as for the Layer object. 
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Page Footer 
The Page Footer can be used to add a full width footer to your website. Basically this object is a 
simplified layer, so most settings are identical and other objects can be dragged on top of this object to 
make then part of the footer. The footer will always be displayed at the bottom of the page. 
 
Mode 
Specifies the footer mode. 

 Default 
The footer will be positioned at the bottom of page. Note that this is not necessarily the 
bottom of the browser window.  

 Fixed 
The footer will be fixed at the bottom of the browser window.  

 Fullscreen 
The footer will be hidden by default and become visible when the user move the mouse over 
the footer. So the footer is only visible when needed. This mode also supports animations to 
slide or fade the footer into view. The animation can be synchronized with the header 
animation so both header and footer show/hide at the same time.   

 Floating 
The position of the footer will depend on other floating objects (like layers), but it will always 
be at the bottom.  

 
Stack Level 
Specifies the stack level of the footer relatively to the page content. The footer can either be 'In front of 
the content' or 'Behind the content'. 
 
Styling, alignment and other options are the same as for the Layer object. 
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Timer 
The Timer object makes it possible to trigger actions based on timer events. For example show or hide 
an object after x milliseconds.  
Timers can also start/stop other timers! All event actions are supported (animate, show/hide, rotate, 
media, JavaScript etc). The possibilities are endless! 
 

General 
The Timer object supports two types: 

 Interval 
Executes a function, over and over again, at specified time intervals. 
 

 Timeout 
Executes a function, once, after waiting a specified number of milliseconds. 

 
Interval 
Specifies the interval in milliseconds. 
 
Auto start 
Specifies whether to automatically start the timer. If this option is not enabled you can start the timer 
through events (for example on click of a button). 
 
Note that you can also stop the timer through events (Timer Stop).  
 

Events 
In Events you can configure what will happen when the timer expires. For example you can display or 
hide an object, play a media file, animate something etc. 
 

For more information about events please read the chapter ‘Events’ of this document. 
 
Related tutorial: 
http://www.quickandeasywebbuilder.com/timers.html 
 

http://www.quickandeasywebbuilder.com/timers.html


Quick ‘n Easy Web Builder   

130 

Wrapping Text 
One of the most requested features is the possibility to wrap text around images and other objects. 
Unfortunately this functionality is very complicated to implement because the size and position of text is 
usually not exactly the same in different browsers. The results with standard HTML/CSS are 
unpredictable and not what-you-see-is-what-you-get. Although future versions of HTML/CSS will 
support more flexibility, so we decided to simulate the wrapping functionality for now and when 
browsers are ready for it we will convert it to the official standard. 
 
'Wrapping Text' is an object container (just like a layer and form) with text. By default the text will fill 
the entire box, but when you drag & drop objects inside the 'Wrapping Text' object then the text will 
wrap around it! 
 
All text will have the same formatting which can be configured in the Style properties. Because not all 
fonts behave the same way in different browsers, we have added a 'font fine-tune' option which allows 
you to fine-tune the size of the font for the best results. Make sure you test this in all browsers! 
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Breadcrumb 
Breadcrumbs are used to enhance the accessibility of a website by indicating the location using a 
navigational hierarchy. You can either manually configure all links for the menu or automatically 
synchronize with Site manager. Also supports FontAwesome icons. 
 

 
 
Synchronize with Site Manager 
When this option is enabled, Web Builder automatically synchronizes the Buttons with the content of 
the Site Manager. So if for example you add a new page, then a button is automatically added to the 
menu. Or if you rename a page the text of the item will also be updated. 
 
Level 
This value specifies which level of the Site Manager will be used to create the buttons.  
First Level 
Includes the 'index' page. 
Parent Level 
Include all parents of the current page. 
 
Target 
Specifies the target window of the links when 'Synchronize with Site Manager' is enabled. 
 
Symbol 
Use '>>>' for special arrow separator. You can increase the 'padding' to control the sharpness of the 
arrow.  A value of 15 gives pretty good results. 
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CSS Menu 
This menu is very similar to the Navigation bar with the main difference that this menu does not use any 
images or JavaScript! Still the CSS menu allows you to create fancy looking menus (glossy, glass, 
gradients etc) using CSS3 gradients and shadows. 
 
The CSS Menu can be either vertical or horizontal. 
We have also added an (experimental) 'Responsive' option. If you select this option then the menu will 
automatically switch from horizontal to vertical mode if the screen width is smaller than 320 pixels. 
This can be useful when the CSS menu is used in Responsive Web Design. 
 
Note that CSS3 gradients and shadows are not available in all browsers yet; IE9 and older does not 
support it! However the links will work in all browsers. Old browsers will display a solid color button. 
 

 
 
Synchronize with Site Manager 
When this option is enabled, Web Builder automatically synchronizes the Buttons with the content of 
the Site Manager. So if for example you add a new page, then a button is automatically added to the 
menu. Or if you rename a page the text of the item will also be updated. 
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Layer Menu 
Layer Menu is an advanced menu where the drop down menus are layers. This is great for creating 
advanced mega menus with images, text, form or any other object! The drop down layer can be 
positioned left, centered or at the right of the buttons. It is also possible to make the layer full width of 
the page. 
 

 
 
 

Notes:  
Main buttons can have links, make the layer size smaller than 48 pixels to remove the layer from the 
item. 
Not recommended for smaller screens. 
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Mega Menu 
Mega Menus are drop down menus that contain multiple columns of links. They enable access to all 
links at once, rather than forcing the user to scroll or use sub-menus. One of the unique features of this 
Mega Menu is that you can set different drop down styles for each button. The drop down can have 
rows, columns, just a simple menu or no sub menu. 
 

 
 
The Mega Menu was created using jQuery and supports the same ThemeRoller themes as the other 
jQuery based components. You can set the theme for the whole in Page Properties->jQuery UI Theme. 
Themes can be created/edited with the built-in Theme Manager. 
  
Items 
Here you can add, edit and remove menu items to the Mega Menu. Click ‘Add’ to insert a new button to 
the main menu bar. The properties of the button give you access to the submenu. 
 
Button Text 
Specifies the text of the button. 
 
Menu Layout 
Specifies how the items in the submenu will be displayed. 

 Columns only 
All categories will be displayed in columns (1 row).  

 Rows only 
All categories will be displayed in rows (1 column)  

 2 columns 
Categories will be displayed in 2 columns.  

 3 columns 
Categories will be displayed in 3 columns.  

 4 columns 
Categories will be displayed in 2 columns  

 Simple menu 
Displays a simple drop down menu  

 Button only 
The button has no sub menu.  

 
Links are organized in categories. To add a new category click the ‘Add category’ button and specify a 
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name. To add a link to a category, first select the category name and then click ‘Add Link’. 
 
You can rearrange the links with the ‘Move Up’ and ‘Move Down’ button or by using drag & drop. 
 

Style 
The menubar uses the global page theme which can be set in Page Properties->Style. 
Other object specific settings can be altered in the 'Style' section of the Mega Menu properties. 
The ‘Font name’ and ‘Font Size’ properties can be used the override the default font of the theme. 
The ‘Animation’ property enables the fade animation for hiding and showing sub menus. 
 
Button Padding 
Specifies the padding for the buttons. The Button text in combination with the padding determines the 
size of the button. 
 
Button Spacing 
Specifies the spacing between the button. 
 
Icon Index 
Specifies the icon displayed on the button. 
 
Icon Offset 
Specifies the position of the icon on the button. 
If the value is positive, the icon will be aligned on the left side of the button. 
If the value is negative, the icon will be aligned on the right side of the button. 
  
Sub Menu Padding 
Specifies the padding for the sub menu.  
 
Sub Menu Icon Index 
Specifies the icon displayed on the left side of the links. 
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Menu Bar 
The Menu bar in Web Builder is based on Heng Yuan's JSCookMenu 
(http://www.cs.ucla.edu/~heng/JSCookMenu). This is a very powerful JavaScript-based menu script that 
can mimic complex menus found in popular GUI applications. Quick ‘n Easy Web Builder provides a 
menu builder so you can easily add menu items, assign the links and set the style for the menu using the 
style tab.  
 

 
 
Items 
Select Add to insert a new item to the menubar. Select Edit to modify the properties of an existing item. 
To remove an item from the Menu Bar select Remove. The Insert Split button inserts a splitter/divider in 
the menu. Move Up, moves the selected item up amongst its siblings. Move Down, moves the selected 
item down amongst its siblings. Move Left will make the selected item a sibling of its parent. Move Right 
will make the selected item the child of its preceding sibling. 
 
Layout 
Specifies whether the menu bar should be displayed horizontally or vertically. 
 
Effect 
Specifies the effect that will be used to open sub menus: None, Fading or Sliding. 
 
Style 
The menu bar has many style properties, most of them speak for themselves. Just try them out to see 
the results. 
 
Synchronize with Site Manager 
When this option is enabled, Web Builder automatically synchronizes the Buttons with the content of 
the Site Manager. So if for example you add a new page, then a button is automatically added to the 
menu. Or if you rename a page the text of the item will also be updated. 
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Navigation bar 
Adding a Navigation Bar in Quick ‘n Easy Web Builder is really easy.  
Just add a few buttons, assign the links and set the style for the buttons. 
 

 
 
Animation duration 
Specifies the duration of the animation. 
 
Image / Image Hover 
Select one of the available button styles from the drop down menu. 
Quick 'n Easy Web Builder includes a several button styles but you can easily add your own styles: 
Copy your own styles (which are basically just images) to /navbar sub folder of the application. 
 
Items 
This option allows you to add, edit or remove buttons/links. 
 
Layout 
The Navigation Bar can be either Vertical or Horizontal. 
 
Resize Buttons 
Enable this option to be able to resize navigation bar buttons horizontally. Instead of the original button 
width, the button will now be stretched according to the overall navigation bar. 
 
Space 
Specifies the space between buttons. 
 
Use custom images 
Enable this option if you want to specify your own image buttons instead of using a standard style. 
 
Use hover style for current page 
To give the visitors of your web site an indication of which page they currently are viewing you can give 
that page the same style as the hover state. 
 

Text 

Alignment 
You can change the alignment of the selected text object by using one of the alignment buttons: Left, 
Center or Right.  
 
Bold/Italic/Underline 
The style of the text can either be regular, bold, italic, or underline.  
 
Font Name 
Font type is the font family of text, such as Comic Sans, Times New Roman, and Courier New.  
 
Font Size 
To change the font size, select one of the available font sizes. 
 
Text Color 
Specifies the color of the text.  
 
Use jQuery UI theme 
Use the jQuery UI theme to style the object. More details about themes: Theme Manager. 
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Panel Menu 
A Panel Menu is initially invisible, but can slide from the right or left side of the page by clicking the 
menu button. Many modern web sites use this menu type. The general menu settings are the same as 
for other menu types like the navigation bar. 
 
Button Text 
Specifies the text of the menu button. 
 
Icon 
Image that can be displayed on the button. The icon position can be used to control the icon position 
relatively to the text. 
 
Display 
Specifies the relationship of the panel to the page contents. "Push" pushes the page over and "overlay" 
display the layer over the content.  
 
Position 
Specifies whether the panel menu will be displayed at the left or right side of the page. 
 
Dismissible 
Specifies whether the panel can be closed by clicking outside onto the page.  
 
Panel Width 
Specifies the width of the panel. By default this value is in pixel but you can also use percentage, for 
example 50%. 
 
The animation can either be none or slide. The slide animation also supports many easing options. 
 
Synchronize with Site Manager 
When this option is enabled, Web Builder automatically synchronizes the Buttons with the content of 
the Site Manager. So if for example you add a new page, then a button is automatically added to the 
menu. Or if you rename a page the text of the item will also be updated. 
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Pagination 
If you have a web site with lots of pages, you may wish to add the pagination object for easier 
navigation. 
 

 
 
Synchronize with Site Manager 
Automatically generates links with auto numbering and next/previous buttons. Always synchronizes 
with current level. 
 
- Leave label text empty to remove the button. 
This menu also works with the Content Management System. 
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Quick Menu 
You can use the Quick Menu component to easily create a drop-down navigation menu, with each menu 
item corresponding to a single URL or page in your web site. When the user presses the Go button the 
select link will be activated. 
 
Items 
This option allows you to add, edit or remove links. 
 
Initial Text 
This is the initial text which will be displayed in the dropdown menu. 
 
Button Text 
The text of the button 
 
Show button 
Enable this option to show the 'Go' button. Is this case a drop down menu selection will trigger the link. 
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Responsive Menu 
The Responsive menu is a responsive, multi-level menu optimized for desktop computers and mobile 
(touch) devices which uses CSS only (no JavaScript). On desktop computers the menu will display a 
standard drop down menu and on mobile devices it will display a multi-level stacked menu with the 
common ‘hamburger’ icon.  
 

 
 
The menu supports FontAwesome icons to give your website a modern look and feel. 
 
Breakpoint 
Specifies the browser width where the menu will switch from desktop to mobile mode. 
 
Most other style and menu related properties are the same as in other menus. 
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Tab Menu 

 

 
The Tab Menu is yet another way to implement your website navigation. The main difference between 
the navigation bar and the tab menu (besides its appearance) is that a tab menu item has 3 states: 

1. Normal 
Idle state 

2. Hover 
Mouse over or Roll over state 

3. Activate 
The selected item is the current page.  

 
Items  
Use this property to add, edit or remove tabs/links. 
 
Tab Menu Style 
Quick 'n Easy Web Builder includes several themes you can choose for the appearance of the tab menu. 
The default theme is text only and does not use any images. The other themes are defined in the 
tabmenu folder and usually are made of 2 images. If you like you can modify the themes or create your 
own themes (for advanced users only). 
  
Use jQuery UI theme 
Use the jQuery UI theme to style the object. More details about themes: Theme Manager 
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Text Menu 
The Text Menu is a text-only version of the Navigation bar. 
Text menus can speed up the navigation through your website, because no images need to be loaded 
first before the user can navigate to another page. 
 

 
 

Background 
Background Mode 
Specifies the background mode: Solid, Image or Transparent. 
 
Background Color 
Specifies the color of the form background. If set to 'Automatic' the standard (system) button color will 
be used. 
 
Background Image 
Specifies the optional background image. 
 
Horizontal Alignment 
Sets the horizontal position for the background image.  
 
Repeat 
Sets the tiling attributes for the background image. Possible options are: 

 Repeat in both directions 

 Repeat in horizontal direction 

 Repeat in vertical direction 

 Do not repeat 
 
Vertical Alignment 
Sets the vertical position for the background image. 
 

Miscellanious 
Delimiters 
Here you specify special characters to put before and after the link text. Common characters include {, [  
and (. 
 
Items 
Use this property to add, edit or remove links. 
 
Layout 
The text menu can be either vertical or horizontal. 
 

Text 

Alignment 
You can change the alignment of the Text Menu by using one of the alignment options: Left, Center or 
Right.  
 
Font Type 
Font type is the font family of text, such as Comic Sans, Times New Roman, and Courier New.  
 
Font Size 
To change the font size, select one of font sizes.  
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Curve 
The Curve tool lets you draw curved lines. 
 
To draw a curved line: 

1. Click the Curve Tool on the Toolbox or click Insert->Drawing->Curve.  
2. Click and release the left mouse button where you want the Curve to start, while dragging the 

mouse press and press/release the mouse button to add points. 
3. To end the curve, double click the left mouse button.  

For more information about editing nodes see 'Edit Points' in the Arrange Menu. 
 

 
 
The curve will be converted to an image when you publish the page. 
 

Border 
Border Color 
Specifies the color of the border around the object.  
 
Border Style 
Specifies the style of the border: Dash, Dot, Dash Dot or Dash Dot Dot. 
 
Border Width 
Specifies the width of the border around the object. Set this to 0 (zero) for no border. 
 

Events  

For more information about events please read the ‘Events’ chapter of this document. 
 

Miscellaneous 

Alternate text 
This text, usually a short description, appears in place of the object in browser when images are 
unsupported or have been disabled.  
 
Angle 
This option allows you to rotate the object. 
 
Fill Effect (Closed Curve only) 
Specifies the fill effect of the polygon: Solid, Gradient, Texture, Hatch or Transparent. 
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Line 
The Line tool of Quick ‘n Easy Web Builder gives you much control over its appearance than the 
standard HTML horizontal line. The Line can be drawn using any angle, color, style and can even have 
arrows on the start or end of the line! 
 
To draw a line: 

1. Click the Line Tool on the Toolbox or click Insert->Drawing->Line.  
2. Click where you want the line to start, and hold the left mouse button down as you draw. To 

end the line, release the mouse button. 
 

 
 
The line will be converted to an image when you publish the page. 
 

Miscellaneous 

Alternate text 
This text, usually a short description, appears in place of the object in browser when images are 
unsupported or have been disabled. In some browsers it appears as a ToolTip when you move the 
mouse over the image. 
 
Arrow Start 
Specifies the arrow type of the start of the line (None, Arrow, Circle, Square, Diamond, Stealth or Thin 
Arrow). 
 
Arrow Start Size 
Specifies the size of the arrow. 
 
Arrow End 
Specifies the arrow type of the end of the line (None, Arrow, Circle, Square, Diamond, Stealth or Thin 
Arrow). 
 
Arrow End Size 
Specifies the size of the arrow. 
 
Color 
Specifies the color of the line.  
 
Line Size 
Specifies the thickness of the line.  
 
Style 
Specifies the style of the line (Solid, Dash, Dot, Dash Dot or Dash Dot Dot). 
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Polygon 
The Polygon tool lets you draw polygons with borders and several filling methods. 
 
To draw a polygon: 

1. Click the Polygon Tool on the Toolbox or click Insert->Drawing->Polygon.  
2. Click and release the left mouse button where you want the polygon to start, while dragging 

the mouse press and press/release the mouse button to add points.  
3. To end and close the polygon, double click the left mouse button.  

For more information about adding, editing or removing nodes see 'Edit Points' in the Arrange Menu. 
 

 
 
The polygon will be converted to an image when you publish the page. 
 

Border  

Border Color 
Specifies the color of the line.  
 
Border Style 
Specifies the style of the line (Solid, Dash, Dot, Dash Dot or Dash Dot Dot).  
 
Border Width 
Specifies the thickness of the line.  
 
 

Miscellaneous  

Alternate text 
This text, usually a short description, appears in place of the object in browser when images are 
unsupported or have been disabled. In some browsers it appears as a ToolTip when you move the 
mouse over the image. 
 
Angle 
This option allows you to rotate the object. 
 
Fill Effect 
Specifies the fill effect of the polygon: Solid, Gradient, Pattern or Transparent.. 
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Scribble 
The Scribble tool lets you sketch curved lines and shapes in a freeform way. 
 
To draw a freeform line: 

1. Click the Scribble Tool on the Toolbox or click Insert->Drawing->Scribble.  
2. Click where you want the line to start, and hold the left mouse button down as you draw. The 

line will be drawn immediately and follows your mouse movements. Releasing the mouse 
button will draw a straight line from the point where you released the button to the current 
mouse position. 

3. To end the line, double click the left mouse button.  
For more information about adding, editing or removing nodes see 'Edit Points' in the Arrange Menu. 
 
The drawing will be converted to an image when you publish the page. 
 

Border  

Border Color 
Specifies the color of the line.  
 
Border Style 
Specifies the style of the line (Solid, Dash, Dot, Dash Dot or Dash Dot Dot).  
 
Border Width 
Specifies the thickness of the line.  
 
 

Miscellaneous  

Alternate text 
This text, usually a short description, appears in place of the object in browser when images are 
unsupported or have been disabled. In some browsers it appears as a ToolTip when you move the 
mouse over the image. 
 
Angle 
This option allows you to rotate the object. 
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Shape 
The Shape object can be used to 'draw' a shape on your webpage. When you publish a page with 
shapes, Web Builder generates each shape as a .gif file. 
 

 
 
Type: Select the type of shape you want to be display on your web page. 

 Rectangle 

 Round rect 

 Ellipse 

 Diamond 

 Hexagon 

 Octagon 

 Arrows 

 Signs 

 Stars 

 Talk Bubbles  

 and many more. 
 

Background  

Background effect 
You can select from the following Fill Effects: 

 Solid Color 

 Gradient 

 Image 

 Pattern 

 Multi color gradient 

 Transparent 
Each fill effect has several additional configuration parameters, like gradient or pattern styles 
 

Border  

Border Color 
Specifies the color of the line.  
 
Border Style 
Specifies the style of the line (Solid, Dash, Dot, Dash Dot or Dash Dot Dot).  
 
Border Width 
Specifies the thickness of the line.  
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Miscellaneous  

Alternate text 
This text, usually a short description, appears in place of the object in browser when images are 
unsupported or have been disabled. In some browsers it appears as a ToolTip when you move the 
mouse over the image. 
 
Angle 
This option allows you to rotate the object. 
 
Shape 
Select the type of shape you want to be display on your web page. 
Rectangle, Round rect, Ellipse, Diamond, Hexagon, Octagon, Parallelogram, Triangle, Trapezoid, Arrows, 
Flag, Flower, Heart, Signs, Stars, Talk Bubbles and many more! 
 
Output format 
Normally shapes will be published as images, for larger shapes this may have some impact on the 
performance of your website. However modern browsers (FireFox 5, IE9, Safari, Chrome) now have 
built-in support for alternatives formats like <canvas> and css. Quick 'n Easy Web Builder now enables 
you to convert your shapes into native HTML5 elements! 
 
Select 'Publish as <canvas>' to output the shape using HTML5's <canvas> element. Basically this 
generates a complex set of JavaScript calls to draw the shape in the browser. 
 
Select 'Publish as CSS3' to output the shape using CSS3 styling. This will output a standard <div> with 
CSS3 styling (border and background color). Note in this mode only rectangle, ellipse and rounded 
corner shapes are possible, because CSS does not support any other shape types! 
 
Known limitations:  
- This is a very new technique and not all Quick 'n Easy Web Builder shape features are available yet, but 
we will continue to improve the software when browsers catch up;) 
- Not all gradient effects are supported.  
- Text on shape is not supported.  
- Dotted and dashed border are not supported for <canvas>. 
- Shadow and other images effects are not supported. 
 

Shadow 
Enable Shadow 
Specifies whether to enable the shadow effect. 
 
Offset X 
Horizontal shadow offset 
 
Offset Y 
Vertical shadow offset 
 
Shadow Color 
Specifies the shadow color 
 
Shadow Opacity 
Sets the transparency of the shadow. 
 

Events  

For more information about events please read the ‘Events’ chapter of this document. 
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Logo 
A banner is an image that displays the title of a web page. A banner helps visitors understand what the 
page is about. The logos have some nice effects like text reflection and shadow. 
 

 
 

Background 

Background effect 
You can select from the following Fill Effects: 

 Solid Color 

 Gradient 

 Tiled or stretched image. 
 

Border 

Border Color 
Specifies the color of the border around the Logo.  
 
Border Offset 
Specifies the offset of the border from the edges. 
 
Border Style 
Specifies the style (Solid, Circle, Disc, Square or Dash) of the border around the Logo.  
 
Border Width 
Specifies the thickness of the border around the Logo. Set this to 0 (zero) for no border. 
 

Font 

In this section you can select the font font family of text (such as Comic Sans, Times New Roman, and 
Courier New), font size, style (Bold, Italic, Underline) and the color of the text. 
 

Text 

Horizontal Alignment 
Horizontal alignment of the text. 
 
Horizontal Offset 
Specifies the horizontal offset of the text. 
 
Text 
Text that will be displayed on the Logo. 
 
Vertical Alignment 
Vertical alignment of the text. 
 
Vertical Offset 
Specifies the vertical offset of the text. 
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Shadow 

Enable shadow 
Specifies whether to enable the shadow effect for text. 
 
Offset X 
Horizontal shadow offset 
 
Offset Y 
Vertical shadow offset 
 
Shadow Blur 
Softens the shadow's edges. 
 
Shadow Color 
Specifies the shadow color 
 
Shadow Opacity 
Sets the transparency of the shadow. 
 

Reflection 

Enable reflection 
Specifies whether to enable the reflection effect for text. 
 
Reflection 
Specifies the amount of reflection of the text. 
 
Reflection Offset 
Specifies the offset of the reflection from the bottom of the text. This value can be negative. 

 



Quick ‘n Easy Web Builder   

152 

PayPal eCommerce Tools 
The PayPal eCommerce Tools are the quickest and easiest way to add eCommerce to your web site. You 
can easily create payment buttons and basic shopping cart functionality for your web site with only a 
few mouse clicks! Accept payments from anyone, all you need to set up a PayPal account is an email 
address! PayPal is one of the leading and more respected payment services on the Web. Best of all, it 
costs nothing to set up an account. 
  
Sign Up for a PayPal Account now: 
https://www.paypal.com/mrb/pal=6TUEY37GLM48U 
 
The following tools are available: 

 Buy Now  
Enable e-commerce on your website by letting customers quickly buy one item at a time. 

 Add to cart  
 View cart  

These buttons are part of PayPal's shopping cart solution. 
With the 'Add to cart' Button users can add one of more items to their shopping cart.  
The 'View Cart' button lets users check their cart whenever they'd like.  

 Subscription  
Useful for subscriptions and recurring payments. Accept recurring payments with flexible, 
automated billing. 

 Donation  
Accept credit card and bank account donations on your website or via email. 

 

https://www.paypal.com/mrb/pal=6TUEY37GLM48U
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Buy Now 

When you use PayPal's Buy Now Buttons, you can sell individual items from your website.  
Buy Now Buttons is a low–cost way for you to accept bank account payments, and can be fully 
integrated with your website in a few easy steps. 
 
PayPal Account: Email address for your PayPal account. 
Button Image: Specifies the button image that will be displayed on your webpage. Select 'Custom 
Image' if you want to specify a custom image. 
Sandbox  Enabled: PayPal provides a Sandbox to allow you to test your site without actually making 
payments. Uncheck this option when publishing the live version of your site! 
More information about the PayPal's sandbox: https://developer.paypal.com/ 
Target: Specifies the browser window where PayPal's website will be opened. Default: PayPal. Make this 
field empty if you want the PayPal website to open in the current window. 
 
Item name/service: Description of item. This field is optional. If omitted customers can enter an item 
name at time of purchase. 
Item ID/number: Pass-through variable for you to track purchases passed back to you at payment 
completion. This field is optional. If omitted no variable is passed back to you. 
Price: The price or amount of the purchase, not including shipping, handling, or tax. If omitted 
customers can enter an amount at time of purchase. 
Tax: Transaction-based tax override variable. Set this to a flat tax amount to apply to the transaction 
regardless of the buyer’s location. This value overrides any tax settings set in your Profile. 
Default: Profile tax settings (if any) apply. 
Currency: The currency of the payment. Defines the currency in which the monetary variables (amount, 
shipping, shipping2, handling, tax) are denoted. 
Allow customers to edit quantity: When this option is enabled it allows the buyer to specify the 
quantity. 
 
Base shipping: The cost of shipping this item if you have enabled item-specific shipping costs. This field 
is optional. 
Extra shipping: The cost of shipping each additional item. This field is optional. 
Handling costs: Handling charges. This is not quantity-specific. The same handling cost is charged 
regardless of the number of items purchased. This field is optional. 
Require shipping information: Specifies whether to prompt the customer for a shipping address. 
Allow customer note: Specifies whether to prompt the customer to include a note with the payment. 
 
Successful Payment URL: The URL to which the customer’s browser is returned after completing the 
payment; for example, a URL on your site that displays a “Thank you for your payment” page. If omitted 
the customer is taken to the PayPal website. 
Cancel Payment URL: A URL to which the customer’s browser is returned if payment is cancelled; for 
example, a URL on your website that displays a 
“Payment Canceled” page. If omitted the Browser is directed to the PayPal website. 
Buyer's Country: Defines the buyer’s language for the Login page only. 
  
More information: 
http://www.paypal.com/cgi-bin/webscr?cmd=p/xcl/rec/singleitem-intro-outside 
 
 

https://developer.paypal.com/
http://www.paypal.com/cgi-bin/webscr?cmd=p/xcl/rec/singleitem-intro-outside
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PayPal Shopping Cart 

When you use PayPal's free Shopping Cart on your website, your customers can purchase multiple items 
with a single payment, browse your entire selection, and view a consolidated list of all their items before 
purchasing. The PayPal Shopping Cart is a low-cost way for you to accept credit card and bank account 
payments, and can be fully integrated with your website in a few easy steps. 
When a buyer clicks the "Add to Cart" button, a new window will appear listing the contents of the 
buyer's PayPal Shopping Cart, including the item just added. To make the purchase, the buyer clicks 
"Checkout" from this window. 
 

Add to Cart 

The Add to Cart button can be used to add an item to the shopping cart. 
 
PayPal Account: Email address for your PayPal account. 
Button Image: Specifies the button image that will be displayed on your webpage. Select 'Custom 
Image' if you want to specify a custom image. 
Enable SandBox: PayPal provides a Sandbox to allow you to test your site without actually making 
payments. Uncheck this option when publishing the live version of your site! 
More information about the PayPal's sandbox: https://developer.paypal.com/ 
Target Window: Specifies the browser window where PayPal's website will be opened. Default: PayPal. 
Make this field empty if you want the PayPal website to open in the current window. 
 
Item name/service: Description of item. This field is optional. If omitted customers can enter an item 
name at time of purchase. 
Item ID/number: Pass-through variable for you to track purchases passed back to you at payment 
completion. This field is optional. If omitted no variable is passed back to you. 
Price: The price or amount of the purchase, not including shipping, handling, or tax. If omitted 
customers can enter an amount at time of purchase. 
Tax: Transaction-based tax override variable. Set this to a flat tax amount to apply to the transaction 
regardless of the buyer’s location. This value overrides any tax settings set in your Profile. 
Default: Profile tax settings (if any) apply. 
Currency: The currency of the payment. Defines the currency in which the monetary variables (amount, 
shipping, shipping2, handling, tax) are denoted. 
Allow customers to edit quantity: When this option is enabled it allows the buyer to specify the 
quantity. 
 
Successful Payment URL: The URL to which the customer’s browser is returned after completing the 
payment; for example, a URL on your site that displays a “Thank you for your payment” page. If omitted 
the customer is taken to the PayPal website. 
Cancel Payment URL: A URL to which the customer’s browser is returned if payment is cancelled; for 
example, a URL on your website that displays a 
“Payment Canceled” page. If omitted the Browser is directed to the PayPal website. 
 Buyer's Country: Defines the buyer’s language for the Login page only. 
 

View Cart 

The View Cart button can be used to view the contents of the shopping cart. 
 
PayPal Account: Email address for your PayPal account. 
Button Image: Specifies the button image that will be displayed on your webpage. Select 'Custom 
Image' if you want to specify a custom image. 
 
More information: 
http://www.paypal.com/cgi-bin/webscr?cmd=p/xcl/rec/sc-intro-outside 

https://developer.paypal.com/
http://www.paypal.com/cgi-bin/webscr?cmd=p/xcl/rec/sc-intro-outside
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Subscription 

When you use PayPal Subscriptions and Recurring Payments, your customers can purchase 
automatically recurring subscriptions from your website. 
Subscriptions and Recurring Payments is a low-cost way for you to accept credit card and bank account 
payments for content site subscriptions, newsletter fees, club dues, or recurring donations, and can be 
fully integrated with your website in a few easy steps. Subscriptions and Recurring Payments are only 
available for Business or Premier accounts. 
 
PayPal Account: Email address for your PayPal account. 
Button Image: Specifies the button image that will be displayed on your webpage. Select 'Custom 
Image' if you want to specify a custom image. 
Enable SandBox: PayPal provides a Sandbox to allow you to test your site without actually making 
payments. Uncheck this option when publishing the live version of your site! 
More information about the PayPal's sandbox: https://developer.paypal.com/ 
Target Window: Specifies the browser window where PayPal's website will be opened. Default: PayPal. 
Make this field empty if you want the PayPal website to open in the current window. 
 
Subscription name: Enter the name of the subscription you wish to sell in the Subscription name field. If 
you do not enter anything in this field, your customers can complete it.  
Reference Item Number: If you have an ID or tracking number for your item, enter it in the Reference 
Item Number field. This field will not be displayed to your customers at the time of payment, but they 
will see it in their transaction details on the PayPal website. 
Currency: Choose the currency in which you would like this payment to be denominated. This field will 
default to the currency of your primary balance. 
Bill the subscriber for: Enter your regular subscription rate. 
Length of each billing cycle: Specifies the regular billing cycle. 
Would you like to stop the recurring payments after a certain number? 
Enable this option if you would like to end your customers’ subscriptions after a certain number of 
payments at your regular rates. This means that once a customer has made the specified number of 
payments at your regular rate, his subscription will be completed. If you disable this option your 
customers’ subscriptions will continue unless it is cancelled manually or by payment failure. 
Trial periods (optional) 
You may enter a trial period and rates for your subscription. To create a free trial 
period, enter an amount of 0. Trial periods can be entered as a number of days, weeks, months, or 
years. 
Reattempt on Failure 
Enable this option if you would like PayPal to automatically reattempt failed 
payments. Payments will be reattempted three days after the failure date. After a second failure, PayPal 
will try once more five days later. A third failure will lead to an automatic cancellation of the 
subscription. 
Payments made with bank accounts are automatically reattempted once, three days after PayPal 
notifies the user that the payment failed. If you select No, failed payments will result in the automatic 
cancellation of the subscription. 
Require shipping information: Specifies whether to prompt the customer for a shipping address. 
 
More information: 
http://www.paypal.com/cgi-bin/webscr?cmd=p/xcl/rec/subscr-intro-outside 
 
 

https://developer.paypal.com/
http://www.paypal.com/cgi-bin/webscr?cmd=p/xcl/rec/subscr-intro-outside
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Donation 

Collect donations from a button on your website. 
PayPal Donations is a low cost way for you to accept credit card and bank account donations. Integrate 
PayPal Donations with your website in a few easy steps. 
 
PayPal Account: Email address for your PayPal account. 
Button Image: Specifies the button image that will be displayed on your webpage. Select 'Custom 
Image' if you want to specify a custom image. 
Enable SandBox: PayPal provides a Sandbox to allow you to test your site without actually making 
payments. Uncheck this option when publishing the live version of your site! 
More information about the PayPal's sandbox: https://developer.paypal.com/ 
Target Window: Specifies the browser window where PayPal's website will be opened. Default: PayPal. 
Make this field empty if you want the PayPal website to open in the current window. 
 
Donation name/service: Enter a description for the donation. If you do not enter anything in this field, 
your customers can complete it.  
Donation ID/number: If you have an ID or tracking number for your item, enter it in the Donation 
ID/number field. This field will not be displayed to your customers at the time of the donation, but they 
will see it in their transaction details on the PayPal website. 
Currency: Choose the currency in which you would like this payment to be denominated. This field will 
default to the currency of your primary balance. 
Require shipping information: Specifies whether to prompt the customer for a shipping address. 
Allow customer note: Specifies whether to prompt the customer to include a note with the payment. 
 
Successful Payment URL: The URL to which the customer’s browser is returned after completing the 
payment; for example, a URL on your site that displays a “Thank you for your payment” page. If omitted 
the customer is taken to the PayPal website. 
Cancel Payment URL: A URL to which the customer’s browser is returned if payment is cancelled; for 
example, a URL on your website that displays a 
“Payment Canceled” page. If omitted the Browser is directed to the PayPal website. 
Buyer's Country: Defines the buyer’s language for the Login page only. 
 
More information: 
http://www.paypal.com/cgi-bin/webscr?cmd=p/xcl/rec/donate-intro-outside 

 

https://developer.paypal.com/
http://www.paypal.com/cgi-bin/webscr?cmd=p/xcl/rec/donate-intro-outside
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Ready to use Java Scripts 
This feature can be useful if you want to brighten up your web pages with some cool Java Scripts. Click 
'Insert JavaScript' and select one of the predefined scripts. Some of the scripts have properties to 
change the behavior of the script. To see the effect of the Java Script you will need to preview or publish 
the web page. 

 

Notes:  

 Most of these scripts were not created by the Quick ‘n Easy Web Builder team. Where possible 
the appropriate copyrights are displayed. 

 Depending on the configuration of the Internet browser some of these scripts might not work 
on all systems. 

 It is not recommended to use more than one Java Script per page.  
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RSS Feed 
What does RSS mean? 
RSS stands for Really Simple Syndication, and is used to describe the technology used in creating feeds. 
 
What is a feed (RSS)? 
Feeds, also known as RSS feeds, XML feeds, syndicated content, or web feeds, contain frequently 
updated content published by a website. They are usually used for news and blog websites, but are also 
used for distributing other types of digital content, including pictures, audio files, or video.  
At its most basic, RSS generates a list of links, to various resources on your site with a description of the 
content for each link. 
 
The contents of a RSS feed can be read in different ways. A variety of tools, both fee based and free, to 
read RSS feeds are available on the Internet. The latest browsers (Internet Explorer 9.0, Safari, FireFox 
4.0 and Opera) also have build-in RSS feed support. 
 
The RSS Feed object lets you define a RSS channel with a set of headlines. When you publish the web 
page, which includes the RSS extension, a RSS (XML) file will be generated in the same folder as the 
HTML page. A small RSS icon will be displayed on your web page with a link to this file. Some browsers 
will display a special icon in the toolbar, which lets the users easily subscribe to your RSS channel. 
 

Miscellaneous 

Description 
Phrase or sentence describing the channel. 
 
Filename 
The filename of the generated RSS xml file. By default, this file is named ‘rss.xml’, but you can rename it  
to anything you like. Common file extensions for feeds are .xml and .rss  
 
Head lines 
Use this property to add, edit or remove headlines. 
 
Include date 
To include the publication date in the RSS feed, enable this option. If you leave this option off, the 
publication date will not be included. 
 
Logo 
Specifies which logo will be displayed on the webpage. Select 'Use Custom Image' to specify your own 
image. 
 
Title 
The name of the channel. It is how users refer to your service.  
If you have an HTML website that contains the same information as your RSS file, the title of your 
channel should be the same as the title of your website.   
 
URL 
The URL to the HTML website corresponding to the channel. 
For example: http://www.yourwebsite.com. 
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Optional Information 

Category, Specify one or more categories that the channel belongs to.  
Example: Newspaper 
  
Copyright, Copyright notice for content in the channel.  
Example: Copyright 2015, Pablo Software Solutions 
 
Editor email, Email address for person responsible for editorial content 
Example: yourname@yourwebsite.com (Your Name) 
 
Image, Specifies a GIF, JPEG or PNG image that can be displayed with the channel. 
 
Language, The language the channel is written in. This allows aggregators to group all Dutch language 
sites, for example, on a single page. 
 
Refresh time, Specifies the number of minutes that indicates how long a channel can be cached before 
refreshing from the source. 
  
Webmaster, Email address for person responsible for technical issues relating to channel 
Example: webmaster@yourwebsite.com (Web Master) 
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News Feed Ticker 
The News Feed Ticker displays RSS feeds (local or from another website), Twitter messages, Flickr 
images, Myspace blogs or other news sources on your website. 
It has various display types: like static, scroller, slideshow, paginate. 
 
 

Note:  
You must publish your page to a web server otherwise the information will not be displayed due to 
security restrictions of the browser. 

 
 

Background 

Background Mode 
Specifies the background mode: Solid or Transparent. 
 
Background Color 
Specifies the color of the form background. If set to 'Automatic' the standard (system) button color will 
be used. 
 

Border 

Border Color 
Specifies the color of the border around the object.  
 
Border Style 
Specifies the style of the border: Dotted,Dashed, Solid, Double, Groove, Ridge, Inset or Outset. 
 
Border Width 
Specifies the width of the border around the object. Set this to 0 (zero) for no border. 
 

Miscellaneous 

Data source 
The news feed ticker supports many data source types. It uses jQuery to fetch the data. 

 User Defined 
This option allows you to specify the headlines manually. The News items section allows you to 
add, edit or remove items. 
 

 RSS Feed 
Select this if the data source is a RSS feed. This can be a feed on your own website or an 
external website. Enter the location of the RSS feed in the URL field. For local feeds (like the 
one created with the RSS feed object), enter ./rss.xml  
For feeds from external websites you should enter the full URL: 
http://www.yourwebsite.com/rss.xml 
 
To overcome security problems due to cross domain restrictions we've included several data 
retrieval options: 
- Load data using a HTTP GET request 
Use this option for feeds retrieved from your own domain. This option uses AJAX 
(Asynchronous JavaScript and XML) to fetch the data and doesn't required PHP. However AJAX 
requests cannot be made to a different site than the one hosting the page being viewed. 
 
- Load data through proxy  (this option requires PHP support on the server!) 
This option uses a PHP proxy script to fetch the data. This basically tricks the browser into 
thinking that the feed came from your own server. A PHP script will pull the content of the 
news feed to your server by using the PHP function file_get_contents() and then relay the data 
to the news feed ticker. This script will be automatically generated and uploaded by Quick 'n 
Easy Web Builder, so you do not have to worry about that.  

http://www.yourwebsite.com/rss.xml
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- Load data through cURL (requires PHP) 
Some web-hosting providers may not allow the use of the PHP file_get_contents() function to 
fetch remote files because of security concerns. If your host supports cURL then this may be a 
good alternative. Consult the documentation of your host for more details. Note that here also 
the PHP script will be automatically generated and uploaded by Quick 'n Easy Web Builder.  
 

 Twitter 
Uses JSON to get the latest messages from a specific Twitter account. 
 

 Flickr 
Displays images based on the specified Flickr search query. Enter the Flickr search query in the 
Flickr Parameters field. For example: tags=vegas&tagmode=any, which will search for the latest 
images tagged with 'vegas'  
 

 

Important information about Twitter:  
Recently Twitter has discontinued their unauthenticated v1.0 API. This means that it is no longer 
possible to get Twitter data without authentication. 
 
You now need API key authentication to display Tweets on your website: 
Visit https://dev.twitter.com/apps/ and sign in using your Twitter username and password. This doesn’t 
have to be the username or password of the stream you need access to, just a Twitter account you 
control. 
- Select ‘Create new application’ and enter the application details. The name and description can be 
anything you like, but you can’t use ‘Twitter’ in the name. The website field can be your main website 
and doesn’t have to be the site where your Twitter feed or feeds are located. 
- Callback URL can be left blank 
- Enter the CAPTCHA info and click create 
- On the next details screen, click ‘create my access token’. You may need to refresh the page after a few 
seconds if it doesn’t appear automatically. 
Make a note of the Consumer key, Consumer secret, Access token and Access token secret and use 
these values in the corresponding properties of the News Feed Ticker. 

 
 
Display Mode 
The display mode specifies how the head lines will be displayed: 

 Default 
The items will be displayed as a static list. If the list is longer than the available space, scrollbars 
will be added. 

 Continuous Scroll 
The items will be scrolled like a (vertical) news ticker. The scroller will pause on mouse over. 

 SlideShow 
The items will flow into view one at a time, pause for a few seconds and then slide up to show 
the next item. The 'Pause for' property specifies the pause between the head lines in seconds. 

 Ticker 
Uses ticker-like animations to fade and slide items into view. This effect is frequently used on 
new web sites. 

 

https://dev.twitter.com/apps/


Quick ‘n Easy Web Builder   

162 

Max items 
Specifies the maximum number of items that will be retrieved from the data source. 
 
Sort order 
Specifies the order in which the items will be displayed. 
 
Speed 
Specifies the scroll speed of the text for Continuous Scroll mode. 
 
Animation 
Specifies the animation effect for the slide show mode: None,  Fade,  Slide. 
 
Animation Duration 
Specifies the duration of the animation. 
 
Link Target 
Specifies the target for links in the news feed ticker. For example: _blank opens the link in a new 
window. 
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Site Search 

 

 
Quick ‘n Easy Web Builder has basic built-in 'search engine' functionality, so visitors can search for 
specific words within your website. The search option does not have any special server requirements 
because it uses JavaScript, so it's very easy to insert this component to your page(s). 
 
 

Note:  
Before you add this object to your page, make sure you have enabled 'Generate Search Index' in  
Menu->Tools->Search Index otherwise the search index will not be created and the search will not 
work!. 

 
 
Hint text 
The hint (or 'cue') text will displayed inside the search field if it doesn't have the focus.When the user 
moves their focus to the field, the label will be hidden. 
 
Enable auto complete 
The auto complete feature will allow users to type the beginning of a search term and be presented with 
all the possible terms that begin with the typed string (juts like the Google Search engine). 
 
No results 
Specifies the text that will be displayed if the search query has no results. 
 
Keywords 
The text for the Keyword label in the search results. 
 
Description 
The text for the Description label in the search results. 
 
Close button 
The text on the close button 
 
Display description 
Specifies whether to display the description in the search results. 
  
Display keywords 
Specifies whether to display the keywords in the search results. 
 
Padding 
Sets the amount of space between the results and the border. 
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Results 
The search results can be displayed on the page in several different ways: 
 

 Show results in a new Browser Window 
The results will be displayed in a new browser window. You can configure the properties of this 
windows via the 'Settings' button. 

 Show results in an Inline Frame 
The results will be displayed in an inline frame on the same page.  
Note that you will have to insert an  inline frame object first before you select its name in the 
Frame property. 

 Show results in another object. 
The results will the displayed inside another object (for instance a layer on the same page). It 
will replace the current content of that object. Make sure the overflow mode of that object is 
set to 'scroll' otherwise you may not see all results! 

 Show results in another page. 
You can use this option to display the results in another page. This can be useful if you want the 
results page to have the same design as the rest of your website. 
 
Step 1 
- Add a new page to the project (for example 'search_results'). 
- Add an inline frame to the new page. This is where the results will be displayed. 
- Add a 'Site Search' object. 
- Select 'Show results in an Inline Frame' 
Note that now you will also be able to search on the result page. 
 
Important: make sure that the Inline frame displays an initial page. Some browsers will not 
display the page if there is no content in the inline frame. For example: you can create a new 
internal page that displays some text like 'This area will display the search results'. Then set 
that page in the 'Link to' property of the Inline frame, so that page will initially be displayed. 
 
Step 2 
- Go back to the page you were working on. 
- Add a 'Site Search' object. 
- Select 'Show results in another page' 
- Click the 'Settings' and select the 'search_results' page. 
 

How to add a 'Search button' to the search field? 
Insert an advanced button 
Open the properties and select button type 'OnClick' 
Select OnClick action 'Execute javascript function' 
Enter 'searchPage()' in the OnClick Value field. 
 
Note that you can basically trigger the searchPage() function from any object supporting events. 
 
Tip:  If you have selected 'Show results in a new Browser Window' then you must specify the popup 
window settings in searchPage's arguments like this: 
 
searchPage('scrollbars=yes,resizable=yes') 
 
More details about the available arguments here: 
http://www.w3schools.com/jsref/met_win_open.asp 
  

http://www.w3schools.com/jsref/met_win_open.asp
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PHP Login Tools 
 

Important Note:  
The login tools are a set of advanced PHP forms and scripts. Please take your time to become familiar 
with tools. First read all available documentation and study the demo project before using them in your 
own project. 

 
Web Builder has a complete built-in (PHP) login system to password protect one or more pages. 
 

Key features: 
 Protect a page simply by dragging the Protect Page object to the page.  

 Login and Logout forms.  

 An Administrator section to add, edit or remove user accounts.  

 A Signup form to allow users to sign up for an account.  

 A Change Password form so users can change their password.  

 A Password Recovery form, to reset the user's password.  

 Custom profile fields. 

 Supports both MySQL and a plain text database.   

 No custom coding needed, everything is 'drag & drop'!  
 

Requirements: 
The login tools require a web server with PHP support, so the first step to start using the login tools of 
Quick ‘n Easy Web Builder is to check whether your web host supports PHP! 
 

Tip:  
We strongly advise to use only one form per page to prevent conflicts between the scripts. 

 
Convert to Form 
Most login forms include an option to convert the predefined/fixed form to a standard form (right click 
on the login form to display the context menu). This allows you to convert the static form into native 
qnewb objects so you can fully customize the layout and code if you like. 
Note that customizing the PHP code requires knowledge of PHP. Making changes to the code without 
knowing what you're doing will result in undefined behavior! 
 

Demo Project 

A fully functional example project is available here: 
http://www.quickandeasywebbuilder.com/support/logindemo.zip 
This project demonstrates how to use the Login tools of Quick ‘n Easy Web Builder. 
 
Please first take your time to study the demo project before including the login tools in your own 
project. The most common reason for the login tools not to work on a website is due to configuration 
mistakes of the user! 
 
Start by reading the information of the 'Getting started' page in project. 
To test the completely working example you must publish all pages to a web server with PHP support. 
Also don't forget to create the user database first!!! 
 
Related online tutorials: 
http://www.quickandeasywebbuilder.com/login_basics.html 
http://www.quickandeasywebbuilder.com/login_tools.html 
 
 
 

http://www.quickandeasywebbuilder.com/support/logindemo.zip
http://www.quickandeasywebbuilder.com/login_basics.html
http://www.quickandeasywebbuilder.com/login_tools.html
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User database 
A database is, generally speaking, a storing mechanism. The login tools can use either a flat file 
database, where all data (usernames, passwords etc) is stored in a text file (usersdb.php) on the server, 
OR a MySQL database. The flat file database is probably the easiest to setup and this is the default 
option. However MySQL is more secure and recommended for advanced users. 
  
The following login tools will use this database file: 

 Admin  

 Change Password  

 Login  

 Password Recovery  

 Signup  

 Edit Profile 
 

Tip:  
You should set the same database name for all login tools! 

 
Flat file database (text file) 
The login tools use a database file on the server to store the user information. 
The data will be stored in a semicolon separated text file or in MySQL. The passwords will be hashed 
using md5 so they will be securely saved. 
 
How do I manually create a user database on the server? 
A user database is basically just a text file on the server. 

1. Open a plain text editor and create an empty file named 'usersdb.php'. 
2. Upload the file to the same folder as your protected pages. To upload the file you can use then 

built-in FTP tool or any other FTP application. 
3. After the file has been uploaded you must modify the permissions so that the PHP script can 

write data to it. The correct permissions are 757 or 777. 
4. Alternatively you can use the file transfer tool of your host's control panel. There should be an 

option in your web hosting control panel to set write permissions. If it's not present, you may 
can contact your web hosting service and request the write permissions for the file. 

 
How do I prevent that user can view or download the user database from the server? 
By default the user database of the login tools can be accessed by anyone that knows the file name. And 
although the passwords are encoded the email addresses are not hidden.  
 
So the first thing you should do is to make sure you give the user database a unique name that can not 
easily be guessed.  
For example: A6gr8JDaTa.php 
 
To make the user database completely inaccessible you can create a .htaccess file in the folder on the 
server with the following content:  
 
<Files "usersdb.php">  

Order deny,allow  

Allow from xxx.xxx.xxx.xxx  

Deny from all  

</Files>  

 
where usersdb.php is the name of the database and xxx.xxx.xxx.xxx is your IP address.  
 
See also:  
http://www.javascriptkit.com/howto/htaccess.shtml 
 

http://www.javascriptkit.com/howto/htaccess.shtml
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MySQL database 
 
Using a MySQL database to store the user information (for advanced users only!) 
As alternative for the plain text user database you can also choose to store the users in a MySQL 
database. Each object has a special MySQL Database category, where you can configure the properties 
of the MySQL database. Before you can use this option you must create the table on the server. 
Log in to your MySQL administrator utility. Create the USERS table using this SQL query: 
 
CREATE TABLE `USERS` ( 

`id` int(10) NOT NULL auto_increment, 

`username` varchar(50) NOT NULL, 

`fullname` varchar(75) NOT NULL, 

`password` varchar(50) NOT NULL, 

`email` varchar(75) NOT NULL, 

`active` tinyint(1) NOT NULL, 

`code` varchar(75), 

PRIMARY KEY  (`id`) 

) ENGINE=MyISAM AUTO_INCREMENT=1; 

 
If you have added custom profile fields to any (or all) of the login objects then you must also create 
these fields in the database. Custom profile fields must be named extra1, extra2, extra3 etc! 
The following SQL query generates a table with 5 extra custom profile fields: 
 
CREATE TABLE `USERS` ( 

`id` int(10) NOT NULL auto_increment, 

`username` varchar(50) NOT NULL, 

`fullname` varchar(75) NOT NULL, 

`password` varchar(50) NOT NULL, 

`email` varchar(75) NOT NULL, 

`active` tinyint(1) NOT NULL, 

`code` varchar(75), 

`extra1` varchar(100), 

`extra2` varchar(100), 

`extra3` varchar(100), 

`extra4` varchar(100), 

`extra5` varchar(100), 

PRIMARY KEY  (`id`) 

) ENGINE=MyISAM AUTO_INCREMENT=1; 
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Admin 
The Administrator object allows you to add, edit or remove users from the user database online. 
To enable scrolling for a large list of users, the administrator form will be displayed inside an inline 
frame. 
  
Background Color 
Specifies the color of the background. 
 
Border Color 
Specifies color of the border around the object. 
 
Border Width 
Specifies width of the border around the object. 
 
Font 
Specifies the font used to display text in the object. 
 
Title Color 
Specifies the title color. 
 
Title Text Color 
Specifies the header text color. 
 
Text Color 
Color of the text. 
  
Admin Password 
Specifies the administrator's password. 
 
Custom Profile Fields 
This option can be used to add additional fields to the signup form. 
New fields can be of type' text' or 'option'. A text field adds a standard editbox ,while the option fields 
adds a combobox to give the user multiple choices. 
You can also mark a field as 'Required'. 
 
The 'Apply to All' button can be used to apply the custom profile fields to all Login tools within the 
project, so you do not have to manually synchronize them. 
 

Important Notes: 
All login tool objects in the project should have the same custom profile fields!  
When adding custom profile fields and you use a MySQL database then you must also add these fields to 
the database!  

 
Database 
Specifies the user database. This value will be ignored if you are using MySQL! 
 
Frame Name 
To enable scrolling for a large list of users, the administrator form will be displayed inside an inline 
frame. The 'Frame Name' property specifies the name of this inline frame. 
 
You can also 'break out' of the frame by linking directly to administrator script. For example if the frame 
name is 'loginadmin' then the URL will be  
./'loginadmin.php 
or 
http://www.yourdomain.com/loginadmin.php 
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Session timeout 
The administrator will be logged out automatically if the session is idle (based on the specified timeout). 
 
MySQL Database (for advanced users only) 
As alternative for the plain text user database you can also choose to store the users in a MySQL 
database. This requires you to create a new table on the MySQL Server. See User Database for more 
details. 
 
Enable MySQL 
Specifies whether to use a MySQL database 
 
MySQL Database 
Specifies the MySQL database name. 
 
MySQL Password 
Specifies the MySQL password. 
 
MySQL Server 
Specifies the MySQL database server. 
 
MySQL Table 
Specifies the MySQL table name. 
 
MySQL Username 
Specifies the MySQL username.
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Change Password  
The Change Password object allows users to change their password. The user must be logged in to be 
able to change the password. 
 

Important Note:  
The page must have the File Extension 'php' ! You can change the file extension in the Page Properties. 

 
Layout 

 Fixed 
All form input fields will have a fixed size. This is the layout as used in previous versions of the 
Quick ‘n Easy Web Builder. 

 Responsive 
In this mode form input fields have 100% width (instead of a fixed size), so the form can have a 
different size in breakpoints. 

 
Background Color 
Specifies the color of the background. 
 
Border Color 
Specifies border color. 
 
Border Width 
Specifies border width. 
 
Button 
Specifies the text to be shown for the button. 
 
Confirm Password Error 
Specifies the text to be shown when the password and confirm password do not match. 
 
Confirm Password Label 
Specifies the text that identifies the confirm password text box. 
 
New Password Invalid Error 
Specifies the text to be shown when the new password is invalid. 
 
New Password Label 
Specifies the text that identifies the new password text box. 
  
Not Logged In Error 
Specifies the text to be shown when the user is not logged in. 
 
Old Password Invalid Error 
Specifies the text to be shown when the old password is invalid. 
 
Password Label 
Specifies the text that identifies the password text box. 
 
Spacing 
Specifies the spacing between controls. 
 
TextColor 
Specifies text color. 
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Title Back Color 
Specifies background color of the title. 
 
Title Color 
Specifies text color of the title. 
 
Title  
Specifies the text shown for the title. 
 
Database 
Specifies the user database. This value will be ignored if you are using MySQL! 
 
Destination Page 
Specifies the page that the user is directed to upon successful login. 
 
MySQL Database 
As alternative for the plain text user database you can also choose to store the users in a MySQL 
database. This requires you to create a new table on the MySQL Server. See User Database for more 
details. 
 
Enable MySQL 
Specifies whether to use a MySQL database 
 
MySQL Database 
Specifies the MySQL database name. 
 
MySQL Password 
Specifies the MySQL password. 
 
MySQL Server 
Specifies the MySQL database server. 
 
MySQL Table 
Specifies the MySQL table name. 
 
MySQL UserName 
Specifies the MySQL username.
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Login  
The Login object provides a standard form to login to the protected pages. 
 

Important Note:  
The page must have the File Extension 'php' ! You can change the file extension in the Page Properties. 

 
Layout 

 Fixed 
All form input fields will have a fixed size. This is the layout as used in previous versions of the 
Quick ‘n Easy Web Builder. 

 Responsive 
In this mode form input fields have 100% width (instead of a fixed size), so the form can have a 
different size in breakpoints. 

 
Background Color 
Specifies the color of the background. 
 
Border Color 
Specifies border color. 
 
Button Text 
Specifies the text to be shown for the button when the ButtonType property is set to 'Button' or 'Link'. 
 
Password Label  
Specifies the text that identifies the password text box. 
 
Remember Me 
Specifies the text to be shown for the remember me checkbox. 
 
Spacing 
Specifies the spacing between controls. 
 
Title Back Color 
Specifies background color of the title. 
 
Title Color 
Specifies text color of the title. 
 
Title Text 
Specifies the text shown for the title. 
 
Username Label Text 
Specifies the text that identifies the user name textbox. 
 
Database 
Specifies the user database. This value will be ignored if you are using MySQL! 
 
Destination Page 
Specifies the page that the user is directed to upon successful login. 
 
Error Page 
Specifies the page that the user is directed to upon failed login. 
 
Display Remember Me 
True if the remember me checkbox is displayed. 
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Logout 
The Logout object gives the user the option to login. 
 

Important Note:  
The page must have the File Extension 'php' ! 
You can change the file extension of a page in the Page Properties. 

 
Layout 

 Fixed 
All form input fields will have a fixed size. This is the layout as used in previous versions of the 
Quick ‘n Easy Web Builder. 

 Responsive 
In this mode form input fields have 100% width (instead of a fixed size), so the form can have a 
different size in breakpoints. 

 
Background Color 
Specifies the color of the background. 
 
Border Color 
Specifies border color. 
 
Border Width 
Specifies border width. 
 
Font 
Specifies the font used for text within the object. 
 
Button Text 
Specifies the text to be shown for the button. 
 
Text Color 
Specifies text color. 
 
Logout Page 
Specifies the page that the user is directed to upon log out. 
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Password Recovery 
The Password Recovery object allows users to reset their password. 
An email message will be send with the new (random) password. 
If the user wants to change the password, he can use the Change Password form. 
 

Important Note:  
The page must have the File Extension 'php' ! You can change the file extension in the Page Properties. 

 
Layout 

 Fixed 
All form input fields will have a fixed size. This is the layout as used in previous versions of the 
Quick ‘n Easy Web Builder. 

 Responsive 
In this mode form input fields have 100% width (instead of a fixed size), so the form can have a 
different size in breakpoints. 

 
Background Color 
Specifies the color of the background. 
 
Border Color 
Specifies border color. 
 
Button Text 
Specifies the text to be shown for the button. 
 
Spacing 
Specifies the spacing between controls. 
 
Title Back Color 
Specifies background color of the title. 
 
Title Color 
Specifies text color of the title. 
 
Title Text 
Specifies the text shown for the title. 
 
Email Label 
Specifies the text that identifies the user name textbox. 
 
Database 
Specifies the user database. This value will be ignored if you are using MySQL! 
 
Success Page 
Specifies the page that the user is directed to after the action has succeeded. 
 
Email From 
Specifies the from email address. 
 
Email Message 
Specifies the email message. 
 
Email Subject 
Specifies the email subject. 



Quick ‘n Easy Web Builder   

175 

Protected Page 
To protect any page from your website, simply drag & drop the 'Protected Page' object to the page.  
If the user is not logged in he will be redirected to the 'Access Denied Page'. 
 

Important Note:  
The page must have the File Extension 'php' ! You can change the file extension in the Page Properties. 

 
Access Denied Page 
Specifies the page that the user is directed to if not logged on. 
 
Allow Users 
Specifies the users who can access the page. You can enter a list of comma-delimited users: 
Bill,Steve,Gary 
If you leave this property empty, then all registered users can access the page.
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Signup  
The Signup object allows users to signup for a new user account. 
The new account will be created immediately after the user has completed the form. 
An email message will be send to the specified email address with the login details. 
 
Note that anyone can create an account, so use this object only for public pages! 
 

Important Note:  
The page must have the File Extension 'php' ! You can change the file extension in the Page Properties. 

 
Layout 

 Fixed 
All form input fields will have a fixed size. This is the layout as used in previous versions of the 
Quick ‘n Easy Web Builder. 

 Responsive 
In this mode form input fields have 100% width (instead of a fixed size), so the form can have a 
different size in breakpoints. 

 
Background Color 
Specifies the color of the background. 
 
Border Color 
Specifies border color. 
 
Border Width 
Specifies border width. 
 
Button Text 
Specifies the text to be shown for the button. 
 
Captcha Enabled 
Specifies whether CAPTCHA should be enabled.  
  
Captcha Label 
Specifies the text that identifies the CAPTCHA field. 
 
Confirm Password Error 
Specifies the text to be shown when the password and confirm password entered by the user do not 
match. 
 
Confirm Password Label 
Specifies the text that identifies the confirm password text box. 
 
Email Invalid Error 
Specifies the text to be shown when the email address entered by the user is invalid. 
 
Email Label  
Specifies the text that identifies the email text box. 
 
Font 
Specifies the font used for text within the object. 
 
Fullname Invalid Error 
Specifies the text to be shown when the full name entered by the user is invalid. 
 
Fullname Label 
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Specifies the text that identifies the full name text box. 
 
Password Invalid Error 
Specifies the text to be shown when the password entered by the user is invalid. 
 
Password Label 
Specifies the text that identifies the password text box. 
 
Spacing 
Specifies the spacing between controls. 
 
Text Color 
Specifies text color. 
 
Title Back Color 
Specifies background color of the title. 
 
Title Color 
Specifies text color of the title. 
 
Title Text 
Specifies the text shown for the title. 
 
Username Already Used Error 
Specifies the text to be shown when the username already exists. 
 
Username Invalid Error 
Specifies the text to be shown when the username entered by the user is invalid. 
 
Username Label  
Specifies the text that identifies the user name text box. 
 

 
Behavior  
Account activation 
Specifies whether to enable account activation by the administrator. If this option is 'Administrator', 
new accounts will not be activate until the administrator enables them. 
If this option is "Automatic' then the account will be enabled immediately after the user has completed 
the form.  
If the ‘Email’ verification option is selected then the user must activate the account via a link in the 
confirmation email before it will be activated. This makes sure the specified email is valid. 
 

Tip: 
If you enable email verification then you probably want to include some instructions in the email 
message to tell the user to use the activation link in the message to activate the account! 
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Custom Profile Fields 
This option can be used to add additional fields to the signup form. 
New fields can be of type' text' or 'option'. A text field adds a standard editbox ,while the option fields 
adds a combobox to give the user multiple choices. You can also mark a field as 'Required'. 
 
The 'Apply to All' button can be used to apply the custom profile fields to all Login tools within the 
project, so you do not have to manually synchronize them. 
 

Important Notes: 
All login tool objects in the project should have the same custom profile fields!  
When adding custom profile fields and you use a MySQL database then you must also add these fields to 
the database!  

   
Database 
Specifies the user database. This value will be ignored if you are using MySQL! 
 
Success Page 
Specifies the page that the user is directed to after the action has succeeded. 
 
Verificated Page 
Specifies the page that the user is directed to after email verification. This value will only be used if 
Account activation is set to 'Email'! 
 

Email  
Admin Email Address 
Specifies the email address of the administrator. This can be left empty. 
A copy of the signup confirmation email will be send to this address. 
 
Email From 
Specifies the from email address. 
  
Email Message 
Specifies the email message. 
 
Email Subject 
Specifies the email subject. 

 

Edit Profile 
The Edit Profile object allows a user to edit his/her account settings. The user must be logged on to be 
able to access the profile. 
 
This object is very similar to the Sign Up object and most properties are the same. 
 
 



Quick ‘n Easy Web Builder   

179 

jQuery Accordion 
The jQuery Accordion object is named after the musical instrument, in the way the expansion of one 
area leads to the contraction of another. Typically, accordions are fixed so that only of the areas is be 
visible at same time. This object is based on the Accordion Widget of the jQuery UI library: 
http://jquery.com/.  
 
Adding objects to the Accordion's Panels 
You can easily add objects to the accordion panels by dragging them on the component. This works the 
same way as for layers or forms. To be able to drag & drop objects to the accordion first make sure it's 
large enough so the objects can be dragged on it (the accordion object should be larger than the object 
you're adding!). A blue border around the panel will indicate that the dragged object will become part of 
the accordion. To add items to another panel simply click the header to make it active. 

 
Style 
The look and feel of this object is defined by the jQuery UI theme. You can set the theme for the all 
jQuery UI widgets in Page Properties->jQuery UI Theme. Themes can be created/edited with the built-in 
Theme Manager. 
 
The Font name and Font Size properties can be used the override the default font of the theme. 
 
Header count 
Specifies the number of headers in the accordion. 
 
Header labels 
Specifies the label for each header in the accordion. 
 
Padding 
The padding properties control the text padding of the headers. 
 
Icon Index 
Specifies the icon that will be used in the header. 
 
Icon Offset 
The expand/collapse icon offset can be with Icon Offset. 
 
Animation 
The Animation property enables the slide animation for hiding and showing panels. 
 
Activate on Mouseover 
Activate on Mouseover can be enabled to change the active panel on mouse over instead of the 
standard mouse click.  

http://jquery.com/
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jQuery Auto Complete 
AutoComplete can replace a standard editbox. It enables users to quickly find and select from a pre-
populated list of values as they type. The list can be either local or from a remote location (AJAX). 
This object is based on the Auto Complete Widget of the jQuery UI library: http://jqueryui.com/ 

 
 

General 
Data Source 
Specifies the source for the auto complete items. 

 Local 
Uses an local array as the data source. The items can be added, edited or removed by using the 
'Add', 'Edit and Remove' buttons. 

 Remote 
Select this option if you want to get the data from an external data source, like a database. You 
must also specify the URL in this case. This option is for advanced user only! 

 
Delay 
The delay in milliseconds Autocomplete waits after a keystroke to activate itself. A zero-delay makes 
sense for local data (more responsive), but can produce a lot of load for remote data, while being less 
responsive. 
 
Min Length 
The minimum number of characters a user has to type before Autocomplete activates. Zero is useful for 
local data with just a few items. It should be increased when there are a lot of items, where a single 
character would match a few thousand items. 
 
Data 
If the data source is local, then you must specify the auto complete data in this list. Use the 'Import' 
button to select from a predefined list of item or import the items from an external file where each item 
must be on a new line. 
 
URL 
When a remote data source is used, the Autocomplete object expects that the page returns JSON data.  
It can be on the same host or on a different one (must provide JSONP).  The request parameter "term" 
gets added to that URL. More details are available on the jQuery website: 
http://jqueryui.com/demos/autocomplete/ 
 
All other properties are the same as for the Editbox object. 
 
Tip: If the dropdown menu is behind other content then you can place this code between the <head> 
tags of the page (in Page HTML):  
 
<style> 

.ui-autocomplete { z-index:999 !important; } 

</style> 

http://jqueryui.com/demos/autocomplete/
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jQuery Button 
The jQuery Button enhances standard button (normal, submit, reset or anchor/link) to themable 
buttons with appropriate mouseover and active styles. The button can be used as a submit button on a 
form or as a stand-alone button for navigation. The Button type property determines the behavior of 
the button. 
 

 
 
General 
Name 
Name of the button. 
 
Value 
Caption of the button. 
 
Button Type 

 Submit 
When activated, a submit button submits a form.  

 Reset 
When activated, a reset button resets all controls to their initial values.  

 Normal 
Normal (Push) buttons have no default behavior. Each push button may have client-side scripts 
associated with the element's event attributes. When an event occurs (e.g., the user presses 
the button, releases it, etc.), the associated script is triggered.  

 Link Button 
If this button type is selected the button will act as a navigation button/link. You can specify the 
link properties in the 'Link' page. 

 Checkbox 
The button will act as a checkbox, so it can be used as a relacement for the standard checkbox 
element in forms.  

 Radio Button 
The button will act as a radio button, so it can be used as a relacement for the standard radio 
button element in forms. Give multiple buttons the same name to make them part of a group. 

 
Access Key 
This attribute assigns an access key to the object. An access key is a single character. 
Pressing the access key gives focus to the element. 
 
Disabled 
The disabled option disables the control for user input.  
 
Tab Index 
Specifies the tab index of the button (in a form). 
 

Style 
The look and feel of this object is defined by the jQuery UI theme. You can set the theme for all jQuery 
UI widgets in Page Properties->jQuery UI Theme.  
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jQuery DatePicker 
The jQuery DatePicker offers a sophisticated and featrure-rich UI component for inputting dates into a 
form. The object provides a graphical calendar that pops up if you click inside the form field. 
 
The jQuery DatePicker is based on the DatePicker Widget of the jQuery UI library: http://jquery.com/ 
The appearance of the jQuery DatePicker object is customizable through ThemeRoller themes. 
 

 
 
Use current date 
This will automatically set the initial value to the current date. 
 
Date format 
The format for parsed and displayed dates.  For a full list of the possible formats see the formatDate 
function: 
http://docs.jquery.com/UI/Datepicker/formatDate 
 
Change month 
Specifies whether the user can change the month by selecting from a drop-down list. 
 
Change year 
Specifies whether the user can change the year by selecting from a drop-down list. 
 
Show button panel 
Specifies whether to show the button panel. 
 
Mode 

 Overlay 
An editbox is displayed. If the edit box gets the input focus, then a graphical calendar pops up 
to select the date.  

 Inline 
The calendar will be visible on the page all the time.  

 Flexible 
This option makes the date picker size flexible, so it can have different sizes in different 
breakpoints. 

 

Style 
The look and feel of this date picker is defined by the jQuery UI theme. You can set the theme for all 
jQuery UI widgets in Page Properties->jQuery UI Theme. 
 
 

http://jquery.com/
http://docs.jquery.com/UI/Datepicker/formatDate
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jQuery Dialog 
A dialog is a floating window that contains a title bar and a content area. You can drag & drop objects to 
the dialog to make then part of the window. The jQuery Dialog is based on the Dialog Widget of the 
jQuery UI library: http://jquery.com/ 
 
You can easily add objects to the dialog by dragging them on the component. This works the same way 
as for layers or forms. 

 
Style 
The look and feel of this object is defined by the jQuery UI theme. You can set the theme for all jQuery 
UI widgets in Page Properties. Themes can be created/edited with the built-in Theme Manager. 
 
The Font name and Font Size properties can be used the override the default font of the theme. 
 
Title 
Specifies the title of the dialog. 
 
Icon Offset 
The 'Close' icon offset from the right side of the header can be with Icon Offset. 
 
Show animation 
Specifies the effect to be used when the dialog is opened. 
 
Hide animation 
Specifies the effect to be used when the dialog is closed. 
 
Horizontal alignment 
Specifies where the dialog should be displayed: ‘left’, ‘center’, ‘right’. 
Select ‘Absolute position’ to use the current x position in the workspace. 
 
Vertical alignment  
Specifies where the dialog should be displayed: ‘top’, ‘center’, ‘bottom’. 
Select ‘Absolute position’ to use the current y position in the workspace. 
 
Modal  
If enabled, the dialog will have modal behavior; other items on the page will be disabled (i.e. cannot be 
interacted with). Modal dialogs create an overlay below the dialog but above other page elements. 
 
Resizable  
If enabled, the dialog will be resizable. 
 

http://jquery.com/
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Draggable  
If enabled, the dialog will be draggable by the titlebar. 
 
Close on escape  
Specifies whether the dialog should close when it has focus and the user presses the escape (ESC) key. 
 
Show dialog automatically 
When this option is enabled the dialog will open automatically when dialog is called. Otherwise it will 
stay hidden until .dialog("open") is called on it. 
 
Q: How can I show or hide the dialog via JavaScript? 
A: It’s very easy to show or hide the dialog from JavaScript. 
Add the dialog widget to your page. 
Take note of the ID. The default value is ‘dialog’. 
Add an image, shape or other obejct with event support to the page. 
Open the properties and select the ‘Events’ tab. 
Click ‘Add’ to insert a new event. 
Select ‘Event’: OnClick and set the ‘Action’ to JavaScript function. 
To show the dialog enter this JavaScript:  
$(‘#dialog’).dialog(‘open’); 
where dialog is the ID of the dialog. 
 
To hide the dialog enter this JavaScript:  
$(‘#dialog’).dialog(‘close’); 
 
… or you can simply use the Show and Hide event actions! 
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jQuery Menu 
Themeable (multi level) menu with mouse and keyboard interactions for navigation. 
 
The jQuery Menu object is based on the Menu Widget of the jQuery UI library: http://jqueryui.com/ 
 

 
 
Items 
elect Add to insert a new item to the menu. Select Edit to modify the properties of an existing item. 
To remove an item from the menu select Remove. 
 
Layout 
The Menu Bar can be either Vertical or Horizontal. 
 
Orientation 
Identifies the position of submenus in relation to the associated parent menu item.  
 
Menu mode 
In 'Standard menu' mode the menu will be displayed at the same position as in design mode. 
In 'Context menu' mode the menu will behave as a context menu. The menu will be displayed on right 
click at the current mouse position. 
 

Style 
The look and feel of this object is defined by the jQuery UI theme. You can set the theme for all jQuery 
UI widgets in  Page Properties->jQuery UI Theme. Themes can be created/edited with the built-in 
Theme Manager. 
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jQuery Tabs 
Tabs can be used to break content into multiple sections that can be swapped to save space, much like 
the accordion. The jQuery Tabs object is based on the Tabs Widget of the jQuery UI library: 
http://jqueryui.com/ 
 
You can easily add objects to the tab panels by dragging them on the component. This works the same 
way as for layers or forms. To add items to another panel simply click on the tab header to make it 
active. 

 
 

Style 
The look and feel of this object is defined by the jQuery UI theme. You can set the theme for all jQuery 
UI widgets Page Properties->jQuery UI Theme. Themes can be created/edited with the built-in Theme. 
 
The Font name and Font Size properties can be used the override the default font of the theme. 
 
Tab Count 
Specifies the number of tabs. 
 
Tab Labels 
Specifies the labels of the tab items. 
 
Sortable 
If the Sortable property is enabled then the user can sort the tabs dynamically using drag & drop, a cool 
feature of jQuery;) 
 
Activate On Mouseover 
Enable this option to change the active tab on mouse over instead of the standard mouse click. 
 
Collapsable 
Enable Collapsable to allow an already selected tab to become unselected again upon reselection.  
 
Layout Mode 
The Layout mode can be used to give the tab widget a different appearance. 

 Tabs at the bottom 
Specifies whether to display the tabs below the content instead of on top.  
Note that this option is experimental, it's not an official feature of the jQuery Tab widget. 

 Remove header background 
This option removes the background decoration of the header 

 Remove entire header 
This option removes the entire header.  

 Tabs like button 
Use buttons instead of tabs  
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jQuery Progressbar 
The progress bar is designed to simply display the current % complete for a process. For example as part 
of a customized upload script or to display the status of an Online Survey. The range of the progressbar 
is from 0 to 100. 
 
The jQuery Progressbar object is based on the Progressbar Widget of the jQuery UI library: 
http://jqueryui.com/ 
 
 

Note:  
The  value of progressbar is usually updated through JavaScript. It does not do anything by itself! 

 
Value 
Specifies the initial value of the progressbar. Typically this is '0'. 
 
Indeterminate 
Enable this option to display an (animated) indeterminate progress bar. 
 

Style 
The look and feel of this object is defined by the jQuery UI theme. You can set the theme for all jQuery 
UI widgets in Page Properties->jQuery UI Theme. Themes can be created/edited with the built-in Theme 
Manager. 
 
 

Example 
Here is an example how to update the value of the progressbar through JavaScript. 
 
1. Add the progressbar widget to your page.  
2. Take note of the ID. The default value is ‘jQueryProgressbar1’.  
3. Add an image, shape or other object with event support to the page.  
4. Open the properties and select the ‘Events’ tab.  
5. Click ‘Add’ to insert a new event.  
6. Select ‘Event’: OnClick and set the ‘Action’ to JavaScript function.  
 
To update the value (0 - 100) of the progressbar the following code 
 
$('#jQueryProgressbar1').progressbar('option', 'value', 75); 
 
where jQueryProgressbar1 is the ID of the progressbar. 
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jQuery Slider 
The slider widget represents a value that is selected by dragging the thumb along the background. 
It's a simple widget, comprised of two main elements: the slider handle (also called the thumb) and the 
slider background. The jQuery Slider object is based on the Slider Widget of the jQuery UI library: 
http://jqueryui.com/ 
 

Note:  
The  value of progressbar is usually updated through JavaScript. It does not do anything by itself! 

 
Orientation 
Specifies whether the slider has the min at the left, the max at the right (= horizontal) or the min at the 
bottom, the max at the top (= vertical). 
 
Animation 
Specifies whether to slide handle smoothly when user click outside handle on the bar.  
 
Value 
Specifies the initial value of the slider. 
 
Minimum Value 
Specifies the minimum value of the slider.  
 
Maximum Value 
Specifies the maximum value of the slider. 
 
Range 
Changes the appearance of the slider. A min range goes from the minimum value to the handle. A max 
range goes from the handle to the maximum value.  
 
Height/Width 
Specifies the height (if the orientation is horizontal) or width (if the orientation is vertical) of the slider 
background. 
 
Handle Width 
Specifies the width of the slider handle. 
 
Handle Height 
Specifies the height the slider handle. 
 

Style 
The look and feel of this object is defined by the jQuery UI theme. You can set the theme for all jQuery 
UI widgets in Page Properties->jQuery UI Theme. Themes can be created/edited with the built-in Theme 
Manager. 
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Events 
Events can be used to update other parts of the page based on the current state of the slider. 
 
The following events are supported: 
slidestart 
This event is triggered when the user starts sliding. 
 
slide 
This event is triggered on every mouse move during slide.  
Use ui.value to obtain the value of the current handle.  
 
slidechange 
This event is triggered on slide stop, or if the value is changed programmatically (by the value method).  
 
slidestop 
This event is triggered when the user stops sliding. 
 
action 
Specifies the action to be taken when the event is triggered. 

 Set value, sets the value of a form element (for example editbox, button or textaera)  

 Custom code. Here you can implement your own code that will be inserted inside the callback 
function. 
 
function(event, ui)  

{ 

 // your custom code will be inserted here... 

}); 

 
Use ui.value to obtain the value of the handle. 
 
Example: 
$("#Editbox1").val(ui.value); 

 
 

Example 
Here is an example how to update the value of an editbox. 
 
1. Add an Editbox to the page.  
2. Take note of the ID. The default value is ‘Editbox1’.  
3. Add the slider widget to your page.  
4. Open the properties of the Slider and select the ‘Events’ tab.  
5. Click ‘Add’ to insert a new event.  
6. Select ‘Event’: slidechange and set the ‘Action’ to Set Value.  
7. In Target select the editbox ('Editbox1'). 
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jQuery Spinner 
Enhance a text input for entering numeric values, with up/down buttons and arrow key handling. 
Note that this object is normally used on a form as a replacement for the standard editbox. 
 
The jQuery Spinner object is based on the Spinner Widget of the jQuery UI library: http://jqueryui.com/ 
 

 
 
Name 
Enter an identifier for the field. 
 
Value 
Value that is initially display in the field. 
 
Minimum Value 
The minimum allowed value. 
 
Maximum Value 
The maximum allowed value. 
 
Steps 
The size of the step to take when spinning via buttons. 
 
Incremental 
Controls the number of steps taken when holding down a spin button. 
When set to true, the stepping delta will increase when spun incessantly. When set to false, all steps are 
equal (as defined by the step option). 
 
Disabled 
The disabled option disables the control for user input.  
Disabled controls do not receive focus.  
Disabled controls are skipped in tabbing navigation.  
The value of disabled controls will not be submitted with the form. 
 
Access Key 
This attribute assigns an access key to the object. An access key is a single character. 
Pressing the access key gives focus to the element. 
 
Tab Index 
All elements (except hidden elements) in a form are part of the form's tab order.  
When the user presses the Tab key, the browser shifts the input focus from element to element in order 
the elements appear in the HTML code.  
However, sometimes you want the tab order to flow a little differently. In that case, you can number the 
fields using tabindex attribute. 
Usually the first tabindex start on with value '1'. To exclude an element from the tab order, set the value 
of tabindex to 0. In that case the element is skipped when the user tabs around the form. 
 
Title 
Specifies the tooltip displayed by the browser. 
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jQuery Tooltips 
Customizable, themeable tooltips, replacing native tooltips. The tooltip supports text formatting and can 
be assigned to any Web Builder object.   
 
The jQuery Tooltips object is based on the Tooltips Widget of the jQuery UI library: http://jqueryui.com/ 
 
 

 
 

General 
Object ID 
Specifies the ID of the associated object. The tool tip will be displayed when the user hovers over the 
specified object. You can find the ID of an object in the (ID) property. 
 
Animation 
Specifies the animation that is used to show/hide the tooltip: None, Fade or Slide. 
 
Track the mouse 
Specifies whether the tooltip should track (follow) the mouse. 
 
Content 
Specifies the context (text) of the tooltip. The text can be formatted by using the style tools. 
 
Position 
Identifies the position of the tooltip in relation to the associated parent object. 
  
 

Style 
The look and feel of this object is defined by the jQuery UI theme. You can set the theme for all jQuery 
UI widgets in Page Properties->jQuery UI Theme. Themes can be created/edited with the built-in Theme 
Manager. 
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Publish your website 
You can publish your web pages using the build-in Publish tool. 
Select File->Publish to launch the publish dialog. 
 
There are two ways to publish your pages: 

1. Publish to a local folder. 
2. Publish to a remote FTP server. 

  

Publish to a local folder 
Click Add to add a new location to the list. 
Enter a name for the location a select Local as type.  
 

 
 
Enter the folder where you want to publish the active document. 
Click OK to save the data and then click Publish to save the files to the specified folder. 
If you do not want, to copy images or other components along with the HTML file,  
select the Only publish HTML files option. Otherwise, all images, movies, scripts etc. will be copied the 
same folder. 
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Publish to a remote FTP server 
Click Add to add a new location to the list. 
 

 
 
Enter a name for the location a select Remote/FTP Server as type and fill in the following fields: 
Host 
The Host Address field contains the location of the FTP server. 
You can either specify a URL or IP address. 
Port 
The default Port of a FTP connection is 21, but if necessary you can configure something else. 
PASV mode 
PASV mode is useful for certain types of firewalls that do not allow FTP servers to initiate data 
connections back to the connected client.  
Username 
This is where you enter the username of the FTP account that allows you to logon to the FTP Server (also 
see anonymous setting). 
Password 
Enter the password of the FTP account. 
Remote Folder 
Specifies the folder on the FTP server where the files are uploaded. The default is your root directory. 
Common remote folders locations are: 
/www 
/public_html 
/html 
 

Important note:  
Unfortunately this value is different for each webhost, so please consult your webhost's documentation 
for more details. 

 
Test Connection 
This command can help you determine if the specified hostname, username and password are correct. 
It also verifies if your firewall allows the connection to the server. 
 
The 'Explore' button in publish settings give you access to your published files. Clicking this button will 
launch the Built-in FTP Client to manage your online files.  
The built-in FTP client also introduces an easy way to find the remote publish folder. Simply login to your 
account, browse to the folder and click ‘Make Home’. Quick ‘n Easy Web Builder will now use that folder 
as the root of your website! 
 
To modify the permissions of any file or folder. Select the file/folder and click the 'Permissions' button. 
This feature is only supported on UNIX based servers. 
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Pages to Publish 
Select which page or pages you want to publish. 

 Entire Web Site 
Publishes all pages of the web site (except the pages which have enabled 'Don't Publish this 
Page' in Page Properties) 

 Select Page Only 
Publishes the select page, click Select to specify the page to be published. 

 Select Page and Sub Pages 
Publishes the select page and all of its sub pages (if any). 

 

Files 
Specifies which files will be published. 

 Publish all files 
All files of the selected page(s) will be published  

 Publish HTML files only 
Select this option if you do not want to upload images or other components along with the 
HTML file. 

 Publish files of modified objects only 
Select this option if you only want to publish files of object sthat were modified since the last 
time you published your web site. What exactly gets published depends on the changes you've 
made. For example, if you've only changed the position of an object, then only the HTML file 
was changed, but if you've changed the size of a shape, then the shape image needs to be 
regenerated and therefore the HTML and the image file will be published. 
Note that this option does not compare local files and files on the server, because that would 
take too long. Instead it checks whether an object was modified since the last publish. If you 
changed one or more properties of an object then all files for that object will be published. 
For small changes this will reduce the number of publish/uploaded files. 
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Where do I publish my website to? 

To make your web pages available for other users you have to publish them to a web server. There are 
lots of hosting companies available, for example: 
http://www.1and1.com  
http://www.tripod.com  
http://www.free-webhosts.com  
 
Make sure you choose a web host, which supports FTP, which makes it much easier to publish your 
pages from Web Builder. Once you have registered to a web host, you will receive a server address, 
username and password.  Enter this information into Web Builder by selecting: File->Publish. Click Add 
and select Type Remote. Sometimes you also need to specify a remote folder like 'public_html'.  if you 
have a firewall/router select 'Use passive mode for transfers'.  Click OK to save.  Now you can publish 
each page simply by selecting Publish. If you want to view the results of the file transfer, you can view 
the log file via: Tools->Options->Publish->View Log.  
 
 

How to publish on host that offer free web hosting that do not support FTP?  

Instead of publishing your web pages directly via FTP, you can also publish your pages to a local folder. 
Click Add and select Type Local.  
Enter a Name and specify a location using the browse (..) button.  
Click OK to save.  
Now if you press the Publish button, the files will be generated to the local folder.  
Next select all the files in the local publish folder and upload them using the File Manager of your web 
host (e.g. geocities, yahoo...).  
 

How do I verify that my publish settings are ok? 

Use the 'Test' button in the publish settings. 
This command can help you determine if the specified host name, user name and password are correct. 
It also verifies if your firewall allows the connection to the server. Note however that it does not verify if 
data can be transferred. You will have to test that by using the 'Explore' option. 
 

What value do I use for the remote folder? 

The remote folder is the root of your website. This location is usually determined by the web host. 
Common values are 'public_html', 'www', or 'html', but basically it can be anything. 
Consult the documentation of your host for more details. 
 
Alternatively you can try the following to determine the root: 

1. In the publish settings select 'Explore', this will login to your website. 
2. Look for the file 'index.html', if it's not in the current folder and try other folder. 
3. If you found the file, click 'Make Home'. Quick ‘n Easy Web Builder now set the current folder as 

the root of the website. 
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Publish failed. What has happened? 

 Are you sure your publishing setting are ok? Please double check your settings. 

 Did you try 'test connection'? If you cannot connect there may be a problem with your firewall 
settings. 

 Can you login to your website with the "Explore' option? 

 If 'Test' works but you cannot explore your website then this may be a problem in your firewall 
settings. 

 Also try to enable or disable 'passive mode'. 
 
Other common reasons for publishing failures: 

 website space is full -> remove unneeded files from the server. 

 there is a (temporary) problem with the host. Try again later or contact the host to report the 
problem. 

 the files (images, mp3, video) are too large -> upload the file manually or reduce their size. 

 one or more file names are invalid. Names must contain only ASCII letters (a-z,A-Z), digits (0-9), 
underscore, dot and dash. Names must not start with a dot (.) or dash (-). 

 
Enable the publish log in Menu->Tools->Options->Publish and make note of the error message. 
The log will be created the next time you publish! The publish log will be generated in your documents 
folder: /Library/Application Support/Quick ‘n Easy Web Builder/publish.txt 
 

All of a sudden publishing no longer works:( 

If you did not change anything to your configuration then this is most likely caused by a (temporary) 
problem on the server. 
Try again later or contact the host to report the problem. 
 

Publish was successful but I do not see the pages on my website. 

 Did you publish the pages to the correct folder on the server? Are you sure? The number one 
reason for pages not showing up is because the files were published to the wrong folder. 

 Did you make sure your home page is called 'index' (and not 'Index', 'INDEX', 'home' etc) 

 Is your host account ok? Did you check if there are problems with the host? 

 If you website doesn't look to be updated, select 'Refresh' in your browser multiple times or 
clear the browser cache. 
 

Publishing was successful but I still see my old pages. 

 Did you publish the pages to the correct folder on the server? 

 Did you use the same page names? 

 Note that name are case sensitive so 'index' is not the same 'Index' 

 If you renamed the file extensions of the page (for example from .html to .php) then you must 
remove the old page from the server. 

 Maybe the browser displaying a cached version of the old page? Select 'Refresh' in your 
browser multiple times or clear the cache of the browser and also try another 
browser/computer. 
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The page looks different than in local preview 

First keep in mind that there is no difference between the HTML generated for local preview and a 
published page on the server. 
So in general the pages should be exactly the same, if not then please check the following: 

 Did you publish all files? 

 Did you publish all files to the correct location? 

 Are you sure you are not looking at a cached version of the page? 

 Is there a conflict with other pages in the same folder? Perhaps you've used the same image 
names for different images? 
 

What to do if publishing times out? 

If the transfer takes a long time then you've probably used (very) large images or other large files.  
Try to increase the connection timeout to 120 seconds or longer: 
Menu->Tools->Preferences->Publish 
 

Publishing takes a very long time 

 If the transfer takes a long time then you've probably used large images, videos, pdfs or other 
large files. 

 Other possible reason for slow publishing: slow internet connection, another application is 
'eating up' the bandwidth of your Internet connection or there is a problem on the host. 

 

Why aren't my images displayed on a published page? 

Did you upload the images to the web server? Make sure you did not accidently enabled 'Only publish 
HTML files' in the publish window. 
 

 Make sure the image names are valid; most web servers are case-sensitive and/or do not 
support special characters in the filenames of images.  
Tip: Use lowercase filenames. 

 Do your image filenames contain whitespaces or other special characters? Image names with 
spaces can cause problems in some browsers and/or web servers, use underscores to connect 
words instead of spaces. 

 

Why do I need to resize online images? 

Depending on the quality and settings of your digital camera, your photos could be very large, in terms 
of both screen size and file size. However large images don't look great on a web page, especially if your 
visitor’s browser is set to a low resolution. 
 
There's also the problem of finite web space and bandwidth. While broadband is becoming more 
widespread, it's still not a good idea to assume that all your visitors are using it. Some webhosts the 
amount of data transferred to and from a website too, and if your pictures are unnecessarily large then 
each time someone views one it'll eat into your bandwidth allowance. 
So it's a good idea to resize your images to more manageable dimensions. 
You can resize pictures in any image-editing program, like Adobe Photoshop., Paint Shop Pro or the free 
Paint.NET (http://www.getpaint.net/index.html) 
In general you should make your images a big as you display them on your website. So for example if the 
size of the image in your page is 100x100. You should resize the used image to this size. 
 
Quick ‘n Easy Web Builder also has a new feature called Resample. Which resamples the image to the 
current size in in the workspace. A (smaller) copy of the image (using a different name) will be published 
to your website. Note that this will not make the original image smaller! 

http://www.getpaint.net/index.html


Quick ‘n Easy Web Builder   

198 

Why do I get a yellow warning bar when I preview my pages? 

This warning indicates that your local security settings are too strict. 
Please note that this warning is usually only displayed for local preview, it will not be shown when you 
have published your website to a server. 
 
To change your local security settings follow these steps: 
1) In IE select Menu->Tools->Internet Options->Security->Local Intranet 
2) Disable the warnings you do not want to be displayed. 
 
3) In IE select Menu->Tools->Internet Options->Advanced->Security->Allow activate content to run in 
files on my computer. This will disable the warning for local preview. 
 
Note that this warning will only be displayed for local preview. 
Usually it does work ok once the page is been published to the web! 
 

How do I remove pages from my website? 

In the publish settings select 'Explore'. After you have been connected to the server you can upload, 
download and remove files and folders. 
Alternative you can log in using an external FTP client. 
 
FTP Wanderer (free tool from the makers of Quick ‘n Easy Web Builder): 
http://www.pablosoftwaresolutions.com/html/ftp_wanderer_3_0.html 
FileZilla:  
http://filezilla-project.org/ 
Smart FTP: 
http://www.smartftp.com/ 

 
Does Quick ‘n Easy Web Builder support SFTP? 

No, this is currently not supported. However you can publish your website to a local folder and then use 
an external tool to upload the site to your website. 
 

PHP code is showing on the page. 

 Is the page extension set to PHP (in Page Properties)? 

 Are you viewing the page in local preview? PHP does not work in preview. The page must be 
published to a web server. 

 Does your website support PHP? Is it enabled? Contact your webhost for more details. 

http://www.pablosoftwaresolutions.com/html/ftp_wanderer_3_0.html
http://filezilla-project.org/
http://www.smartftp.com/
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Links 
(Hyper)links are text or images that can be clicked to bring the user to another web file such as a web 
page, images or any other file. They are the essence of the World Wide Web as they link pages within 
sites and web sites to other web sites.  
 

 
 
Highlight the text or image that will be the link and select Insert->Link from the menu bar or pressing 
CTRL+K. This will display the Insert Hyperlink window. 
 

Link to a page on another web site 
Set the Link To option to Web Site. Enter the full URL (Internet Address) of the destination page in the 
URL box. External URLs MUST begin with "http://" or they will not work.  
For example, to link to the Pablo Software Solutions home page, type 
"http://www.pablosoftwaresolutions.com/" instead of "www.pablosoftwaresolutions.com". 
 

Link to a page on your own web site 
Set the Link To option to Internal Web Page. 
Click 'Select' to choose a page. This will list all pages which are part of the current project. Select one of 
the pages and a relative link will automatically be created (eg ./products.html).  

 You must publish all pages you have linked to in order to be able to test relative links. 

 Internal links do not work in Preview mode, unless you have set the Preview Scope to Entire 
Web Site (Tools->Options->Preview) 

 

Link to an email address 
Select Email Address from the Link To dropdown list. 
The URL box will automatically be updated with the mailto: prefix. Now enter the destination email 
address. 
For example: 
mailto:webmaster@yourdomain.com 
or  
mailto:webmaster@yourdomain.com?subject=Website Feedback 
 

Link to a file 
Set the Link To option to File. 
Browse for the file you wish to create a link for. Quick ‘n Easy Web Builder will automatically upload the 
local file to your website, when you publish your page. 
To specify where the linked file is uploaded to, specify a folder for that file type in the Publishing 
preferences. 
 

Note: When linking to large files, it may take a while a while before the file is transferred to your 
website! 
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Other link types 
FaceTime 
Launch the FaceTime app and initiate a call to the specified user. Example: facetime:14085551234 or 
facetime:user@example.com 
 
Phone Number 
Call the specified number. Example:  tel:+1200229933 
 
SMS 
Send an SMS. Example: sms:+3290322111 
 
Skype 
Launch the Skype app and initiate a call to the specified user. Example: skype:skype_user 
 

Smart Links 
Smart links can be used to link to the next, previous, parent or child of the current page. If you change 
the structure of your website, these links will automatically update to represent the current state.  
The following smart link options are available: 

 Parent Page; Link to the parent of the current page. 

 Child Page; Link to the first child of the current page. 

 Next Page; Link to the sibling to the right of this page.  

 Previous Page; Link to the sibling to the left of this page.  

 Back; Go back to the previous page in the browser's history. 

 Close the current browser window; Close the current browser window, this feature is not 
supported by all browsers! 

 Print the current page; Clicking the link will print the current page. 

 Reload Page; Clicking the link will reload/refresh the current page. 
   

Target Window or Frame  
Open in the same browser window, this option will set the target of the link to _self 
Open in a new browser window, this option will set the target of the link to _blank 
Open in another window or frame, this option lets you specify a custom target.  
  
Examples: 
_parent 
open the link in the parent frame 
_top 
loads the linked page in the topmost frame 
iframe1 
specify the name of an inline frame, to open the linked page in an inline frame. 
 
Open in a popup window, this option will open the linked page in a (javascript) popup window. 
Click 'Settings' to specify the properties of the popup window: 
Left, Specifies the left position, in pixels. This value is relative to the upper-left corner of the screen. The 
value must be greater than or equal to 0. 
Top, Specifies the top position, in pixels. This value is relative to the upper-left corner of the screen. The 
value must be greater than or equal to 0. 
Height, Sets the height of the window in pixels. The minimum value is 150 for Internet Explorer!  
Width, Sets the width of the window in pixels. The minimum value is 250 for Internet Explorer!  
Status Bar, Enable the status bar at the bottom of the window.  
Tool Bar, Enable the standard browser toolbar, with buttons such as Back and Forward.  
Location Bar, Enable the Location entry field where you enter the URL.  
Menu Bar, Enable the menu bar of the window.  
Resizable, Allow/Disallow the user to resize the window.  
Scrollbars, Enable the scrollbars if the document is bigger than the window  
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Open in a Lightbox, this option will open the linked page in a Light Box. In 'Settings' you can specify 
additional options for the Fancy Lightbox. Each option must be on a new line and separated by a 
comma: 
 
width : 350, 
height : 250, 
overlayShow : true, 
overlayColor : '#FF0000' 
 
More information about options is available here: http://fancybox.net/api 
 
 

Anchors (Jump to another part of the page) 
Text and images can be set as anchors (also called "bookmarks") that can be linked to within a page. For 
example, if a page has several new items, the news titles for each item can be set as anchors and a row 
of links can be added to the top of the page that will each skip down to those bookmarked sections. This 
method of using anchors allows visitors to your site to quickly access information by not having to scroll 
down the page to view the information they want. 
 
Step 1 
You can create an anchor by using the Anchor tool from the Insert menu 

 
 
Step 2 
Move the anchor icon to the position where you want the page to jump to if the user clicks the link. In 
this case let’s jump to the top of the page. 
 

  
 
Step 3 
Make sure you give the anchor a unique name. Do not include white spaces in the name.  We 
recommend using alphanumeric characters only. 
 

 

http://fancybox.net/api
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Step 4 
Once you have placed the anchor icon on your page, it can be selected from the anchor dropdown list. 
 

 
 

Appearance 
All hyperlinks in your webpage by default use the default HTML link colors (link: blue, visited: purple, 
active: red). By defining Hyperlink Styles (CCS) you can adjust the colors and formatting of an hyperlink. 
Once you have defined a style you can attach it to the hyperlink by selecting it from the Style dropdown 
list. Click the Edit Styles button to add or modify the hyperlink style sheet. 
 

Hyperlink Style Sheet 
By default, all text hyperlinks in your webpage use the default HTML link colors (link: blue, visited: 
purple, active: red). However, since CSS (Cascading Style Sheets) where introduced, more and more 
websites use different colors to create better looking layouts. Web Builder gives you the option to 
customize the way hyperlinks will be displayed in the browser by introducing the Hyperlink Style Sheet 
Editor. 
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Click Add to add a new hyperlink style. Each hyperlink style allows you to customize the colors for all 
four hyperlink states: 
Linked (default: blue, underlined) 
Visited (default: purple, underlined) 
Active (default: red, underlined) 
Hover (default: blue, underlined) 
Besides the colors, you can also change the bold, underline and italic formatting. 
 

 
 
Each style must be saved with a unique name.  
In the Link Properties window you can attach this name to a link. 
 
Click Edit to modify an existing style and Remove to delete it from the list. 
 
Example: Removing the underlining from a link. 

1. Create a new style and clear the underline checkbox for all four states. 
2. Name the style 'no_underline' 
3. Click OK to save. 
4. Select a link and change the Style from the dropdown list to 'no_underline' 
5. Publish or preview the page to view the effect. 

 
 

Note: The link style becomes active when you publish or preview your page. Web Builder will always 
show links in blue. 
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Events 
Images, shapes and form controls have an Events property to easily add actions to object events, like 
OnClick, OnMouseOver etc.  
 

 
 
Predefined actions include: Show, Hide, Move, Set Image, Play, Pause, Stop and JavaScript Function. 
Multiple events can be assigned to a single object. 
 

 
 
To add an event click Add. Next, select the event, action and specify the target. 
Based on the object one or more of these events can be selected: 
onBlur   Fires when the object loses the input focus. 
onChange  Fires when the contents of the object or selection have changed. 
onClick   Fires when the user clicks the left mouse button on the object. 
onDblClick  Fires when the user double-clicks the object. 
onFocus   Fires when the object receives focus. 
onKeyDown  Fires when the user presses a key. 
onKeyPress  Fires when the user presses an alphanumeric key. 
onKeyUp  Fires when the user releases a key. 
onLoad   Fires immediately after the browser loads the object or page. 
onMouseDown  Fires when the user clicks the object with either mouse button. 
onMouseMove  Fires when the user moves the mouse over the object 
onMouseOut  Fires when the user moves the mouse outside the boundaries of the object. 
onMouseOver  Fires when the user moves the mouse pointer into the object. 
onMouseUp  Fires when the user releases a mouse button while the mouse is over the 
object. 
onReset   Fires when the user resets a form. 
onScroll   Fires when the user repositions the scroll box in the scroll bar. 
onSelect  Fires when the current selection changes. 
onSubmit  Fires when a FORM is about to be submitted. 
onUnload  Fires immediately before the object or page is unloaded. 
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New HTML5 generic events: 
ondrag   Fires when an element is dragged. 
ondragend  Fires at the end of a drag operation. 
ondragenter  Fires when an element has been dragged to a valid drop target. 
ondragleave  Fires when an element leaves a valid drop target. 
ondragover  Fires when an element is being dragged over a valid drop target. 
ondragstart  Fires at the start of a drag operation. 
ondrop   Fires run when dragged element is being dropped. 
onmousewheel  Fires when the mouse wheel is being rotated. 
onscroll   Fires when an element's scrollbar is being scrolled. 
oncontextmenu  Fires when a context menu is triggered. 
onformchange  Fires when a form changes. 
onforminput  Fires when a form gets user input. 
oninput   Fires when an element gets user input. 
oninvalid  Fires run when an element is invalid. 
 
HTML5 page events: 
onafterprint  Fires after the document is printed. 
onbeforeprint  Fires before the document is printed. 
onbeforeonload  Fires before the document loads. 
onerror   Fires when an error occurs. 
onhaschange  Fires when the document has changed. 
onmessage  Fires when the message is triggered. 
onoffline  Fires when the document goes offline. 
ononline  Fires when the document comes online. 
onpagehide  Fires when the window is hidden. 
onpageshow  Fires when the window becomes visible. 
onpopstate  Fires the window's history changes. 
onredo   Fires when the document performs a redo. 
onresize   Fires when the window is resized. 
onstorage  Fires when the document loads. 
onundo   Fires when the document performs an undo. 
 
HTML 5 media events: 
oncanplay  Fires when a file is ready to start playing. 
oncanplaythrough Fires when a file can be played to the end without pausing for buffering. 
ondurationchange Fires when the length of the media changes. 
onemptied  Fires when something bad happens and the file is suddenly unavailable. 
onended  Fires when the media has reach the end. 
onerror   Fires when an error occurs when the file is being loaded. 
onloadeddata  Fires when media data is loaded. 
onloadedmetadata Fires when meta data (like dimensions and duration) are loaded. 
onloadstart  Fires just as the file begins to load before anything is actually loaded. 
onpause  Fires when the media is paused either by the user or programmatically. 
onplay   Fires when the media is ready to start playing. 
onplaying  Fires when the media actually has started playing. 
onprogress  Fires when the browser is in the process of getting the media data. 
onratechange  Fires each time the playback rate changes. 
onreadystatechange Fires each time the ready state changes. 
onseeked  Fires when the seeking is set to false indicating that seeking has ended. 
onseeking  Fires when the seeking attribute is set to true indicating that seeking is active. 
onstalled  Fires when the browser is unable to fetch the media data. 
onsuspend  Fires when fetching the media data is stopped before it is completely loaded. 
ontimeupdate  Fires when the playing position has changed. 
onvolumechange Fires each time the volume is changed. 
onwaiting  Fires when the media has paused but is expected to resume. 
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CSS3 animation and transition events: 
onanimationstart Fires when a CSS animation has started. 
onanimationend  Fires when a CSS animation has completed. 
onanimationiteration Fires when an iteration of an animation ends. This event does not occur for 
animations with an animation-iteration-count of one. 
ontransitionend  Fires when a CSS transition has completed. 
 
These actions can be assigned to the event above: 
Show   Show the object as specified in the Target field 
Hide   Hide the object as specified in the Target field 
Move   Move the object as specified in the Target field to position Left, Top. 
Set Image  Set the image of object 'Target' as specified in Filename 
JavaScript Function  Execute a custom JavaScript function (eg. alert('enter your message');) 
 
These actions can be used in combination with the Media Player object only! 
Play   Start the media file. 
Pause   Pause the media file. 
Stop   Stop the media file. 
 
The following actions can be used in combination with the Slide Show object 
Make sure you select a valid slideshow object as the target and set the interval to 0! 
SlideShow Next  Display the next image of a slide show. 
SlideShow Previous Display the previous image of a slide show 
 
ShowWithEffects 
Show the object as specified in the Target field while using one of the cool effects like fading, sliding, 
blinds, explode, puff drop etc.... 
Give your website amazing 'web 2.0' effects, with only a few mouse clicks! 
 
HideWithEffects 
Hide the object as specified in the Target field. 
 
SetStyle 
The SetStyle action can be used to dynamically set a new style for an object. The style must have been 
created in the Style Manager. 
 
Toggle 
Toggle the visible state (show/hide) of an object. Triggering the event again will restore the previous 
state. Supports animations/easing. 
 
Toggle Style 
Toggle between the current style and another style while animating the style changes. Triggering the 
event again will restore the previous style. 
The style must have been created in the Style Manager. Note that the object must also have a current 
(predefined) style. 
 
Animate 
Perform a custom animation of a set of CSS properties. 
The following properties can be animated: 
Left, this will animate the object to the specified horizontal position (in pixels). 
Top, this will animate the object to the specified vertical position (in pixels). 
Width, this will animate the object to the specified width (in pixels). 
Height, this will animate the object to the specified height (in pixels). 
Opacity, this will animate opacity of the specified object (in a range between 0.0 - 1.0) 
Angle, this will animate the angle of the specified object (in a range between 0 - 359). Basically this allow 
you to rotate any object. Works only in modern browsers because it uses CSS3 transforms. 
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Rotate 
Rotates an object by specifying the angle (in a range between 0 - 359). Works only in modern browsers 
because it uses CSS3 transforms. 
 
Timer Start 
Activates the specified Timer object. The target must be a Timer object! 
 
Timer Stop 
Deactivates the specified Timer object. The target must be a Timer object! 
 
Animation Pause (CSS3) 
Pauses a running CSS3 animation. 
 
Animation Resume (CSS3) 
Resumes a paused CSS3 animation. It's not possible to resume an animation that has ended (when the 
iteration count has reached the end). 
 

Tip:  
Events that are not listed above can be inserted using the custom HTML tools. 

 

Important note: 
When you implement an event for an object then this will overwrite the default behavior for that event. 
So if you implement the 'onclick' event for a submit button, then it will no longer execute the 'onsubmit' 
action, because it assumes that you want to implement the action yourself. 
 
If you still want to enable default behavior for an event then follow these steps: 
1) Add the same event again and select action -> JavaScript function. 
2) In the JavaScript field enter:  
return true; 
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Form Validation 
Quick ‘n Easy Web Builder has some very powerful validation tools to validate the user input for the 
EditBox, Combobox, Checkbox, Filer Upload and TextArea before it's submitted in a Form. 
Besides JavaScript based validation, there is also native HTML5 validation support built-in! 
 

 Default 
Displays a standard JavaScript message.  

 Info bubble (real-time) 
Select this option to enable real-time validation. The input field will be validated as soon as it 
loses the focus without the need for the user to press the submit button first. Real-time 
validation uses info balloons instead of the standard message box, this give your forms a 
professional look and feel. To configure the style of the balloons click the 'Settings' button. You 
can configure the colors, font, bubble type, position and animation effect. 

 
 HTML5 

Select this option to use native HTML5 form validation. Note that this feature is not available in 
all browsers yet. 
 

 
Checkbox validation 
Error message   
This message will be displayed when the user enters the wrong data. 
 
Selection required   
Enable this option if the checkbox must be checked before the user can submit the form. 
 

Combobox validation 
Error message                 
This message will be displayed when the user enters the wrong data.. 
 
Selection required 
Require users to make a selection from the combobox. 
 
Disallow first choice 
If you use the first option to display instructions, such as "Select an option," you can make that first 
option unavailable by enabling this option. 

 
FileUpload validation 
Error message                 
This message will be displayed when the user enters the wrong data.. 
 
Data required  
If this option is enabled then the user must specify a filename. 
 
Valid extensions 
Specifies which extension will be accepted by the form. 
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Editbox and TextArea validation 
Date Type 
 

 No Constraints 
All input is accepted 

 Text 
The input field is a text field. Use Text Format to specify which characters are allowed 

 Number  
The input field is a number field. Use Numeric Format to specify which numbers are allowed. 

 Email Address 
The input field is an email address field.  

 All Major Creditcards 

 Creditcard - American Express 

 Creditcard – Dinersclub 

 Creditcard – Discover 

 Creditcard – Mastercard 

 Creditcard – Visa 
These options verify common credit card formats. 

 Date – ddmmyyyy 

 Date - mmddyyyy  

 Date – yyyymmdd 
These options verify common date formats. 

 IP Address 
The input field is an IP address. 

 URL 
The input field is an URL. 

 AJAX 
This option is for advanced users(!) who wish to validate a value on the server, for example in a 
database. Use the URL field to specify the validation script on the server. For example: 
http://www.yourwebsite.com/validate.php 
 
The validate.php script in its simplest form could look something like this: 
 
<?php 

$username = $_POST['data']; 

 

// TODO: lookup username in database... 

if ($username == 'user') 

{ 

   echo "true"; 

} 

else 

{ 

   echo "false"; 

} 

?> 

 

 Custom 
Select the Custom option to specify your own regular (JavaScript) expression.  

 
Error message                 
This message will be displayed when the user enters the wrong data.. 

http://www.yourwebsite.com/validate.php
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Text Format 
Select the types of characters to allow in the field Letters, Digits, Whitespace (spaces, tabs, carriage 
returns, and line feeds), or Other (different characters, such as commas and hyphens).  
 
Numeric Format 
Specify to use a comma or period for Decimal points. 
 
Data Length 
Required; require the user to type an entry in a edit box or text area field. 
Minimum; specifies the minimum number of characters to allow in the text box. 
Maximum; specifies the maximum number of characters to allow in the text box.  
 
Data Value 
This option can be used to specify a value limitation. In the Field must be list, select a constraint: Don't 
care, Less than, Greater than, Less than or equal to, Greater than or equal to, Equal to or Not equal to. 
In the Value box, type the value for the constraint. To specify a second constraint, select And must be, 
click a condition, and then type a value.  
 
Match 
This option allows you to specify another form field of which the contents will be checked against the 
current field to see if they're the same. This can be useful for validating email or password fields. 
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CSS3 Animations and Transitions 
Quick ‘n Easy Web Builder has built-in support for CSS3 animations and transitions. Animations and 
transitions are supported by all modern browsers (FireFox/Safari/Opera/Chrome/IE10), but NOT by 
Internet Explorer 9 or older! 
 

Animation 
A CSS3 animation is an effect that lets an element gradually change from one style to another without 
using JavaScript or Flash. Animation effects can be applied to a wide variety of CSS properties, including 
background-color, width, height, opacity, transforms (rotate, skew, scale, translate) and many more. The 
Animation Manager can be used to define animations. These animations can be assigned to an object in 
the CSS3 Animation section of the object's properties.  
 
Note however that not all animations are useful for all objects. For instance animating the background 
color of an image or shape will not do anything because there is no background in that case! 
 
You can also associate an animation to a style (in the Style Manager). This makes it possible to 
dynamically assign an animation to an object (through events -> set style). 
 

Animation Properties 
Animation 
Specifies the animation (as created in the Animation Manager)to use for the object. 
 
Duration 
Specifies the duration of the animation in milliseconds. 
 
Delay 
Delay causes the very first run of the animation to wait for the specified amount of time (in milliseconds) 
before beginning to execute. Note that the delay will not occur during animation repeats. It will only be 
used for the first iteration of the animation. 
 
Iteration count 
You can configure how many times you would like the animation to play, or you can even make it repeat 
infinitely by using -1. 
 
Direction 
Set this to normal to play the animation from start to finish. Or use alternate to play it forward and then 
backwards. 
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Timing 
The animation-timing-function specifies the speed curve of the animation. 
The speed curve defines the time an animation uses to change from one set of CSS styles to another. 
The speed curve is used to make the changes smoothly. 
The animation-timing-function uses a mathematical function, called the Cubic Bèzier curve, to make the 
speed curve. 
 

 linear 
The animation has the same speed from start to end 
 

 ease 
The animation has a slow start, then fast, before it ends slowly 
 

 ease-in 
The animation has a slow start. 
 

 ease-out 
The animation has a slow end 
 

 ease-in-out 
The animation has both a slow start and a slow end 

 
Related tutorials: 
http://www.quickandeasywebbuilder.com/animations.html 
 
 

Transition 
A CSS3 transition is an animation that moves a property between two states. Transitions are an implicit 
animation, which means they are triggered by a state change like ‘hover’ or ‘focus’, unlike an animation 
which run continuously.  
You can add multiple transitions to an object. This makes it possible to animate multiple properties at 
the same time. 
 
Trigger 
Specifies which state change will trigger the transition. Commonly used triggers are 'hover' and 'focus'. 
 
Duration 
Specifies the duration of the transition in milliseconds. 
 
Delay 
Specifies when the transition will start. 
 
Timing 
The timing-function specifies the speed curve of the animation. See 'animation properties' for more 
details. 
 
Property 
Specifies the name of the CSS property to which the transition is applied. 
 
Value 
Specifies the new value of the CSS property. 
 
Related tutorials: 
http://www.quickandeasywebbuilder.com/transitions.html 
http://www.quickandeasywebbuilder.com/transform.html 
 

http://www.quickandeasywebbuilder.com/animations.html
http://www.quickandeasywebbuilder.com/transitions.html
http://www.quickandeasywebbuilder.com/transform.html
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Animation Manager 
The Animation Manager can be used to define animations (with key frames). We have included a few 
example animations to help you get started. 
 

Important:  
Not all animations are useful for all objects. For instance animating the background color of an image or 
shape will not do anything because there is no background in that case.  Also animating 
left/top/width/height/margin/etc will not work for most objects because these values are usually fixed. 
If you want to animate the size or position of an object it's better to use transforms. See the examples 
for more details. 

 
The first step in creating animations is to define 'key frames'. A key frame is a point that defines the start 
and end of a transition. The most simple animation will have two key frames - one at the start (0%) and 
one at the end (100%) - whereas more complex animations will have more key frames in between. 
In the key frame you set the position (in percentages) along the duration of the animation. You must 
specify at least two key frames (0% and 100%), but you can have many as you like. 
Each key frame defines a property (and value) that is applied to the element at the specified stage of the 
animation. 
 
Example: 
First key frame: 0% -> background color #000000 
Last key frame: 100% -> background color #FFFFFF 
This will smoothly animate the background color of an object from black to white. 
Note that the timing is defined in the animation properties of the object, not in the animation itself. This 
way you can reuse an animation in different objects with different timing settings. 
 

Note  
You can animate multiple CSS properties at the same time by using multiple key frames with same 
position. See the include examples for more details. 

 
 

Animation Timeline 
The Animation Timeline option is available in the Page menu. The Animation Timeline displays all 
animations on the page, you can also add, edit and remove animations. It's also possible to drag & 
drop/move animations on the timeline, so you can easily control the timing of the animations. 
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Responsive Web Design 
With the increase in popularity of browsing on mobile phones and tablets it is becoming essential to 
create web sites that are optimized to the needs of these users. Previously you had to create different 
versions of the website and use scripts to redirect the visitor to the mobile version of the page.  
Quick ‘n Easy Web Builder 3 introduces 'Responsive Web Design' which allows you to create a single 
HTML page containing different variants of the layout, each optimized for specific device widths. Your 
website will dynamically respond to the screen size of the visitor and display the layout most 
appropriate to their device. These different variants are called 'breakpoints' and uses CSS3's media 
queries. 
 
A breakpoint is separate 'view' of the page in Quick ‘n Easy Web Builder. A page can have multiple 
breakpoints, each one optimized for a specific screen width. For example, you can have the standard 
desktop layout, one for tablets (1024 px) and another one for mobile phones (320 px). Common 
breakpoints are: 

 320 px, Mobile portrait , 480 px, Mobile landscape  

 768 px, Tablet portrait  1024 px, Tablet landscape/Netbook  

 1280 px and greater, Desktop  
 
Of course you can define your own widths and have as many breakpoints as you like (max 25), although 
usually you will have no more than 3. To add or edit breakpoints click the 'Manage Breakpoints' option 
in the Page menu. To switch between breakpoints click the 'Breakpoints' drop down menu and select 
the desired breakpoint. To go back to the default layout, select "Default'. 
 
The different variants share the same content (text, images etc) and you can change the position and 
size of the object for each breakpoint. You can also add unique content for specific screen widths, which 
makes it possible for example to hide objects on smaller screen. 
 
The following objects are not responsive; this means that they cannot have a different size in 
breakpoints. See also ‘Important notes about Responsive Web Design’. 

 Curve 

 Line 

 Logo (set the output format to ‘CSS’ to make the logo responsive) 

 Navigation Bar 

 Polygon 

 Shape (set the output format to ‘CSS’ to make the shape responsive) 

 Table 

 Wrapping Text 
 
If you need different sizes in breakpoints then you will need to create a copy of the object. 
 
Related tutorial: 
http://www.quickandeasywebbuilder.com/responsivewebdesign.html 
 
Related FAQ (must read!): 
http://www.quickandeasywebbuilder.com/forum/viewtopic.php?f=49&t=43085 
 

http://www.quickandeasywebbuilder.com/responsivewebdesign.html
http://www.quickandeasywebbuilder.com/forum/viewtopic.php?f=49&t=43085
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Important notes about Responsive Web Design 
Objects can have a different size, position and visibility state per breakpoint. However all other 
properties will be exactly the same! For example if you change the color of an object then it will be 
changed in all breakpoints (because the object is shared between all views). 
 
Although objects can have different sizes in breakpoints, there are a few exceptions. For example shapes 
and other drawing tools will have the same size in all breakpoints. The reason for this is because only 
one image will be published and if you change the size of that image in one breakpoint then it would 
look distorted in another breakpoint. But you can use multiple shapes, one for each breakpoint and hide 
the ones you do not use in other breakpoints.  
 
If you share text between multiple breakpoints then set 'compatibility’ to 'Default', because the other 
options optimize the text for a specific width. If you really need to use one of the compatibility options 
then consider using a separate text object for each breakpoint, so it can be optimized for that specific 
width. 
 
Objects can only be part of one Layer (and Form, Carousel, Tabs, Accordion, Dialog). So if you move an 
object to a layer in one breakpoint then it will automatically be part of the same layer in other 
breakpoints! 
 
If you add a new object to a breakpoint then it will initially be hidden on all other breakpoints. You can 
use the Object Manager to unhide it if you also want it on other breakpoints. 
 
If you delete an object from a breakpoint then it will be removed from all other views as well. If you 
want to hide the object then you can use the Object Manager. 
 
You can test breakpoints in your desktop browser. Resize the browser window to activate breakpoints. 
 
Some browsers also have dedicated tools for testing responsive web sites. For example, FireFox has a 
Responsive Design View which is great to test breakpoints. Consult the documentation of the browser 
for more details. 
 
Browsers that do not support CSS3 media queries will display the default layout. 

 



Quick ‘n Easy Web Builder   

216 

Responsive Properties 
A 'Responsive Property' means that it can have a different value in breakpoints. For example, the font-
size can be larger for smaller screens. 
 
Common responsive properties are visibility, object size and position, background mode, background 
color, background image, background size, background gradient, font family and text size.  
Which properties are responsive is depends on the object type.  
 
  
Notes about Responsive Properties: 
· When you change the property in a breakpoint, then it will only be changed for that breakpoint! 
· If you want to change the property for all breakpoints (and all breakpoints still have the same value) 
then please do this in the Default view. 
· Dynamically generated images like Shapes, ClipArt, Curves, Polygon cannot be responsive because 
there is only one image which is shared between all breakpoints. The generated image is optimized for 
only one size. If you could give it a different size in breakpoints, then it would look distorted in the 
published page. 
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Responsive Web Design FAQ 
Although the RWD concept is rather easy, it may require a different way of thinking for die-hard Web 
Builder users. In this FAQ we have collected frequently asked questions about Responsive Web Design, 
so this will always be the first place to look before you start... 
 
Important: Learning to use Responsive Web Design takes time. Please start at the basics. Learn to walk 
before you run!  
 
What is Responsive Web Design? 
Responsive web design (RWD) is a web design approach aimed at creating web sites to provide an 
optimal viewing experience—easy reading and navigation with a minimum of resizing, panning, and 
scrolling—across a wide range of devices (from mobile phones to desktop computer monitors). 
 
How can I design a responsive website with Quick 'n Easy Web Builder? 
For an introduction to Responsive Web Design in Quick 'n Easy Web Builder please read this tutorial: 
http://www.quickandeasywebbuilder.com/responsivewebdesign.html 
 
What are breakpoints? 
A breakpoint is different 'view' of the page in Quick 'n Easy Web Builder. A page can have multiple 
breakpoints, each one optimized for a specific screen width. For example, you can have the standard 
desktop layout, one for tablets (1024 px) and another one for mobile phones (320 px). Common 
breakpoints are: 
• 320 px, Mobile portrait , 480 px, Mobile landscape  
• 768 px, Tablet portrait  1024 px, Tablet landscape/Netbook  
• 1280 px and greater, Desktop  
 
Which breakpoints should I add to my web page? 
There is no fixed rule for implementing breakpoints.  Generally you do not create a breakpoint for any 
particular device or for any particular screen resolution.  
It all depends on your design. The idea behind breakpoints is that any design will 'break' at certain 
resolutions. For example, text is no longer readable, the menu is too small or the browser displays a 
horizontal scrollbar. Where a design 'breaks' can be different for each and every design. One design may 
look fine on all displays all the way down to 320px ... and then it breaks. That would mean that you 
would only need a breakpoint at 320. Another design may break at all sorts of different resolutions. This, 
then, would require all sorts of differing breakpoints. 
 
The designer needs to decide where to start designing: from smallest to largest or largest to smallest. 
Although it may be the easiest to start with the default layout. 
Once you get your initial design down, you then test it at various sizes to see when and where it breaks. 
Once you have that screen resolution you create a breakpoint and adjust. Then you move on from there. 
 
What is 'max-width'? 
max-width specifies the maximum width of the rendering surface of the output device (such as the 
width of the browser window). 
Web Builder uses the max-width in CSS3 media queries to control the size, position and visibility of 
objects. For example if you add a breakpoint and set the max-width to 320px then this layout will be 
used if the browser window is less than or equal to 320 pixels. 
 
What are 'responsive objects'? 
'Responsive objects' are objects than can have a different size at different breakpoints.  
Not all objects are responsive, for example shapes and other drawing tools will have the same size in all 
breakpoints. The reason for this is because only one image will be published and if you change the size 
of that image in one breakpoint then it would look distorted in another breakpoint. But you can use 
multiple shapes, one for each breakpoint and hide the ones you do not use in other breakpoints.  
 

http://www.quickandeasywebbuilder.com/responsivewebdesign.html
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Which objects are not responsive? 
Although we did our best to make most objects responsive, not all objects can have different sizes at 
different breakpoints due to their 'fixed size' nature. 
The following objects are not responsive: 
- Logo (*) 
- Carousel 
- Curve  
- Flash Video Player  
- Line  
- Navigation Bar  
- Polygon  
- Shape (*) 
- Table  
- Wrapping Text  
(*)Shapes and Logos can be made responsive if you set the output format to 'CSS3' 
 
If you need different sizes in breakpoints then you will need to create a copy of the object. You can also 
use quickly clone and hide the original object with the 'Clone and Hide' option in the object's context 
menu. 
 
Can objects have different properties at different breakpoints? 
Objects can have a different size, position and visibility state in each breakpoint. However all other 
properties will be exactly the same! For example if you change the color of an object then it will be 
changed in all breakpoints (because the same object is shared between all views). But you can have 
different objects on different breakpoints so if you want to use a different menu then you hide the 
menu in the breakpoint and add another one to the current breakpoint. 
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Why isn't my text responsive? 
Text is only responsive if the output format is set to 'Default' (in the compatibility properties of the text 
object). If the output format is set to 'use <div> for each line' or 'use <div> with position for each line' 
then the text is optimized for one size only.  
Text is also not responsive when you are using line spacing. 
 
Is there a quick way to see which objects on my page are responsive? 
Yes, you can use the keyboard combination Shift+Ctrl+R to outline all non-responsive objects on the 
page. The outline color is currently fixed to red. 
 
Where do you place the "hidden" objects (eg. menus)? Should they be within or outside the borders 
of the breakpoint? 
It's recommended to place them inside the page boundaries of the breakpoints, so the objects do not 
affect the page width. 
 
Can I use breakpoints in master pages and master frames? 
Yes, but make sure you use the same breakpoints values in both the master page/frame and content 
page. 
 
How can I test my responsive designs? 
There are many dedicated websites to test responsive designs. For example: http://responsivepx.com/ 
But some browsers also have built-in test tools. For example in Firefox you can press CTRL+SHIFT+M to 
go into responsive test mode.  
 
Are there any alternative ways to create a responsive website? 
Web Builder has several other methods for creating flexible and responsive websites. 
For example you can create multiple versions of your pages where each version is optimized for a 
different target resolution. 
You can then use one of the redirect scripts in the 'Ready-to-use-JavaScripts' (available in the toolbox 
and Insert menu) to redirect the user to the right version of the page. 
 
Another solution is to use a grid-like layout that automatically adjusts to the current screen resolution. 
This can be done with the jQuery Masonry extension  
http://www.quickandeasywebbuilder.com/support/masonry/metro.html 
http://www.quickandeasywebbuilder.com/support/masonry/test1.html 
http://www.quickandeasywebbuilder.com/support/masonry/test2.html 
You can download/install the jQuery Masonry extension in the Extension Manager. 
 
It's also possible to use layers to create stretchable or floating layouts.  
http://www.quickandeasywebbuilder.com/using_layers.html 
http://www.quickandeasywebbuilder.com/anchored_layers.html 
http://www.quickandeasywebbuilder.com/floating_layers.html 
 

http://responsivepx.com/
http://www.quickandeasywebbuilder.com/support/masonry/metro.html
http://www.quickandeasywebbuilder.com/support/masonry/test1.html
http://www.quickandeasywebbuilder.com/support/masonry/test2.html
http://www.quickandeasywebbuilder.com/using_layers.html
http://www.quickandeasywebbuilder.com/anchored_layers.html
http://www.quickandeasywebbuilder.com/floating_layers.html
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Why are newly added objects hidden in other breakpoints? 
New objects will be set invisible in other breakpoints. This is usually the best option because new 
objects generally do not have the same position in different breakpoints, so it would clutter the layout if 
they were added at a 'random' position. 
You can use the Object Manager to make the object visible in other breakpoints and move them to the 
desired position. It is also possible to change this 'auto-hide' behavior by disable the option 'Hide new 
objects on other breakpoints' in  
Preferences->HTML 
 
When using events, the visibility is affected by breakpoints. 
In Responsive Web Design, the software will automatically generate code for controlling the position, 
size and visibility of objects (with CSS3 media queries). 
However in some cases controlling the visibility can conflict with other features on the page (like events 
that show or hide objects).  
The option 'Include Visibility' in the context menu of the object makes it possible to exclude the visibility 
attribute from the media query, so it will not affect the state of the object when using events. Note that 
if 'Include Visibility' is not active then the object will have the same visibility state in all breakpoints! 
 
You can control the default value of this property in Preferences ->HTML->Use 'Include visibility' as 
default for new objects in Responsive Web Design. 
 
After I started using breakpoints extensions or custom HTML no longer works. 
When using Responsive Design/breakpoints, the software will move all inline styles of objects to the 
<style> section in the header of the page. This makes it possible to use CSS3 media queries to control 
the position, size and visibility of objects for different breakpoints. However in some cases this may 
affect the behavior of an object, HTML or extension.  
To control this behavior we have added a special option in Preferences->HTML->Keep inline styles with 
Responsive Web Design (use !important). 
If you enable this option then the software will not touch inline styles, but adds !important to overwrite 
the position, size and visibility of objects with media queries. 
 
When do I use 'Include min-width in CSS3 media queries'? 
Note: This option in available in the Manage Breakpoints window. 
This option changes the way breakpoints behave in the browser. By default breakpoints will be triggered 
if width of the browser window is the same or smaller than the defined breakpoint. 
If Include 'min-width' in CSS3 media queries is enabled then breakpoint will be triggered if width of the 
browser window is the same or larger than the current breakpoint and smaller than the next breakpoint. 
This can be useful if you want to center the layout if the screen width is wider than the current 
breakpoint. 
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Here are some examples (resize the browser window to see the different breakpoints): 
 
Example 1 
Include 'min-width' in CSS3 media queries is enabled: 
http://www.quickandeasywebbuilder.com/support/rwd/index.html 
 
Include 'min-width' in CSS3 media queries is disabled: 
http://www.quickandeasywebbuilder.com/support/rwd/index2.html 
 
Example 2 
Include 'min-width' in CSS3 media queries is enabled: 
http://www.quickandeasywebbuilder.com/support/rwd/minwidth.html 
 
Include 'min-width' in CSS3 media queries is disabled: 
http://www.quickandeasywebbuilder.com/support/rwd/maxwidth.html 
 
And finally one important tip: DO ONE THING AT A TIME! 
Do not change too many things at once. If you only do one thing at the time then this make it easier to 
trace back your steps if something goes wrong. 
For example: when using master frames, first add breakpoint to the master frame, make one 
modification to begin with (move an object or change its size). 
Then add the same breakpoint to the content page. Test the page in the browser, if it works then move 
on to the next step, if it does not work then first try to figure out what went wrong before moving on. 
 

http://www.quickandeasywebbuilder.com/support/rwd/index.html
http://www.quickandeasywebbuilder.com/support/rwd/index2.html
http://www.quickandeasywebbuilder.com/support/rwd/minwidth.html
http://www.quickandeasywebbuilder.com/support/rwd/maxwidth.html
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Mac App Store Sandboxing 

 
Important information for Mac users who are using the Mac App Store version. 
Apple requires all applications sold in the Mac App Store to implement 'Sandboxing'. 
This means that the version of Quick 'n Easy Web Builder in the Mac App Store works slightly different 
than the version that is available on our website (which does not implement sandboxing). 
 
What is sandboxing? 
A non-sandboxed app has the full rights of the user who is running that app, and can access any 
resources that the user can access.  
If that app or the frameworks it is linked against contain security holes, an attacker can potentially 
exploit those holes to take control of that app,  
and in doing so, the attacker gains the ability to do anything that the user can do. 
By limiting access to resources on a per-app basis, App Sandbox provides a last line of defense against 
the theft, corruption, or deletion of user data if an attacker successfully  
exploits security holes in the application or the frameworks it is linked against. 
 
Because Quick 'n Easy Web Builder (sandboxed version) has limited access to the resources of your 
computer, the software cannot save project files and other assets anywhere on your hard disk. 
The software can only access files that are in the application’s container. This 'container' is a special 
(private) folder on your hard disk: 
Username/Library/Containers/com.pablosoftwaresolutions.quickandeasywebuilder/Data/ 
 
Normally when you save templates, extensions or other QnEWB related files they will be saved in the 
folder 
Username/Library/Application Support/Quick 'n Easy Web Builder 3/ 
 
But in the sandboxed version they will be saved in 
Username/Library/Containers/com.pablosoftwaresolutions.quickandeasywebuilder/Data/Library/Applic
ation Support/Quick 'n Easy Web Builder 3/ 
 
This means that if you are upgrading from a previous (not-sandboxed) version that you will have to copy 
all your qnewb files from 
Username/Library/Application Support/Quick 'n Easy Web Builder 3/ 
to 
Username/Library/Containers/com.pablosoftwaresolutions.quickandeasywebuilder/Data/Library/Applic
ation Support/Quick 'n Easy Web Builder 3/ 
 
We also recommend to store your project files and images in   
Username/Library/Containers/com.pablosoftwaresolutions.quickandeasywebuilder/Data/Documents/ 
otherwise Quick 'n Easy Web builder cannot access the files!!! 
 
We understand that this can be inconvenient for some users. However this was the only way to get our 
software accepted in the Mac App Store.  
 
Update:  
In version 2.2 we’ve added the ability to configure a document folder for the sandboxed version of the 
Mac version. This will give the application full access to that folder outside the sandbox container!  
You can set the folder in Preferences->Miscellaneous->Sandbox folder  
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